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Foreword

Notes

Thank you for purchasing the MV1000/MV2000 (hereafter referred to as the MV).
This Communication Interface User’s Manual contains information about the Ethernet
and serial interface communication functions. To ensure correct use, please read this
manual thoroughly before beginning operation.

Keep this manual in a safe place for quick reference in the event a question arises.
The following manuals, including this one, are provided as MV1000/MV2000 manuals.
Please read all of them.

¢ Electronic Manuals Provided on the Accompanying CD-ROM

Manual Title Manual No. Description

MV1000 IM MV1000-02E Explains how to set up the MV1000 for making

First Step Guide measurements using the quick settings function. Connection
diagrams are also provided to help you with the setup.

MV2000 IM MV2000-02E Explains how to set up the MV2000 for making

First Step Guide measurements using the quick settings function. Connection
diagrams are also provided to help you with the setup.

MV1000/MV2000 IM MV1000-01E Explains all functions except communication functions and

User’s Manual procedures of the MV1000 and MV2000.

MV1000/MV2000 IM MV1000-17E Explains the MV1000 and MV2000 Ethernet and serial

Communication Interface interface communication functions.

User’s Manual

DAQSTANDARD IM 04L41B01-61E Explains the functions and operating procedures of

User’s Manual DAQSTANDARD.

¢ Paper Manuals

Manual Title Manual No. Description

MV1000 IM MV1000-02E This guide is also provided in the CD-ROM.

First Step Guide

MV2000 IM MV2000-02E This guide is also provided in the CD-ROM.

First Step Guide

MV1000/MV2000 IM MV1000-91C Provides information about pollution control.

Control of Pollution Caused
by the Product

» The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions. The figures
given in this manual may differ from those that actually appear on your screen.

» Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

» Copying or reproducing all or any part of the contents of this manual without
YOKOGAWA's permission is strictly prohibited.

» The TCP/IP software of this product and the document concerning the TCP/IP software
have been developed/created by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the University of California.

Trademarks

* MVAdvanced is a trademark of Yokogawa Electric Corporation.

» Microsoft and Windows are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

» Adobe and Acrobat are trademarks of Adobe Systems Incorporated.

» Company and product names that appear in this manual are registered trademarks or
trademarks of their respective holders.

* In this manual, the ™ and ® symbols do not accompany trademarks or registered
trademarks.

Revisions

» 1st Edition:December 2007

1st Edition : December 2007 (YK)
All Rights Reserved, Copyright © 2007 Yokogawa Electric Corporation
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How to Use This Manual

The following symbols are used in this manual.
Unit
+ k stands for 1000. Example: 5 kg, 100 kHz
» K stands for 1024. Example: 640 KB

Markings

The following safety notations are used in this manual.
Improper handling or use can lead to injury to the user or damage

A to the instrument. This symbol appears on the instrument to
indicate that the user must refer to the user's manual for special
instructions. The same symbol appears in the corresponding place
in the user’s manual to identify those instructions. In the manual,
the symbol is used in conjunction with the word WARNING or
CAUTION.

WARNING Calls attention to actions or conditions that could cause serious or
fatal injury to the user, and precautions that can be taken to prevent

such occurrences.

CAUTION Calls attentions to actions or conditions that could cause light
injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.

Note Calls attention to information that is important for proper operation
of the instrument.

Bold Characters
Bold characters are used to indicate text that appears on the screen or operation keys.

The ¢ symbol indicates key and menu operations.

Procedural Explanations
This manual mainly describes the MV1000 procedures. Where procedures differ between
the MV2000 and MV1000, the MV2000 procedures are also provided.

High-Speed and Medium-Speed Model Groupings
This manual uses the terms high-speed input model and medium-speed input model to
distinguish between MV models as follows:

Model Type Model

High-speed input model MV1004, MV1008, and MV2008

Medium-speed input model |MV1006, MV1012, MV1024,

MV2010, MV2020, MV2030, MV2040, and MV2048
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Communication Ports

Rear Panel

MV1000
— Ethernet port
— RS-422/RS-485 port (option)
A serial port that is provided with the /C3 option.
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MV2000
— Ethernet port

An Ethernet port that comes standard.

—— RS-422/RS-485 port (option)

A serial port that is provided with the /C3 option
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Chapter 1 Overview of Communication Functions

1.1 Ethernet Interface

This chapter gives an overview of the MV Ethernet communication functions.

Modbus Communications
The MV can connect to a Modbus device and read and write to the device’s internal
registers. See section 1.3 for details.

Setting/Measurement Server

* You can use this feature to set almost all of the settings that can be configured from
the front panel keys. However, you cannot use this feature to turn the power ON/OFF,
register users, set the key lock password, or set the connection destination of the FTP
client function.

* You can use this feature to transmit the following types of data.

+ Measured, computed’, and external input data?
» Files in the internal memory or files on an external storage medium
» Setup information and status byte
* Logs of operations errors, communications, etc.
* Alarm summaries and message summaries
* Relay status information
Measured, computed’, and external input® data can be transmitted to a PC in binary
or ASCII format. Other types of data are transmitted in text format. For a description of
data output formats, see chapter 5.
1 /M1 option.
2 MV2000 with the /MC1 option.

» You can use setting mode commands (see sections 4.4 and 4.5), basic setting mode
commands (see section 4.6), and output commands (see sections 4.7 and 4.8) with
this feature.

* You can use this feature via an Ethernet interface or serial interface (/C2 or /C3
option).

+ If you want to use this feature via a serial interface, configure the serial interface
according to Chapter 3.

Maintenance/Test Server
* You can use this feature to transmit connection information, network statistics, and
other Ethernet communication information from the MV.
* You can use maintenance/test commands (see section 4.11) with this feature.

IM MV1000-17E 11
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1.1 Ethernet Interface

FTP Server

* You can access the MV from a PC via FTP. You can perform operations such as
retrieving directory and file lists and transferring and deleting files from an external
storage medium connected to the MV. You can also retrieve directory and file lists and
transfer files from the internal memory.

» For the settings necessary to use this feature, see section 2.5.

PC

1:-;-']

-_—
o
o
L]

T Files on an external storage medium

I Ethernet
J FTP server

FTP Client

Automatic File Transfer
* You can use this feature to automatically transfer display, event, report, and snapshot

data files that are created in the MV internal memory to an FTP. The result of the
transfer is recorded in the FTP log. You can view the FTP log on the MV (see “Log
Display” described later) or transmit the log to a PC using commands.

FTP client :-"’Data files to Transfer destination Transfer log *
(————————n i betransferred (FTP server)information (FTP log)
L ol
MV |©
ﬁ@@mg
=l = |
, Data files
— Ethernet

You can specify two destination FTP servers: primary and secondary. If the primary
FTP server is down, the file is transferred to the secondary FTP server.
» For the settings necessary to use this feature, see section 2.6.

* FTP Test
» You can perform an FTP test by transferring a test file from the MV to an FTP

server.
* You can view the result of the FTP test on the FTP log screen.
» For information on how to use this feature, see section 2.6.

IM MV1000-17E



1.1 Ethernet Interface

Instrument Information Server

Login

You can use this feature to output the serial number, model name, and other
information about an MV that is connected via an Ethernet network.

You can use instrument information output commands (see section 4.12) with this
feature.

You can use this feature when accessing the setting/measurement server,
maintenance/test server, and FTP server functions via an Ethernet interface.

For a description of the settings required to use this feature, see the MV1000/MV2000
User’s Manual (IM MV1000-01E).

For the procedure to log into the setting/measurement server or the maintenance/test
server, see appendix 3.

User Registration
Users are registered using the MV login feature. There are two user levels: administrator
and user.

Administrator
An administrator has privileges to use all the features of the setting/measurement
server, maintenance/test server, and FTP server.
User
A user has limited privileges to use the features of the setting/measurement server,
maintenance/test server, and FTP server. For command limitations, see section 4.2.
» Setting/measurement server feature limitations
A user cannot change settings that affect the MV operation. A user can output
measured data and setting data.
* Maintenance/test server feature limitations
A user cannot disconnect a connection between another PC and the MV. A user
can disconnect the connection between the user’s own PC and the MV.
* FTP server feature limitations
A user cannot save or delete files on an external storage medium connected to the
MV. A user can only load files.

Application Timeout

This feature drops the connection with the PC if there is no data transfer for a given
time. It prevents a PC from being connected to the MV indefinitely which would
prohibit other users from making new connections.

IM MV1000-17E
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1.1 Ethernet Interface

Web Server

» The MV screen can be displayed in Microsoft Internet Explorer.
» The following two pages are available.
» Monitor page: A dedicated monitoring screen.
» Operator page: You can switch the MV display and change or write messages.
You can set access control (user name and password specified with the login
function) for each page.

Auto Refresh m Zoom

Refresh Alarm Summary Log.
Data list Print page

TREND |
SelectGroup=> v] |

Select Group => =
Select Screen => ¥

» The MV screen can be refreshed at a constant interval (approximately 10 s).
» The following information can be displayed.
» Alarm summary
* Measured and computed values of all channels
* Log (message log, error log, etc.)
» For Web server feature settings, see section 2.4.
» For a description of the monitor page and operator page operations, see section 2.4.

1-4 IM MV1000-17E



1.1 Ethernet Interface

E-mail Transmission
E-mail Transmission
The available e-mail types are listed below. The MV can automatically transmit
each e-mail type. You can specify two destination groups and specify one of the two
destination groups for each e-mail type. You can also set a header string for each type.
* Alarm e-mail
Reports alarm information when an alarm occurs or clears.
* System e-mail
When the MV recovers from a power failure, it reports the time of the power failure
and the time of recovery.
Reports the detection of a memory shortage when it is detected.
Reports the error code and message when a media error occurs (when an error
occurs on an external storage medium or when data cannot be stored due to
insufficient free space on an external storage medium).
Reports the error code and message when an FTP client error (when data transfer
fails using the FTP client feature) occurs.
» Scheduled e-mail
Transmits a message when the specified time is reached. You can use this feature to
check that the network and e-mail transmission functions are working properly. You
can specify a reference time and e-mail transmission interval for each destination.
» Report e-mail (only on models with the computation function, /M1 option)
Transmits report results.
You can specify POP before SMTP if authentication is necessary before transmission.
For e-mail transmission settings, see section 2.3.
For e-mail transmission formats, see section 2.3.
For the procedure to start/stop e-mail transmission, see section 2.3.

Example of an e-mail sent at a scheduled time

From: MV1000@dagstation.com

Date: Tue, 22 Jan 2008 08:00:45 +0900 (JST)
Subject: Periodic_data Subject
To: useri@dagstation.com, user2@mvadv.co.jp

LOOP1 Header 1
TEMPERATURE Header 2
Time

Host name

MV1000

Time of transmission
01/05 08:00:01

E-mail Transmission Test

* You can test e-mail transmission by sending a test mail from the MV to a destination.
* You can view the test result in the e-mail log screen.

* For information on how to use this feature, see section 2.3.

IM MV1000-17E 1-5
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1.1

Ethernet Interface

SNTP Server/Client

DHCP Client

Other Features

The client feature retrieves time information from a specified SNTP server at a specified
interval.

The server feature can provide time information to MVs and other devices connected to
the same network.

You can use this feature to automatically obtain an IP address from a DHCP server. You
can manually retrieve or release network information.

Ethernet Interface Connection Status Check

You can check the Ethernet interface connection status on the MV rear panel or the MV
screen.

For a description of the connection status indicators, see section 2.2.

Keepalive (TCP extension feature)

This feature drops the connection if there is no response to a test packet that is
periodically transmitted at the TCP level.

For the settings necessary to use this feature, see section 2.2.

Log Display

You can display operation logs on the MV log screen. You can also check logs
using communication commands. The Web screen can also display logs (except
communication and DHCP logs).

» Error log screen: A log of operation errors

» Communication log screen: A setting/measurement server communication input/
output log

* FTP log screen: A log of file transfers carried out using the FTP client
feature

+ WEB log screen: A Web server operation log

» Mail log screen: Alog of e-mail transmissions

* Login log screen: A login/logout log

* SNTP log screen: An SNTP server access log

* DHCP log screen: A DHCP server access log

* Modbus log screen: A Modbus status (master/client operating condition) log

For the procedure to show the log screen and details on the displayed contents, see the
MV1000/MV2000 User’s Manual (IM MV1000-01E).

For details on the Modbus status log, see section 2.8.

For details on how to output logs using communication commands, see section 5.2. For
details on how to show logs on the Web screen, see section 2.4.

IM MV1000-17E



1.2 Serial Interface

The MV supports serial communications via the RS-232 and RS-422/RS-485. This
chapter gives an overview of the MV serial communication functions.

Modbus Communications
* The MV can connect to a Modbus device and read and write to the device’s internal
registers. See section 1.3 for details.

Setting/Measurement Server
» You can use this feature to set almost all of the settings that can be configured from
the MV front panel keys. See section 1.1 for details.
» For the settings necessary to use this feature, see section 3.3.

IM MV1000-17E 1-7
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1.3 Modbus Protocol

Modbus Client/Master

The MV can connect to a Modbus server or slave device and read and write to the
device’s internal registers.
The MV can handle the data that is read from the registers as communication input
data on a computation channel (computation function’). The MV can also handle the
data on an external input channel.?
The MV can write measured and computed data to the registers.

1 /M1 option.

2 MV2000 with the /MC1 option.
For details on the Modbus function codes that the MV supports, see section 7.3.
For the settings to use the Modbus client feature, see section 2.9. For the settings to
use the Modbus master feature, see sections 3.3, 3.5, and 3.6.

Server Device Connection Example
- = - Modbus server device

w0
=
120
ISP = Yon)
= = pncknnnan |

| Ethernet
|

!

—

Mv

088 & 00

MV (client) [ o= =

=

Modbus Server/Slave

A Modbus client (master) device can connect to an MV, a Modbus server (slave)
device, to read the measured, computed,” or external input? data that is written in the
input register or to read or write data to communication input data’ or to an external
input channel? through the MV hold register.

1 /M1 option.

2 MV2000 with the /MC1 option.
For details on the Modbus function codes that the MV supports, see section 7.3.
For the settings to use the Modbus client feature, see section 2.8. For the settings to
use the Modbus master feature, see sections 3.3, 3.4, and 3.6.

Example of a Connection with a Modbus Master Device
= C Modbus master device

T

1l o |lo |lo =

g
I

0o
0o
O

UD
B

]

I Serial communication

i

MV

088 @ 00

MV (slave) | Tooo o

=
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Chapter 2  Using the Ethernet Interface

21 Workflow for Using the Ethernet Interface

Follow the flowchart below to configure Ethernet communication.

Connect the ports

IP address Automatically assigned IP address (DHCP)

assignment method

Fixed IP address

aoeIaju| JoulaYylg ay) buisn

Set the IP address Set the Obtain DNS

info item
Set the subnet Set the Host name
mask registration

Set the default
gateway Set the host name
Set the host name Set the domain Not set when Obtain
(optional) name DNS info is set to Use.
Set the domain Set the DNS server Not set when Obtain
name (optional) search order DNS info is set to Use.

Set the DNS server
search order

Set the domain suffix
search order

IM MV1000-17E 21



2.2 Connecting the MV

Connecting to the Port

Ethernet Port
Connect an Ethernet cable to the Ethernet port on the MV rear panel.

Ethernet cable

CAUTION

Be sure to connect an Ethernet cable

with an FCC-compliant plug. Otherwise,

the MV may malfunction.
|

Connecting to a PC
Connect the MV to a PC via a hub. To make a one-to-one connection, see the figure
below. You can connect multiple MVs to a single PC in the same way.

MV

? Hub
QCIcacig

0688 & 00

U
0
m_
0|01
u

0

Ethernet cable

2-2 IM MV1000-17E



2.2 Connecting the MV

Setting the IP Address, Host Information, and DNS

MV1000

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > IP address

¢ Press MENU and then select MENU tab > Basic setting mode > Menu tab >
Communication (Ethernet) > Host settings

¢ Press MENU and then select MENU tab > Basic setting mode > Menu tab >
Communication (Ethernet) > DNS settings

MV2000

¢ Press MENU and then select MENU tab > Basic setting mode > Menu tab >
Communication (Ethernet) > IP address, Host settings

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > DNS settings

IP address settings (DHCP set to Not) IP address settings (DHCP set to Use)
Basic Setting Mode Lirk Basic Setting Hode
IP-addre=zs IP-addre=zs
DHCP DHCP
DHS accession Uze
Host-name register Uze

Fixed IP-address

IP-address 192,168, 1.18@
Subnet mask 256,256,266, @
Default gatewaw 192.168. 1. 1@

Host name settings DNS settings
Basic Setting Hode i Basic Setting Hode

Host settings Server search order

Host name Primary 92,168, . 28
Secondary 192,168, 1. 38

Domain name Domain suffix search order

Haastation.com Primary
fri.dagstation.com
Secondary

kec.dagstation. com

[ Ireut | |

Set the IP address to a fixed IP address or obtain it automatically (DHCP).
Consult with your network administrator for network parameters such as the IP address,
subnet mask, default gateway, and DNS.

IM MV1000-17E 2-3
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2.2 Connecting the MV

When Using a Fixed IP Address
e DHCP
Set DHCP to Not.

e |P address
Set the IP address to be assigned to the MV.

¢ Subnet mask
Set the subnet mask according to the system or network that the MV belongs to.

e Default gateway
Set the gateway IP address.

* Host name
Set the MV host name using up to 64 alphanumeric characters. You do not have to set
this parameter.

¢ Domain name
Set the name of the domain that the MV belongs to using up to 64 alphanumeric
characters. You do not have to set this parameter.

e Server search order
Register up to two IP addresses for the primary and secondary DNS servers.

* Domain suffix search order
Set up to two domain suffixes: primary and secondary.

When Obtaining an IP Address Automatically (DHCP)

e DHCP
Set DHCP to Use.

¢ Obtain DNS info
To automatically obtain the DNS server address, select Use. Otherwise, select Not. If
you select Not, you must set the server search order.

* Host name registration
To automatically register the host name to the DNS server, select Use.

¢ Host name
Set the MV host name using up to 64 alphanumeric characters.

e Domain name
Set the name of the domain that the MV belongs to using up to 64 alphanumeric
characters. This parameter is valid when Obtain DNS info is set to Not.

* Server search order
Register up to two IP addresses for the primary and secondary DNS servers.

¢ Domain suffix search order
Set up to two domain suffixes: primary and secondary.

2-4 IM MV1000-17E



2.2 Connecting the MV

Requesting/Clearing Network Information through DHCP
You can manually request or release IP address and other network information. This
operation applies when DHCP is set to Use. First switch to the network information
screen and then execute the request or release (clear) operation.

Requesting Network Information

1. Switch to the network information screen.
¢ Press FUNC > Network info

IF address @, @8, @ @
Subnet mask @, @8, @ @
Default gatewsw @ @, @, B, @
HAG address t BE B8 :A8: 8888 8A
DNS zerver

Primary @, @8, @ @
Secondary @, @8, 8. @
Host name

nvady

Domain name
daustation. com

aoeialu| J9ulaYylg oy buisn

2. Request network information.

¢ Press FUNC > Network info > Request

HET! i T

, G IEET(O)
IF address @, @8, @ @ IF address A, @, @, @
Subnet mask @, @8, @ @ Subnet mask @, @8, @ @
Default gatewsw @ @, @, B, @ Default gatewsw @ @, @, B, @
HAG address t BE B8 :A8: 8888 8A HAG address t BE B8 :A8: 8888 8A
DNS zerver DNS zerver
Primary 1 B, @ B, 8 Primary @, @8, @ @
Secondary 1 B, @, B, 8 » Secondary @, @8, 8. @
Host name Host name
nvady nvady
Domain name Domain name
daustation. com daustation. com

IP address 1 192,168, 1,188
Subnet mask 255,255,255, @
Default gatewaw @ 192,168, 1. 1A
HAG address t BE B8 :A8: 8888 8A
DNS zerver

Primary 1 192,168, 1. 28
Secondary 1 192,168, 1. 3@
Host name

nvady

Domain name
daustation. com

The retrieved network information appears.

IM MV1000-17E 2-5



2.2 Connecting the MV

Clearing Network Information

1. Switch to the network information screen.

O Press FUNC > Network info

IF address
Subnet mask

Default gateway @
HE: 68 a0 BE 86 By

HAG address
DNS zerver
Primary
Secondary
Host name
nvady
Domain name
daustation. com

t 192,168, 1.18@
1 285,266,265, @
132,168, 1. 18

P 192,168, 1. 28
P 192,168, 1. 38

2. Release (clear) the network information.

O Press FUNC > Network info > Release

[ = —
;.0 G0 IEET(D)

IF address
Subnet mask

Default gateway @
HE: 68 a0 BE 86 By

HAG address
DNS zerver
Primary
Secondary
Host name
nvady
Domain name
daustation. com

Subnet mask
Default gateway @

HAG address

DNS zerver
Primary
Secondary

Host name

nvady

Domain name
daustation. com

The network information is released.

t 192,168, 1.18@
1 285,266,265, @

132,168, 1. 18

P 192,168, 1. 28
P 192,168, 1. 38

IF address
Subnet mask

Default gateway @
HE: 68 a0 BE 86 By

HAG address
DNS server

Primary
» Secondary
Host name

nvady

Domain name
daustation. com

IF address
Subnet mask

Default gateway @

HAG address
[ ———

«

t 192,168, 1.18@
1 285,266,265, @

t 192,168, 1.18@
1 285,266,265, @

132,168, 1. 18

P 192,168, 1. 28
P 192,168, 1. 38

, §@o IE(O)

132,168, 1. 18

HE: 68 a0 BE 86 By

DISP/ENTER key
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2.2 Connecting the MV

Setting the Communication Conditions

MV1000

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > Keep alive, Timeout

MV2000

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > Keep alive, Application time out

b

Basic Setting Hode

keep alive “

Application time out

On/fOff (n

Time 1 min
L 00 | off |

Setting the Keepalive Feature
To disconnect when there is no response to the test packets that are periodically sent,

select On. Otherwise, select Off.

Setting the Application Timeout

» Selecting On or Off
To use the application timeout feature, select On. Otherwise, select Off. If you select
On, the Time parameter appears.

* Time
Set the timeout value in the range of 1 to 120 (minutes).

Checking the Communication Status
You can check the Ethernet communication status with the LED lamp that is provided on

the MV rear panel Ethernet connector or the Ethernet link that is shown at the upper right
of the basic setting screen.

IM MV1000-17E
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2.3 Sending E-mail Messages

Configuring E-mail Transmission
Configure the server, and set the contents of the e-mail.
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > E-Mail

Basic settings Recipients
Basic Setting Mode Ciii™ Basic Setting Hode
Basic settings Recipients
SHTP server name Recipient 1 userld tion.com
Fort number Recipient 2 Eser2ﬂdaqstation.com
Security Sender fivadvddaastation. con
| Tnput | | ¢ | Tnput | | ¢
POP3 Settings Alarm settings

Basic Setting Hode

POP3 Settings Alarm settinas
Recipient 1 m Recipient 2 0ff

POP3 Server name
Port number

Active Alarms

Login name
| Alarm 1 On  Alarm 2 On
Pazzword EEEEE LS L LS EEEH alarm 3 f5¥¥_ larm d f5¥¥_
Include INST On
Include source URL On
Subject  Blarm_summary
Header 1
Header 2
[ Toput | | | ¢ L 00 | off |
Scheduled settings System settings
thernet R R
] Basic Setting Mode
Scheduled settinas Swystem settinas
Recipient 1 [0 Recipient 2[ 0ff Recipient 1 [ETN Recipient 2 [off
Interval 1h Interval 2dh
Ref.time  [15:08 Ref.time  [o8:08 Include source URL On
Subject  Bustem_warning
Include INST On Header 1
Include source URL On Header 2
Subject  Periodic_data
Header 1
Header 2
L 00 | off | L 00 | off |
Report settings

Basic Setting Hode

Report settinas
Recipient 1 [N Recipient 2 [off

Include source URL On
Subject  Report_data
Header 1
Header 2
L 00 | off |
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2.3 Sending E-mail Messages

Basic Settings
Specify the SMTP server and POP before SMTP.

SMTP server name

Enter the host name or IP address of the SMTP server.

Port number

Unless specified otherwise, set the number to the default value. The default value is
25.

Security
If you need to use POP before SMTP, set Security to PbS.

Recipients
Set the recipient e-mail addresses.

Recipient 1 and Recipient 2
Enter e-mail addresses. You can enter multiple addresses in each recipient box.
Separate each address with a space. You can enter up to 150 characters.

Sender
Enter the sender e-mail address. You can enter up to 64 characters.

POP3 Settings
If you need to use POP before SMTP, specify the POP3 server.

P For the POP3 login procedure, see “Setting the POP3 Server Connection” in this section.
POP3 Server name
Enter the host name or IP address of the POP3 server.
Port number
Unless specified otherwise, set the number to the default value. The default value is
110.

Login name
Enter the POP3 server login name.

Password
Enter the POP3 server login password. You can enter up to 32 characters.

Alarm Settings
Specify the settings for sending e-mail when alarms occur or clear.

Recipient 1 and Recipient 2

Specify the recipients. For Recipient 1 and Recipient 2, select On to send e-mail or
Off to not send e-mail.

Active Alarms

Sends an e-mail when an alarm occurs or clears. For alarms 1 to 4, select On to send
e-mail or Off to not send e-mail.

Include INST

Select On to attach instantaneous value data that is acquired at the time of alarm
occurrence.

Include source URL

Select On to attach the source URL. You can attach the URL when the Web server is
enabled.

Subject

Enter the subject of the e-mail using up to 32 alphanumeric characters. The default
subject is Alarm_summary.

Header 1 and Header 2

Enter Header 1 and Header 2 using up to 64 characters.

IM MV1000-17E
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2.3 Sending E-mail Messages

Scheduled Settings

Specify the settings for sending e-mail at scheduled times.

* Recipients
Specify the recipients. For Recipient 1 and Recipient 2, select On to send e-mail or
Off to not send e-mail.

e Interval
For Recipient 1 and Recipient 2, set the interval for sending e-mail to 1, 2, 3, 4, 6, 8,
12, or 24 hours.

e Ref.time
Enter the time reference for sending e-mail to Recipient 1 and Recipient 2 at a
specified interval.

¢ Include INST, Include source URL, Subject, Header
These parameters are the same as those listed under “Alarm Settings.” The default
subject is Periodic_data.

System Settings
Specify the settings for sending e-mail when the MV recovers from a power failure, when
there is a memory shortage, and when an error occurs.
* Recipients
Specify the recipients. For Recipient 1 and Recipient 2, select On to send e-mail or
Off to not send e-mail.
* Include source URL, Subject, and Header
These parameters are the same as those listed under “Alarm Settings.” The default
subject is System_warning.

Report Settings

Specify the settings for sending e-mail when reports are generated.

* Recipients
Specify the recipients. For Recipient 1 and Recipient 2, select On to send e-mail or
Off to not send e-mail.

* Include source URL, Subject, and Header
These parameters are the same as those listed under “Alarm Settings.” The default
subject is Report_data.
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2.3 Sending E-mail Messages

Setting the POP3 Server Connection
Specify the operation for connecting to the POP server.
¢ Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Communication > POP3 Details

POP3 Details
POP Before SHTP

Send delay [second] n

POF2 Login PLAIN

Send delay [second]
Enter the wait time from POP3 server authentication until transmission. Set a value in the

range of 0 to 10 (seconds).

POP3 Login
To send the POP3 server login password without encryption, set POP3 Login to PLAIN.
To send the password with encryption, set POP3 Login to APOP.

E-mail Test
¢ Press FUNC and then select E-mail test > Recipient1 or Recipient2
You can send a test e-mail to check the e-mail settings.

Enabling/Disabling the E-mail Transmission Function
Enabling the E-mail Transmission Function
¢ Press FUNC and then select E-Mail start

The e-mail transmission function is enabled.

Disabling the E-mail Transmission Function
¢ Press FUNC and then select E-Mail stop

The e-mail transmission function is disabled. Unsent e-mail messages are discarded.

E-mail Retransmission

If an e-mail transmission fails, the MV retransmits the message up to three times at
30-s, 1-minute, or 3-minute intervals. If retransmission fails, the MV discards the e-mail
message.

IM MV1000-17E 2-11
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2.3 Sending E-mail Messages

E-mail Format

The formats of alarm, scheduled, system, report, and test e-mails are given below.
For details on the displayed items that are common to all e-mails, see “Display Items
Common to All Formats” in this section.

Alarm Notification E-mail Format

¢ Subject

Subject: [Alarm Summary]

¢ Syntax
headerl1CRLF
header2CRLF
CRLF

Alarm_ summary.CRLF
<Host name>CRLF

hostCRLF
CRLF

<CH>ccc:* * *cCRLF

<Type>1gqCRLF

<aaa>mo/dd_hh:mi:ssCRLF

CRLF

<Inst. value>CRLF
mo/dd_hh:mi:ssCRLF

ccc: - -c=ddd-

CRLF

+ +dCRLF

Access_the following URL in order to look at a screen.CRLF
http://host.domain/CRLF

CRLF

ccce- - -C

aaa
ddd- - -d

Channel number or tag name

(Up to 16 characters. Channels set to Skip or Off are not transmitted.
See section 4.3 for channel numbers.)

Alarm level (1 to 4)

Alarm type (H, L, h, 1, R, or r)

H(high limit alarm), L(low limit alarm), h(difference high limit alarm),
1(difference low limit alarm), R(high limit on rate-of-change alarm),
and r(low limit on rate-of-change alarm)

Alarm status (off or on)

Measured/computed value (up to 10 digits including the sign and
decimal point) + unit (up to six characters)

+OVER: Positive range-out
-OVER: Negative range-out
Burnout: Burnout data

e Error data

The MV transmits the channel numbers, alarm types, and alarm statuses for up to
10 events in a single e-mail.

212
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2.3 Sending E-mail Messages

Scheduled E-mail Format

¢ Subject
Subject: [Periodic Datal
Syntax
headerl1CRLF
header2CRLF
CRLF

Periodic data.CRLF
<Host name>CRLF
hostCRLF

CRLF

<Time>CRLF

mo/dd _hh:mi:ssCRLF
CRLF

E-mail message(s) did not reach intended recipient (s).CRLF
ttt-- -t
Count=nnCRLF
mo/dd _hh:mi:ssCRLF

CRLF

<Inst. value>CRLF

mo/dd_hh:mi:ssCRLF

ccc- - -c=ddd- - -dCRLF

CRLF

Access_the following URL in order to look at a screen.CRLF
http://host.domain/CRLF

CRLF

ccc---c Channel number or tag name
(Up to 16 characters. Channels set to Skip or Off are not transmitted.
See section 4.3 for channel numbers.)

ttt---t Type of discarded e-mail

Alarm_summary: Alarm e-mail

Periodic data: Scheduled e-mail

System warning:  System e-mail

Report data: Report e-mail
nn Number of discarded e-mails

ddd---d Measured/computed value (up to 10 digits including the sign and
decimal point) + unit (up to six characters)

+OVER: Positive range-out
-OVER: Negative range-out
Burnout: Burnout data

el Error data

The time that follows the type and count of discarded e-mails is the time when the
last e-mail is discarded.

IM MV1000-17E
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2.3 Sending E-mail Messages

System E-mail (Power Failure) Format

¢ Subject

Subject: [System warning]
* Syntax

headerlCRLF

header2CRLF

CRLF

Power failure.CRLF

<Host name>CRLF

hostCRLF

CRLF

<Power fail>mo/dd hh:mi:ssCRLF

<Power on>mo/dd_hh:mi:ssCRLF

CRLF

Access_the following URL in order to look at a screen.CRLF
http://host.domain/CRLF

CRLF

System E-mail (Memory Full) Format

e Subject

Subject: [System warning]
¢ Syntax

headerl1CRLF

header2CRLF

CRLF

Memory full.CRLF

<Host name>CRLF

hostCRLF

CRLF

<Memory remain>ppp- - -pMbytesCRLF
<Memory blocks>bbb/400CRLF
<Media remain>rrr---rMbytesCRLF
CRLF

Access_the following URL in order to look at a screen.CRLF
http://host.domain/CRLF

CRLF

ppp- P Remaining amount of internal memory

bbb Number of unsaved blocks (0 to 400)

rrr---r Remaining free space on the external storage medium (when an
external storage medium is connected)

2-14 IM MV1000-17E



2.3 Sending E-mail Messages

System E-mail (Error) Format

¢ Subject
Subject: [System warning]
Syntax
headerlCRLF
header2CRLF
CRLF

Error.CRLF

<Host name>CRLF
hostCRLF

CRLF

mo/dd _hh:mi:ssCRLF
ERROR: fffCRLF

“Operation aborted because an error was found in media.”CRLF
CRLF

Access_the following URL in order to look at a screen.CRLF
http://host.domain/CRLF

CRLF

fff Error number (200, 201, 211, or 281 to 285)
The displayed error message varies depending on the error type. For details on
errors, see the MV1000/MV2000 User’s Manual (IM MV1000-01E).

Report E-mail Format

¢ Subject
Subject: [Report data]
Syntax
headerl1CRLF
header2CRLF
CRLF

ti report.CRLF

<Host name>CRLF
hostCRLF

CRLF

mo/dd hh:mi:ssCRLF
<CH>C;C"‘CCRLF
<tp>eee-: eCRLF
<tp>eee- - -eCRLF
<tp>eee- - -eCRLF
<tp>eee- - -eCRLF
<Unit>uuu- - -uCRLF

CRLF

Access_the following URL in order to look at a screen.CRLF
http://host.domain/CRLF
CRLF

ti Contents of the report e-mail (hourly, daily, weekly, or monthly report)
cccerC Channel number or tag name
(Up to 16 characters. Channels set to Skip or Off are not transmitted.
See section 4.3 for channel numbers.)

IM MV1000-17E
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2.3 Sending E-mail Messages

tp Report content (average, maximum, minimum, instantaneous, and
sum. Four out of the five items above are transmitted.)

eee- e Measured/computed value (up to 10 digits including the sign
and decimal point). However, sum values are transmitted as a
combination of the sign, mantissa, E, sign, and exponent such as in
—3.8000000E+02.
+OVER: Positive range-out
-OVER: Negative range-out
Burnout: Burnout data
Empty data: Error data
uuu- - -u Unit (up to six characters)

Test E-mail Format
* Subject
Subject: [Test]
e Syntax
Test mail.CRLF
<Host_name>CRLF
hostCRLF
CRLF
<Time>CRLF
mo/dd hh:mi:ssCRLF
CRLF
<Message>CRLF
x:msCRLF

x Message number (1 to 10)
ms Message content (only specified messages are transmitted.)

Display Items Common to All Formats
» Time information

mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mi Minute (00 to 59)
ss Second (00 to 59)

The MV transmits the month, day, hour, minute, and second in the time information
in the order specified by the date format set in Basic Setting Mode.
* Host name, domain name, and header information

headerl Header 1 (displayed only when it is set)

header? Header 2 (displayed only when it is set)

host Host name or IP address (IP address when the host name is not
assigned. In the case of an IP address, the <Host> section is set to
<IP address>.)

domain Domain name

Space
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Monitoring the MV on a PC Browser

Configuring the Web Server

From the Basic Setting Mode menu, set the server function and Web page for Ethernet
communication.

Setting the Web Server
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > Server

Server
FTP
Web
SHTP

Hodbus Use

* Web
Set the Web parameter under Server to Use or Not (don’t use). If set to Use, Web

page parameters appear in the Basic Setting Mode menu.

Port Number

The default value is 80. To change the value:

¢ Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Communication > Service port

For the selectable range, see section 7.1.

Setting the Web Page
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > Web page

Basic Setting Hode
Page twpe Operator

On/fOff
Access control 0ff

Command Use

Operator

IM MV1000-17E
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2.4 Monitoring the MV on a PC Browser

Page Types (displayed screen types)
* Monitor
Configure the monitor page. The monitor page can display the following items.
» Alarm summary
» Measured and computed values of all channels
* Log (message summary, error log, etc.)
* For screen examples, see “Monitoring with a Browser” in this section.
» Operator
Configure the operator page. You can carry out the following operations in addition to the
functions available on the monitor page.
» Switch the MV display by specifying the display type (trend, historical trend, digital,
bar graph, or overview). You can also specify the trend and historical trend groups.
« Control the MV DISP/ENTER key, arrow keys, and HISTORY key.
» Set and write MV messages.
» For screen examples, see “Monitoring with a Browser” in this section.

Configuring the Monitor Page

» Setting the page type
To configure the monitor page, select Monitor.

» Selecting On or Off
To display the monitor page on a browser, select On. Otherwise, select Off.

» Setting the access control
To use access control, select On. You must enter a user name and password to
display the monitor page. You must set the security and login in the environmental
settings to use this function. For settings, see the MV1000/MV2000 User’s Manual (IM
MV1000-01E).

Configuring the Operator Page
» Setting the page type
To configure the operator page, select Operator.
» Setting the access control
This setting is the same as that for the monitor page.
» Selecting whether or not to use command input
To use the set and write commands for messages, select On. Otherwise, select Off.
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2.4 Monitoring the MV on a PC Browser

Monitoring the MV on a Browser

Setting the URL
Set the URL appropriately according to your network environment. You can access the
MV by setting the URL as follows:
http://host name.domain name/file name
* http: The protocol used to access the server.
* Host name.domain name: The MV host name and domain name.
You can also use an IP address in place of the host name and domain name.
» File name: The file name of the MV monitor page or operator page.
File name of the monitor page: monitor.htm
File name of the operator page: operator.htm
Omitting the file name is equivalent to specifying the monitor page. However, if the
monitor page is disabled, it is equivalent to specifying the operator page.
Example
To display the operator page on a PC that is in the same domain as the MV, enter
the URL in the browser Address box as follows:
http://mv1000.dagstation.com/operator.htm or
http://192.168.1.100/operator.htm
(In this example, we assume that the domain name is dagstation.com, the host
name is mv1000, and the IP address is 192.168.1.100.)

Login
Enter the user name and login password. You do not have to enter these items if access

control is set to Off in the Web page setting.

¢ Monitor Page Contents

All channel display — Automatically refreshes the screen
Displays measured values and alarm statuses Turn this ON to automatically refresh
of all channels in a separate window. the screen.

Log display

Display the alarm summary

Displays an alarm summary \?V:f]zljxs each log in a separate
in a separate window. "~ Zoom
Changes the zoom rate of

Refresh the screen
the screen.

-
.I e efmh — ZM, MV1000: 100% and 200%
ey T MV2000: 50% and 100%

Log

Data list and print page
Displays the information in
a separate window.

MV screen image
The displayed information is the same as that shown on the MV.

IM MV1000-17E
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2.4 Monitoring the MV on a PC Browser

If the MV is in Setting Mode™ or Basic Setting Mode", the monitor page cannot be
displayed. An error message will appear.
*  For details on modes, see the MV1000/MV2000 User’s Manual (IM MV1000-01E).
Refreshing the monitor page
The monitor page can be refreshed automatically or manually.
* Auto Refresh ON
The monitor page is refreshed at approximately 10-second intervals.
» Auto Refresh OFF
The monitor page is not automatically refreshed. You can refresh the page
manually. The page will not be refreshed within approximately 10 seconds for the
last refreshing even if you try to refresh the page manually.
Displaying the log
You can display the message summary, error log, FTP log, login log, Web operation
log, e-mail log, SNTP log, and Modbus log in a separate window. From the Log list,
select the log you want to display. Click Refresh to refresh the data. The window can
display up to 100 messages and 50 added messages.

Log display (example of a message log display)

LOG
[MESSAGE -]
_Refresh | Cioze | Creation date : 2008/01/23 17:18:53
2?23{ g 15’123 POWER OFF ALL [Key]
2?333’ g 10’; 3 STOP ALL [Communication]
2[;[3]81!2 112 3 DANGER ALL [Key]
2?281’ 2 12’; 3 HIGH VOLTAGE o1 [Communication]
gEot BATTERY A =l
2?331’ [3”1’; 3 POWER ON ATL [Communication]

Refreshing the alarm summary display and all channel display
Click Refresh to refresh the data. The alarm summary can display up to 400 alarms.

Example of an alarm summary display

Refresh Close Creation date : 2008/01/23 17:23:32

Chatinel Ve Alarm Time

\ CFF | IH | 20080123 172330

Example of an all channel display

Refrash Close Creation date : 2008/01/23 17:25:12
Channel - teading
[] 1 L 0.9131 v
[] p L 0.7114 v
[ ] 3 0.5895 v
[] 4 0.4384 v
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2.4 Monitoring the MV on a PC Browser

« Data list
You can easily retrieve files via FTP from the data list link without having to specify the
URL. You can also save the data that is being sampled to a file and retrieve the file.
P For the procedure, see section 2.5.

-]

Data list

Memory
Iledia

Acquire new data
OKl

[ |

» Print page
You can enter a title and comments in the screen image and print the image.

[ 00 —  Title box

By default, the title box displays
the IP address or host name.
You can overwrite the default
title with your own.

Flemse suter commente. —=— Comment input box
Enter comments.
= You can enter more than five
Pint| lines of comments, but only
the first five lines will be printed.

IM MV1000-17E

2-21

aoeIalu| JouIaylg oy buisn ﬂ



2.4 Monitoring the MV on a PC Browser

¢ Operator Page Contents

Displays the alarm summary

All channel Automatically refreshes the screen
Refreshes display Log Zoom
the screen display Message input
I Opens a separate window for
Auto Refresh OFFJ Zoom QLIESN entering a message.

Data list and print page
Displays the information in a
23 14,2507 = DECTON(S)EH i separate window.
' selectGrous > =—— Selects the trend screen
: ! Directly selects the group you

5e|mc;mup=>;,—L want to display.

s <torical di
N elects the historical display
Select Sereen > Directly selects the group you

want to display.

Selects other displays
Selects the overview display,
numeric display, or bar graph
display.

Arrow keys and DISP key

MV screen image HISTORY key Performs the same operations
The displayed information is Performs the same operation ~ as the corresponding keys on
the same as that shown on as the corresponding key on  the MV.

the MV. the MV.

You can carry out the following operations on the operator page in addition to the

operations available on the monitor page.

» Switch between trend, historical trend, digital, bar graph, and overview displays.
For the trend and historical trend displays, you can switch the MV screen by specifying
the group you want to display.

» Control the MV using the DISP/ENTER key, arrow keys, and HISTORY key on the
operator page.
You can carry out the same operations as the DISP/ENTER key, arrow keys, and
HISTORY key on the MV.

» Set and write messages
You can set a message string to MV messages 1 through 10 (up to 32 alphanumeric
characters) and, at the same time, write it to the specified group. The existing
message is overwritten. The following figure indicates an example in which the word
“ALARM” is written to all groups in message number 9, and the Command Response
box shows that the operation has been successfully completed.
Message entry example

Active Message

Message Mo [

TWrite message to
@ Al Groups

€ Group Number 1>
Input Characters HIGH YOLTAGE
Cancel

Command Response

[Eooa:ox
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2.5 Accessing Measured Data Files on the MV from
aPC

You can access data files stored on an external storage medium.

Configuring the FTP Server
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet)> Server

Basic Setting Hode

Server
FTP

Web Use
SHTP Use
Hodbus Use

* FTP
Set the FTP parameter under Server to Use or Not (don’t use).

Accessing the MV from a PC

You can use the following functions when the FTP server is enabled.
Accessing a Data File from a Web Page
¢ If the Data File to Be Retrieved Is Already Generated

1. Click the Data list link.

2. Click Memory or Media.

3. Select the file you want to retrieve from the file list.

4. Drag and drop the file to the desired folder on the PC.
Nofte

* The Internal memory link is ftp://hosthame/MEMO/DATA.
* The External media link is ftp://hostname/DRV0/.
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2.5 Accessing Measured Data Files on the MV from a PC

» If the Data File to Be Retrieved Is Being Generated
1. Click the Data list link.
2. Click OK for retrieving the most recent data.
The Confirmation window opens.
3. Read the information, and click OK.
4. In the File status window, click Update.

If the file has been generated, the Final status window opens. If not, the File status window
will open. Wait for a little while, and click Update again.

5. In the Final status window, click Get.

6. In the File Download window, click Save.

Nofte

* You can retrieve files by carrying out the steps above when the data file contains display
data or event data stored in Free mode.

« The file is generated at different times from the specified file save interval.

Connecting to the MV from a PC via the FTP
An example of retrieving files using a browser is described below. In the Address box,
enter the following:

ftp://host name.domain name/file name
To retrieve data from the internal memory, drag the files from the /MEMO/DATA folder. To
retrieve data from an external storage medium, drag the files from the /DRVO folder. You
can also use an IP address in place of the host name and domain name.
You can also retrieve files easily from the Data list link in the browser window. See
section 2.4 for details.

Login
If the security feature is enabled, you will be prompted for a login name and password.
Enter the login name and password to connect to the server.

Port Number

The default value is 21. To change the value:

¢ Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Communication > Service port

For the selectable range, see section 7.1.
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2.6 Transferring Data Files from the MV

The MV can automatically transfer display and event data files, report data files, and
snapshot data files that are created in the MV internal memory via FTP as the files are

created.

Files to Be Transferred via FTP

The MV automatically transfers display and event data files and report data files to the

FTP destination at appropriate times.

File Type Description

Display data file Automatically transferred at the file save interval.

Event data file Automatically transferred each time the specified length of data is recorded.
Report data file Automatically transferred when a report file is closed (divided). For

example, a data file is transferred once per month if you configure the MV

to generate only daily reports.

Snapshot data file Automatically transferred when you take a snapshot.” Snapshot data files
are transferred regardless of the media storage settings.
* Snapshots taken using the FUNC key, the EV2 communication command,
the USER key, or the remote control function.

Configuring the FTP Client
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > FTP client

FTP transfer file settings FTP connection settings
et N N
Basic Setting Hode Basic Setting Hode
FTP transfer file FTP connection
DispiEvent data “ Server name ftp.dagstation.com
Report On Port number 21
Snapshot 0n Login name v 1A8A
FPazsword (RS EEF S S 5535323553355
Account
PASY mode Off

Initial path

“ Frimary | Second

Specifying the Files to be Transferred via FTP
¢ Disp&Event Data

data

Select On to automatically transfer display and event data files.

¢ Report
Select On to automatically transfer report data files.

¢ Snapshot

Select On to automatically transfer snapshot data files.
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2.6 Transferring Data Files from the MV

Setting the FTP Connection Destination
Set the primary and secondary FTP servers, port number, login name, password,
account, PASV mode, etc. Consult your network administrator for the correct values.

FTP connection
You can specify two destination FTP servers: primary and secondary. If the primary

FTP server is down, the file is transferred to the secondary FTP server.
Server name
Enter the name of the destination FTP server using up to 64 alphanumeric characters.
» If you are using the DNS, you can set the host name for the server name. For DNS
settings, see section 2.2.
* You can also set the IP address. In this case, the DNS is not required.
Port number
Enter the port number of the destination FTP server in the range of 1 to 65535. The
default value 21.
Login name
Enter the login name for accessing the FTP server using up to 32 alphanumeric
characters.
Password
Enter the password for accessing the FTP server using up to 32 alphanumeric
characters. The characters that you enter will be displayed as »x*+x,
Account
Enter the account ID for accessing the FTP server using up to 32 alphanumeric
characters.
PASV mode
Select On when using the MV behind a firewall that requires the passive mode. The
default setting is Off.
Initial path
Set the file transfer destination directory using up to 64 alphanumeric characters. The
delimiter for directories varies depending on the implementation of the destination FTP
server.
Example: When transferring files to the “data” directory in the “home” directory of an
FTP server on a UNIX file system.
/home/data

If the file transfer to both primary and secondary destinations fails, the MV will abort the
file transfer. When the connection recovers, the MV will transfer the data that could not to
be transferred along with the new data file. However, because the data that could not be
transferred resides in the MV internal memory, the data will be lost if it is overwritten.
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2.6 Transferring Data Files from the MV

Testing the FTP Transfer

You can transfer a test file from the MV to an FTP server.
¢ Press FUNC > FTP test

Items to Check Before Executing This Test

» Connect the Ethernet cable properly. For the connection procedure, see section 2.2.

» Check that the Ethernet interface settings are correct. For the setup procedure, see
section 2.2.

Viewing the FTP Test Result

* When you execute an FTP test, the MV transfers a test file named FTP_TEST.TXT to
the FTP connection destination initial path directory that you specified in this section.

* You can check the FTP test result on the FTP log (displayed on the MV (see the
User’s Manual), displayed on the Web screen (see section 2.4), or transmitted with
the FL command (see section 4.8)).
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2.7

Synchronizing the Time

The MV time can be synchronized to the time on an SNTP server. You can also configure
the MV to run as an SNTP server.

Configuring the SNTP Client

You can configure the SNTP client to synchronize the MV time to an SNTP server.
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > SNTP client

Basic Setting Mode
SHTP client zettings
Uses/Hot
Server name
Entp. dagstation.con
Port number 123
Access interval Sh

Access reference time e aa
Access timeout 38z
Time adjust on Start action Off

Use/Not

To use the SNTP client function, select Use. Otherwise, select Not. If you select Use,

the SNTP client parameters appear.

Server name

Enter the SNTP server name using up to 64 alphanumeric characters.

» If you are using the DNS, you can set the host name for the server name. For DNS
settings, see section 2.2.

* You can also set the IP address. In this case, the DNS is not required.

Port number

Enter the SNTP server port number in the range of 1 to 65535. The default value is

123.

Access interval

Set the time interval for synchronizing the time with the server to Off, 1, 8, 12, or 24h.

If you select Off, you can synchronize the time using the soft keys. The time is not

synchronized if the time difference between the MV and the server is greater than or

equal to 10 minutes.

Access reference time
Set the reference time for making queries.

Access timeout

Set the time that the MV will wait for a response from the SNTP server after making a
query to 10, 30, 90 s.

Time adjust on Start action

Select On to synchronize the time with an SNTP server when memory start is
executed. Otherwise, select Off.

Manually Synchronizing the Time

You can synchronize the time at any time using the FUNC key. The SNTP client setting
must be enabled.
¢ Press FUNC > SNTP
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2.7 Synchronizing the Time

Configuring the SNTP Server

You can configure the MV to run as an SNTP server.

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > Server

Server
FTP
Web
SHTP

Hodbus Use

e SNTP

Set the SNTP parameter under Server to Use or Not (don’t use).
When an SNTP client on the network queries the MV for the time information, the MV
returns the time information.

Port Number

The default value is 123. To change the value:

¢ Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Communication > Service port

For the selectable range, see section 7.1.
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2.8 Reading/Writing the MV Data from Another
Device via Modbus

The MV is a Modbus server.
For Modbus specifications, see section 7.3.

Configuring the Modbus Server
You can configure the Modbus server so that another device will be able to read or write
the MV data via Modbus.
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > Server

Basic Setting Hode

Server

FTP Usze
Web Use
SHTP Use

Hodbus

* Modbus
Set the Modbus parameter under Server to Use. If you select Not (not use), you will
not be able to use the Modbus server function.

Port Number

The default value is 502. To change the value:

¢ Press MENU and then select Menu tab > Basic setting mode > Environment tab >
Communication > Service port

For the selectable range, see section 7.1.

Reading or Writing the MV Data from Another Device
Another device (client device) sends commands to the MV to read data from the MV or
write data to the MV.
For the function codes that the MV supports and the MV registers that the client device
can access, see “Modbus Server Function” in section 7.3.
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2.9

Reading/Writing Data on Another Device from

the MV via Modbus

The MV is a Modbus client.
For Modbus specifications, see section 7.3.

Configuring the Modbus Client

You can configure the Modbus client so that the MV will be able to read or write data to

another device via Modbus.

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > Modbus client

Basic settings

Destination server settings

Basic Setting Hode

Hodbus client basic settings

Server number

Basic Setting Hode

Read cwcle Fort Hodbus server name Unit Mo
Retry interval 18min 1| 582 podbus.dagstation. com Auto

2| 5@2 [192.168.1.88 Fixed |_3

3| He2 Auto

4| 5@z Auto

5| G@2 Auto

E| G@2 Auto

7| G@2 Auto

8] &a2 Auto
125ms 256ms S5H@ms

Transmission command settings

Basic Setting Hode

Client command number
First Last Server Reai. Twpe

R-H [cAl -|CcAS 4= | 1 28881 INT1E
W A1 ad =, 1 d@aE1 INT1E
-

181 -| 185 2 dBA1A | INT32_B

=

,f_
,f_
,f_
,f_

T+

=

=
-

=
-

L BB B S SC O e
= =
—+ —+

=

Basic Settings

* Read cycle
Set the read cycle to 125m, 250m, 500m, 1s, 2s, 5s, or 10s.

* Retry interval

Set the interval for retrying the connection when the connection is interrupted for
some reason. Select Off, 10s, 20s, 30s, 1min, 2min, 5min, 10min, 20min, 30 min,
or 1h. If you select Off, the MV will not retry the connection. If communication fails,
communication will stop.
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2.9 Reading/Writing Data on Another Device from the MV via Modbus

Destination Server Settings

Server number
Select registration numbers of the server you want to configure from 1 to 16.

Port

Enter the port number for the selected server in the range of 0 to 65535. The default
value is 502.

Modbus server name

Set the destination Modbus server name using up to 64 alphanumeric characters.

» If you are using the DNS, you can set the host name for the server name.

* You can also set the IP address. In this case, the DNS is not required.

Unit

If the unit number of the destination server is not necessary, select Auto. If a fixed unit
number is necessary, select Fixed. If you select Fixed, the unit number parameter
appears.

No.

Enter a fixed unit number in the range of 0 to 255.

Transmission Command Settings

Client command number
Select numbers of the transmission commands you want to configure from 1 to 16.

Command type
Set the command type to Off, R, R-M, W, or W-M. If you select a command type
other than Off, the client channel, server number, register, and data type parameters
appear.

R: Read the data from the server into external input channels (16-bit signed

integer)
R-M: Read the data from the server into communication input channels (32-bit
floating point)
W:  Write measurement channel data (16-bit signed integer) to the server
W-M: Write computation channel data (32-bit signed integer) to the server
R is selectable on the MV2000 when external input channels (/MC1 option) is installed.
R-M and W-M are selectable when the computation function (/M1 option) is installed.

First/Last (MV channels)
Enter the first and last channel numbers of input/output. The range of channels that
you can enter varies depending on the command type as follows:

R: 201 to 440, R-M: C01 to C60, W: 1 to 48, W-M: 101 to 160
Server (server number)
Select a server number from 1 to 16.
Regi. (server register)
Set the server register number.
Enter an input register in the range of 30001 to 39999 and 300001 to 365536 or a hold
register in the range of 40001 to 49999 and 400001 to 465536.
The register numbers that you can specify vary depending on the command type. See
section 7.3 for details.
Type
The data type.
Select INT16, UINT16, INT32_B, INT32_L, UINT32_B, UINT32_L, FLOAT_B, or
FLOAT_L.
The data type that you can specify vary depending on the command type. See section
7.3 for details.

2-32

IM MV1000-17E



2.9 Reading/Writing Data on Another Device from the MV via Modbus

Examples of Entering Commands

The following are examples of commands when the MV is operating as a Modbus client
device. If the MV is operating as a Modbus master device, read the word “client” as
“master” and “server” as “slave.”

Connection example
MVAdvanced Instrument A Instrument B Instrument C
(Modbus client) (Modbus server 1)  (Modbus server 2) (Modbus server 3)

I Ethernet

Loading Data into Communication Input Channels
The MV reads the data from the server device and enters the data into communication

input channels in floating point format.

e Example 1
Read a 16-bit signed integer value from instrument A’s register 30001 into C01.

Communication input data Instrument A register

Cco1 30001 | 16-bit signed integer
Command
[RM||cot-cot| «= | 1 || 30001 || INT16 |

e Example 2
Read a 32-bit signed integer value from instrument B’s registers 30003 and 30004

(lower bytes and higher bytes) into C03. Specify the smaller register number in the
command.

Communication input data Instrument B register
[Ccos K 30003 | Lower bytes 32-bit signed int
-DIt sighea integer
30004 | Higher bytes g g
Command
[RM|[co3-co3| «= [ 2 || 30003 || INT32_L |

e Example 3
Read a 16-bit signed integer value from instrument B’s registers 30001 and 30002 into
C01 and CO02. Specify the smaller register number in the command.

Communication input data Instrument B register

m 30001 | 16-bit signed integer
Cc02 30002 | 16-bit signed integer

Command

[RM||[co1-co2| «= | 2 || 30001 || INTIE |

e Example 4
Read a 32-bit floating point value from instrument B’s registers 30005 and 30006
(lower bytes and higher bytes) into C04. Specify the smaller register number in the
command.

Communication input data Instrument B register
co4 ||< 30005 | Lower bytes

32-bit floati int
30006 | Higher bytes tt floating poin

Command
[RM]| [ coa-coa| « | 2 || 30005 || FLOAT_L |
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2.9 Reading/Writing Data on Another Device from the MV via Modbus

Reading Data into External Input Channels (MV2000 only)
The MV reads the data from the server device and enters the data into external input

channels in 16-bit signed integer format.

* Example 1
Read a 16-bit unsigned integer value from instrument C’s register 30001 into external
input channel 201.

External input channel Instrument C register

201 ,'< 30001 | 16-bit unsigned integer
Command
| R || 201-201| «= | 3 || 30001 || uINT16 |

* Example 2
Read a 32-bit unsigned integer value from instrument C’s register 32001 and 32002

into external input channel 202. Specify the smaller register number in the command.

External input channel Instrument C register
202 € 32001 | Higher bytes 32:bit unsianed int
__ Lower bytes -oit unsigned integer
Command
| R || 202-202]| «= | 3 || 32001 ||uINT32_B]|

Writing Measured Values to a Server

* Example
Write the measured value of channel 1 (16-bit signed integer) to instrument A’'s
register 40001.
Measurement channel Instrument A register
001 >'| 40001 | 16-bit signed integer
Command
| w||oo1-001]|=> | 1 || 40001 || INT16 |

Writing Computed Values to a Server

* Example
Write the computed value of channel 101 (32-bit signed integer) to instrument A's
40001 and 40002 registers, lower 16 bits first and then higher 16 bits. Specify the
smaller register number in the command.

Computation channel Instrument A register
L. byt
E 40001 ower yes32-bit signed integer
40002 | Higher bytes
Command
[WR|[101-101 | = | 1 || 40001 || INT32_L |
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2.9 Reading/Writing Data on Another Device from the MV via Modbus

Checking the Modbus Operating Status

Displaying the Modbus Operating Status
¢ Press DISP/ENTER and then select INFORMATION > MODBUS CLIENT

Nofte
To show the MODBUS CLIENT on the display selection menu, you need to change the setting

using the menu customize feature. Carry out the following steps.

¢ Press MENU and then select Menu tab > Menu customize > Display menu
1. Select INFORMATION > MODBUS CLIENT using the arrow keys.
2. Press the View soft key.

Communication conditions

s o= T (J)

Read cucle : 1=

Conect.retrd : 2min
Comm. Data
Mo. Status First Last  Server name Registers
= 1R ®Good CAL - CB1 192.162.1.181 JaeE1

L B

— Register numbers

— Server device host names or IP addresses

ST NN RN V.Y BT N TN

MV channels

L Detail code
— Status lamp
— Cursor used to select a command
(Used to resume command transmission from the front panel keys)

¢ Communication Conditions
The Read cycle and Connect.retry settings are displayed.

e Communication Status
The MV displays the communication status using status lamps and detail codes.

Status Lamp Detail Code Meaning

Green Good Communication is operating normally.

Yellow Command is readying.

Orange Trying to establish a TCP connection.

Red Communication is stopped.

Common to yellow, None No response from the server device.

orange, and red Func The server device cannot execute the command from the MV.
Regi The server device does not have the specified register.
Err There is an error in the response data from the server device.
Link Ethernet cable is disconnected.
Host Unable to resolve the IP address from the host name.
Cnct Failed to connect to the server.
Send Failed to transmit the command.
BRKN Failed to receive the response data or detected a

disconnection.

(Space) The detail code does not appear until the status is

confirmed when communication is started.
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2.9 Reading/Writing Data on Another Device from the MV via Modbus

Resuming Command Transmission
Using the front panel keys, you can resume command transmission to a server device

whose communication is stopped (red status lamp).

1. Using the up and down arrow keys, select the command assigned to the server
device that you want to resume transmission. The message “Push [right arrow] key to
refresh” appears.

2. Press the right arrow key. The MV will transmit a command to the specified server.

Data When Communication Is Stopped and during Connection Retrials
If command transmission stops such as when the connection is disconnected, the

status lamp will turn orange or red, and the communication input data and external input
channel data will be error data. For computation channels, the MV displays “+OVER” or “—
OVER” according to the settings. The MV displays “******” for external input channels.

Data Dropout
A data dropout occurs when the commands 1 to 16 do not complete within the read cycle

(see appendix 2). When a data dropout occurs, the communication input data is held at
the previous value. The Modbus operating status display shows a message indicating
that a data dropout occurred. If this happens, take measures such as making the read
cycle longer or reducing the number of commands. Be sure to confirm that no data
dropout occurs on the Modbus status log display.
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2.9 Reading/Writing Data on Another Device from the MV via Modbus

Function for Automatically Assigning MW100s to the Modbus Client (MV2000

only)

The following setup is carried out from the MV using YOKOGAWA MW100 Data
Acquisition Unit as a Modbus server.
If the MV2000 is a Modbus client, MW100s—Modbus servers on the network—can be
automatically assigned to the MVV2000. This feature is available only on MV2000s with
the external input channel function (/MC1 option).

Setup

Preparation

Configure the MW100s so that they are ready to make measurements (IP address,
system construction, range setting, and the like of the MW100s that are going to be
automatically assigned). For details, see the MW100 User’s Manual.

Setup

Procedure

If the MV IP address is not set, set it before carrying out the procedure below.

1.

Displays the IP address or host name.

Comn[unication

Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > Modbus client > Auto setting.

Carefully read the displayed precautions. Select Yes to execute the auto setting.

Select No to return to the screen operation.

From the list of MW100s that is displayed, select the MW100s to be connected
using the up and down arrow keys, and press DISP/ENTER. The selected
MW100s are assigned to the external input channels of the MV.

Displays the MW100 unit number. The list displays up to

16 units in order from the smallest unit number.

Displays the status of the external input
channel assignments.
No settings:The MW100 is not automatically

Not Ready:

Basic Setting Hode
{Ethernet> > Hodbus client > Auto setting

—

192.168.1.181
[192.168.1.182

Ext. 1/0 name or IP Unit No. Status
Jil5] 2081/220
i1} No settings

?

assigned.
The MW100 cannot be connected.*
Displays the number of the
assigned external input channel
Example: If an MW100 is assigned
to external input channels
201 to 220, the status
displays 201/220.

To correct the problem, see the
MV1000/MV2000 User’s Manual.

Pressing the Call soft key causes “--” to blink for 2 seconds on the 7-segment LED
display of the selected MW100.
This feature allows you to check which MW100 is selected if multiple MW100s are connected.

IM MV1000-17E
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2.9 Reading/Writing Data on Another Device from the MV via Modbus

Settings

The MW100 channels are assigned to the MV external input channels as follows:

» Channel numbers
The channels of the MW100 selected first are assigned consecutively to external
input channels from 201. The channels of the MW100 selected next are assigned
consecutively to the available external input channels from the smallest number. You
cannot select the target external input channels.

MW100 Automatic
MV external measurement assignment
Mv input channels channels order
T _ ____________________________ I
= CH;ZM « ! CH?M Measurement channels!
- : ! : CH001 to CH020 !
I I
g CH220 . [cHo20
T s CH221 : CHo001 Measurement channels:
= « N CHOO1to CHOO4, 1
CH240 | [CHo14] mirlemd. criomochHo )
| CH241 | 1 [ .CH001 | !
— « ! - Measurement channels:
: X :
: : CHO001 to CH030
CH270 i [cHozo |

* Range settings
The range settings of the MW100 (including the span and unit) are set automatically
to the external input channels.
If the span setting of the MW100 range exceeds the span setting range of the MV
external input channel (—30000 to 30000), it is set to the span upper limit (30000) or
lower limit (—30000).
Specify the settings such as the alarm, the tag, and the area display of the color scale
band of each channel after the auto setting is complete.

Note

Precautions When Assigning Channels to the External Input Channels

The MW100 channels are assigned 10 channels at a time to the external input channels. If
the MW100 measurement module consists of less than 10 channels, “OFF” is assigned to
the external input channels for the section without channels.

An error occurs if the number of MW100 channels to be automatically assigned is greater
than the number of available external input channels.

If the range setting of a MW100 channel is set to “SKIP,” the corresponding MV external
input channel is set to “OFF.”

If a MW100 unit contains a module that cannot be assigned automatically, only the channels
that can be assigned are assigned to the MV external input channels.

If a new MW100 is added, auto setting is executed again. Because all the settings are
cleared, you must execute auto setting again for all MW100s.

If you are connecting MW100s that can be automatically assigned along with MW100s
that cannot be automatically assigned or other Modbus devices, automatically assign the
MW100s that can be automatically assigned first and then manually assign the remaining
devices.
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2.9 Reading/Writing Data on Another Device from the MV via Modbus

Note
About the MW100

+  MW100s that support auto assignment are those with firmware version R2.22 or later.

*«  MW100 modules that can be automatically assigned are the following input modules. The
installable input modules vary depending on the MW100 firmware version.
4-CH, High-Speed Universal Input Module
10-CH, Medium-Speed Universal Input Module
6-CH, Medium-Speed Four-Wire RTD Resistance Input Module
10-CH, High-Speed Digital Input Module
30-CH, Medium-Speed DCV/TC/DI Input Module
10-CH, Medium-Speed Pulse Input Module

« If there are no assignable channels or the Modbus server setting is Off, auto setting fails
with an error. Check the settings.

*  MWA100s that are connected through auto setting automatically switches to the measurement
mode.

*  MW100 port number 34324 is used to perform auto setting.

* For details on the MW100 settings, see the MW100 User’s Manual.

The first channel information of the MW100 that is automatically assigned to an external
input channel can be displayed when the cursor is on the first or last channel.

®

GROUP 1 =
omaesni /25 12:34:56 e DISP NN 1hour
Ext. channel > Range. Alarm

First-CH Last-CH 201
Ext. range
On/0ff Span Lover Span Upper Unit

[On [-2ooed [ zome [V

Ext. alarm
1 [off
2 [off
3 [Ooff
4 [0ff

In addition, you can check the status of the connected MW100 on the Modbus status
display screen.

HODBUS CLIENT =
Doe/oL/38 Lo:oacs6 el D1 N trer  (3)

Read cycle T 1s ‘

Connect-retry : 2nin

Conn. Data
No. Status First Last  Server name Registers

READ O Cnet 201 - 220 192.168.1.181 3pea1

»
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2.10 Usage Example of the Modbus Function

This section explains an example of setting two MV1000s that are connected via the
Ethernet network, one configured to be a Modbus client and another configured to be a
Modbus server. This section refers to the MV1000 configured to be a Modbus server as
the MV1000 server and the MVV1000 configured to be a Modbus client as the MV1000

client.

System Configuration and Operation
The measurement channels, computation channels, and communication input data
shown below will be used. We assume that the Ethernet interface is already configured.

|

{

ﬁ
(oo

MV1000 server
(Modbus server)

Server number: 1

Measurement channel 1
Input range: —2.000 to 2.000 V

Modbus service port
502 (default value)

Operation

Command

B —
Measured data

I Ethernet
izl

i

088 @ (00

CI=l=l= =]
e =

MV1000 client
(Modbus client)

Reads measured data from the MV1000
and displays data on a computation
channel (/M1 option).

Communication input data C01

'

Computation channel 101
—2.000 to 2.000 V

\

Start the computation

\

Displayed in group 1

» The MV1000 client reads the measured value from the MV1000 server channel 1 into
communication input channel C01 and displays the value on computation channel
101. The MV displays computation channel 101 in group 1.

* The measured value of MV1000 server channel 1 is transferred to the MV1000 client

as an integer in the range of —20000 to 20000.

» The MV1000 client displays values in the range of —2.0000 to 2.0000 V for values
in the range of —20000 to 20000. The value is linearly scaled using the following

equation.

The value on MV1000 client computation channel 101 = Communication input data

C01 x 0.0001
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2.10 Usage Example of the Modbus Function

Configuring the MV1000 Server (Modbus server)

Configuring the Modbus Server Function
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > Server

Basic Setting Hode

Server

FTP Usze
Web Use
SHTP Use
Hodbus

Parameter Setting
Modbus Use
Port Number

The default value is 502.

Configuring Measurement Channels
¢ Press MENU and then select Menu tab > Meas channel > Range, Alarm

5 S IEET(S) )
First-CH: Last-CH: [1

Range

Hode Range Span_L Span_ll

[Wo1t [ 2y [-2.eeee [ 2.eee8

Alarm

1 [off

2 [off

3 [off

4 [off

1 1 2 [ 3 | 4 |

Parameter Setting
First channel and last channel 1

Mode Volt
Range 2V
Span_L —2.0000
Span_U 2.0000
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2.10 Usage Example of the Modbus Function

Configuring the MV1000 Client (Modbus client)
The description below assumes that settings other than destination server settings and
commands are at default values.
Registering the Destination Server
The example below describes the settings used to register the MV1000 server to number 1.
The MV1000 server IP address is assumed to be 192.168.1.101.
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Ethernet) > Modbus client > Modbus server settings

hEt

Basic Setting Hode

Server number

Hodbus server name Unit

o
o
=
~

o
=
=

192.168.1.181 futo
Auto
Auto
Auto
Auto
Auto
Auto
Auto

o
=
=

[ = SRS RN U
||| m
o @@ ==
rafra| raf R3] R

o
=
=

Parameter Setting

Port 502

Modbus server name 192.168.1.101
Unit Auto

Setting Transmission Commands
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Ethernet) > Modbus client > Command settings

Basic Setting Mode
Client command number

First Last Server Regi. Twpe

1[r-H [cal -[cal 4= [ 1 I@@a1 | INTIG

2[off

aloff

4[off

5[0ff

6loff

7[off

aloff
Parameter Setting
Command type R-M
First and Last CO01
Server 1
Regi. 30001
Type INT16

2-42 IM MV1000-17E



2.10 Usage Example of the Modbus Function

Configuring Computation Channels
¢ Press MENU and then select Menu tab > Math channel > Expression, Alarm

oz @0 T (S)
First-CH: GHl Last-CH: 181
Hath an
Galculation expression
atskal
Span Lower Span Upper Unit
[ -2.eees | 2. eeae [y
Alarm
[off
2 [off
3 [off
4 [off
Parameter Setting
First and Last 101
Math On
Calculation expression 01+K01
Span Lower —2.0000
Span Upper 2.0000
Unit V

¢ Press MENU and then select Menu tab > Math channel > Constant
' §or T (O)

Humber of constant

Walue ﬁ.EBBI
Parameter Setting
Number of constant K01
Value 0.0001

Assigning a Channel to a Group
¢ Press MENU and then select Menu tab > Group set, Trip line

Group number

Group set

On/fOff (n
Group name GROUP 1
CH set 181
Trip line

Parameter Setting
Group number 1

On/Off On
Group name GROUP 1
CH set 101

IM MV1000-17E
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2.10 Usage Example of the Modbus Function

Starting Computation (MV1000 client)
¢ Press FUNC > Math start
Computation starts, and the status display section shows the math icon.
The value of the MV1000 client’s computation channel 101 shown in GROUP 1 varies
in sync with the measured value of the MV1000 server’s measurement channel 1.

Imirn/div

Checking the Modbus Operating Status (MV1000 client)
Showing the Menu Used to Switch to the Modbus Client Screen
Carry out the procedure below to show INFORMATION > MODBUS CLIENT in the
display selection menu.
¢ Press MENU and then select Menu tab > Menu customize > Display menu
1. Select INFORMATION > MODBUS CLIENT using the arrow keys.
* Select MODBUS MASTER to use Modbus master via the serial interface.
2. Press the View soft key.
The menu item is enabled and is displayed in white.

30:55 =R (D)

. HODBUS CLIENT
= HODBLS HASTER
il RELAY View/Hide

Pressing the View soft key changes
the soft key to Hide.

3. Press ESC several times to return to the operation screen.

Displaying the Modbus Client Screen
¢ Press DISP/ENTER and then select INFORMATION > MODBUS CLIENT
* Select INFORMATION > MODBUS MASTER to use Modbus master via the serial
interface.

- +=
= o= I (O
=

1
Conect.retrd : 2min

Comm. Data
Mo. Status First Last  Server name Registers

= 1 R @Good CB1 - CB1 192.168.1.181 J@8al

ST NN RN V.Y BT N TN
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Chapter 3  Using the Serial Interface

3.1 Workflow for Using the Serial Interface

The flow chart below shows the procedure to set RS-232 or RS-422/RS-485

communication.

The procedure differs between RS-232 and RS-422/RS-485.

Connect a cable

Set the baud rate

Set the data length

Set the parity

Communication type

RS-232

Set the handshaking

RS-422/485

Set the address

Set the protocol

Configure the
Modbus master

Configuration required when the protocol
is set to Modbus master.

IM MV1000-17E
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3.2 Connecting the MV

Connecting a Cable
Connect a cable to the serial port on the MV rear panel.

RS-232 Connection Procedure
Connect a cable to the 9-pin D-sub RS-232 connector.

Connector Pin Arrangement and Signal Names
1 2 3 4 5

©

P ——
Ei=]

(Rear panel)

Pin assignments are shown in the table below.
The table shows the signal names as defined by the RS-232 , JIS, and ITU-T
standards along with their description.

Pin Signal Name Name Signal Description
JIS ITU-T RS-232
2 RD 104 BB(RXD) Received data Input signal to the MV.
3 SD 103 BA(TXD) Transmitted Output signal from the MV.
data
5 SG 102 AB(GND) Signal ground Signal ground.
7 RS 105 CA(RTS) Requestto Handshaking signal transmitted
send from the MV used to receive data
from the PC.
8 CS 106 CB(CTS) Cleartosend Handshaking signal transmitted
from the MV used to receive data
from the PC.

* Pins 1, 4, 6, and 9 are not used.

Connection
+ Signal direction

<€— RS [Request to send...Ready to receive]
—— CS [Clear to send...Ready] ——— >

7

8

MV
<€— SD [Send data] 3
2

PC

—— RD [Received data] >

3-2
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3.2 Connecting the MV

» Connection example

* OFF-OFF/XON-XON * CS-RS (CTS-RTS)

PC MV PC MV
SD 3 SD SD 3 SD
RD 2 RD RD 2 RD
RS O 7 RS RS 7 RS
Ccs 8 CS CS 8 CS
SG 5 SG SG 5 SG

* XON-RS (XON-RTS)

PC Mv

SD 3 SD  You do not need to wire RS on the PC to
RD 2 RD ¢35 onthe MV. However, we recommend it
RS 7 RS B .

cs —.. g cs So thatthe cable can be used in either

SG 5 SG direction.

Handshaking
When using the RS-232 interface for transferring data, it is necessary for equipment on
both sides to agree on a set of rules to ensure the proper transfer of data. The set of
rules is called handshaking. Because there are various handshaking methods that can
be used between the MV and the PC, you must make sure to choose the same method
for both the MV and the PC.
You can choose any of the four methods in the table below for the MV.

Handshaking Combinations (Yes indicates that it is supported)

aoeivju| [elas ay) Buisn H

Data transmission control Data Reception Control
(Control used to send data to a computer) (Control used to receive data from a computer)
Software Hardware Software Hardware
handshaking handshaking handshaking handshaking
Stops sending Stops sending |[No Sends X-OFF Sets RS (RTS) to No
Handshaking|when X-OFF is when CS (CTS) |handshaking| When the receive | false when the handshaking
received. Resumes | is false. data buffer is 3/4 | receive data buffer
when X-ON is Resumes full. Sends X-ON | is 3/4 full. Sets RS
received. when it is true. when the receive | (RTS) to true when
data buffer is the receive data buffer
1/4 full. is 1/4 full.
OFF-OFF Yes Yes
XON-XON Yes Yes
XON-RS Yes Yes
CS-RS Yes Yes
+ OFF-OFF

» Data transmission control
There is no handshaking between the MV and the PC. The MV treats the “X-OFF”
and “X-ON” signals that are received from the PC as data and ignores the CS
signal.

» Data reception control
There is no handshaking between the MV and the PC. When the received buffer
becomes full, the MV discards all of the data that overflows.
RS = True (fixed).
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3.2 Connecting the MV

* XON-XON

Data transmission control

Software handshaking is performed between the MV and the PC. When an “X-OFF”
code is received while sending data to the PC, the MV stops the data transmission.
When the next “X-ON” code is received, the MV resumes transmission. The MV
ignores the CS signal that is received from the PC.

Data reception control

Software handshaking is performed between the MV and the PC. When the used
area in the received buffer increases to 1537 bytes, the MV sends an “X-OFF”
code. When the used area decreases to 511 bytes, the MV sends an “X-ON” code.
RS = True (fixed).

* XON-RS

Data transmission control

The operation is the same as with XON-XON.

Data reception control

Hardware handshaking is performed between the MV and the PC. When the used
area in the received buffer increases to 1537 bytes, the MV sets “RS=False.” When
the used area decreases to 511 bytes, the MV sets “RS=True.”

* CS-RS

Note

Data transmission control

Hardware handshaking is performed between the MV and the PC. When the

CS signal becomes False while sending data to the PC, the MV stops the data
transmission. When the CS signal becomes True, the MV resumes the data
transmission. The MV treats the “X-OFF” and “X-ON” signals that are received from
the PC as data.

Data reception control

The operation is the same as with XON-RS.

*  You must design the PC program so that the received buffer of neither the MV nor the PC
does not become full.
» If you select XON-XON, send the data in ASCII format.
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3.2 Connecting the MV

RS-422/485 Connection Procedure

Terminal Arrangement and Signal Names
Connect a cable to the clamp terminal.

e

(Rear panel)

OO0
WS )55 5|5

FG SDB RDB
SG SDA RDA

Terminal assignments are shown in the table below.

Signal Name

Signal Description

FG (Frame Ground)

The MV case ground.

SG (Signal Ground)

Signal ground.

SDB (Send Data B)

Send data B (+).

SDA (Send Data A)

Send data A (-).

RDB (Received Data B)

Receive data B (+).

RDA (Received Data A)

Receive data A (-).

Connection
» Connecting a cable

As shown in the figure below, remove approximately 5 mm of the covering from the
end of the cable to expose the conductor. Keep the exposed section from the end of

the shield within 5 cm.

» Connection for a four-wire system

SG SDA
SDB

RDA
RDB

OO0

.
@\ﬂﬂﬂ

A
Shield potential

Shield

Connecting to a Host Device

The figure below illustrates

the connection of the MV to a host device. If the port on the

host device is RS-232, connect a converter.

Host computer or
host device

|_:| RS-422/485

Host device side
-

RS-422/485 port
on the MV

Host computer

Converter

|‘:| RS-232 |:| RS-422/485

RS-422/485 port
on the MV

Host device side
-

IM MV1000-17E
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3.2 Connecting the MV

Host device
side

SDA(-)O

— Terminator (external) 120 Q 1/2W or greater

Example of a Connection to the Host Device
The MV can connect to a host device that has an RS-232, RS422, or RS-485 port.

If the host device has an RS-232 port, use a converter. See the examples below for
typical converter terminals. For details, see the converter manual.

RS-422/485 Port Converter
SDA(-) TD(5)
SDB(+) TD(+)
RDA(-) RD(-)
RDB(+) RD(+)

SG SHIELD
FG EARTH

There is no problem with connecting a 220-Q terminator at each end if YOKOGAWA PLCs or
temperature controllers are also connected in the communication line.

e Four-Wire System
Generally, a four-wire system is used to connect the MV to a host device. In a four-

wire system, the transmission and reception lines need to be crossed over.

Terminator (external) —

SDB(+)O

RDA(-)O

RDB( +)O

SG
L

?]

RS-422/485
terminal on the MV
SD A soA | /N SD A
O (SDA) O ---(SDA)- L >0
SD B / \ SD B / SD B
O (SDB) O --(SDB)-- —O
RD A RD A RD A
O (RD A) O --(RDA)-- O
RD B XX RD B RD B ?
O (RD B) O --(RD B)-- O
SG SG SG
O (SG) O -~ (SG) --
/Fg_l‘o \ / 7 ;glo
L L

P

#1

3+

#n
(#n =32)

Do not connect terminators to #1 through #n-1.

¢ Two-Wire System
Connect the transmission signals to the reception signals with the same polarity on the
RS422/485 terminal block. Only two wires are used to connect to the external device.

Terminator (external) 120 Q 1/2W or greater Terminator (external)

RS-422/485
Host device terminal on the MV
/ § \ SD A 7N\ \ SD A
SDA(-)O (A) O (A)
SDB(+)3\ i ® \ sy [ | ® \ soe) T
RD A RD A
RDA( -)
RD B RD B
RDB( +)
' SG SG
SG OK (SG) / O (SG) / 7FC(>;
FG
L
=\ A s
1 T T
- # -

[IA

n

=

(

31)

Do not connect terminators to #1 through #n-1.
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3.2 Connecting the MV

Nofte
* The way to eliminate noise varies depending on the situation. In the connection example, the
cable shield is connected only to the MV’s ground (one-sided grounding). This is effective
when there is a difference in the electric potential between the PC’s ground and the MV’s

ground, which may be the case with long distance communications. If there is no difference
in the electric potential between the PC’s ground and the MV’s ground, connecting the cable
shield to ground at both ends may be effective (two-sided grounding). In some cases, using
two-sided grounding with a capacitor connected in series at one end is effective. Consider
these possibilities to eliminate noise.

*  When using the two-wire system (Modbus protocol), the 485 driver must be set to high
impedance within 3.5 characters after the last data byte that the host PC sends.

Serial Interface Converter

We recommend the following converter.
MODEL RC-770X by SYSMEX RA CO.,LTD; SI-30FA by LINE EYE; or ML2 by
YOKOGAWA.

A CAUTION

In converters other than those that we recommend, the FG and SG terminals may

not be isolated. In such case, do not follow the diagram on the previous page (do

not connect anything to the FG and SG terminals). Especially in long distance

communications, the potential difference that occurs may damage the instruments

or may cause communication errors. For converters that do not have the SG

terminal, they can be used without the signal ground. For details, see the converter

manual.
I ——
In converters other than those that we recommend, the signal polarities may be reversed
(A/B or +/- indication). In this case, reverse the connection.

In the case of a two-wire system, the host device must control the converter transmission
driver to prevent collisions of transmitted and received data. If you are using one of the
recommended converters, control the transmission driver using the RS (RTS) signal on
the RS-232.

When the System Contains Instruments That Only Support the RS-422
Interface

In a four-wire system, up to 32 MVs can connect to a single host device. However, this
may not be possible if the system contains instruments that support only the RS-422
interface.

When the System Contains YOKOGAWA Recorders That Only Support the

RS-422 Interface

Only up to 16 instruments can be connected. Some of the conventional YOKOGAWA
recorders (HR2400 and R, for example) only support the RS-422 driver. If the system
contains these recorders, only up to 16 instruments can be connected.

Note

In the RS-422 standard, the maximum number of connections that are allowed on one port is
10 (for a four-wire system).

Terminator

In a multidrop connection (including point-to-point connection), connect a terminator to
the MV if the MV is connected to the end of the chain. Do not connect a terminator to a
MV in the middle of the chain. In addition, turn the host device terminator ON (see the
host device manual). If a converter is being used, turn ON its terminator. We recommend
converters with a built-in terminator.

Select the appropriate terminator (120 Q), indicated in the figure, according to the
characteristic impedance of the line, the installation conditions of the instruments, and so
on.

IM MV1000-17E
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3.3

Configuring the Serial Interface

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Serial) > Basic settings
Basic Setting Hode

Serial

Baud rate 9668A bps
Data lenath g bit
Parity Even
Handshaking Off:0ff
Address 1
Protocal Hormal

E[T]

For RS-232

Baud rate

Select 0, 1200, 2400, 4800, 9600, 19200, or 38400 (bps).

Data length

Select 7 or 8 (bits). To output the data in binary format, select 8.

Parity
Set the parity to Odd, Even, or None.

Handshaking
Select Off:Off, XON:XON, XON:RS, or CS:RS.

Address

Enter a value in the range of 1 to 99 for the Modbus protocol. For a general purpose

communication protocol, do not set this value.
Protocol

Select Standard for a general purpose communication protocol, Modbus for Modbus

slave, and Master-M for Modbus master.

If you select Modbus master, you must specify Modbus master settings. See section 3.5

for details.

For RS-422/485

Baud rate

Select 0, 1200, 2400, 4800, 9600, 19200, or 38400 (bps).

Data length

Select 7 or 8 (bits). To output the data in binary format, select 8.

Parity
Set the parity to Odd, Even, or None.

Handshaking
Do not set.

Address
Select a number from 1 to 99.

Protocol
This is the same as with the RS-232.

3-8
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3.4 Reading/Writing the MV Data from Another
Device via Modbus

The MV is a Modbus slave.
For Modbus specifications, see section 7.3.

Configuring the Serial Interface
Set Protocol to Modbus under Serial basic settings. See section 3.3 for details.

Reading or Writing the MV Data from Another Device
Another device (master device) sends commands to the MV to read data from the MV or
write data to the MV.
For the function codes that the MV supports and the MV registers that the master device
can access, see “Modbus Server Function” in section 7.3.

IM MV1000-17E 3-9
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3.5

The MV is a Modbus master.

For Modbus specifications, see section 7.3.

Configuring the Serial Interface
Set Protocol to Master-M under Serial basic settings. See section 3.3 for details.

Configuring the Modbus Master
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Serial) > Modbus master > Basic settings or Command settings

Basic settings

Hodbus master bazic settings

Read cwcle
Timeout

Retrials
Inter-block delay
Auto recovery

Command Settings

Basic Setting Hode

S5H@ms

Basic Settings
* Read cycle

Set the read cycle to 125ms, 250ms, 500ms, 1s, 2s, 5s, or 10s.

¢ timeout

Reading/Writing Data on Another Device from
the MV via Modbus

Tupe

INT1R

INT1R

INT32_B

Set the command timeout value to 125ms, 250ms, 500ms, 1s, 2s, 5s, 10s, or 1min.

¢ Retrials

Set the number of retrials when there is no response from the slave. Select Off, 1, 2, 3,

4,5,10, or 20.
* Inter-block delay

Set the wait time between commands to Off, 5ms, 10ms, 15ms, 45ms, or 100ms.

e Auto recovery

Set the auto recovery time from communication halt. Select Off, 1min, 2min, 5min,
10min, 20min, 30min, or 1h.

Command Settings

¢ Master command number

Select 1-8 or 9-16 for the command numbers to be configured.

¢ Command type

Set the transmission command type to Off, R, R-M, W, or W-M.
R: Read the data from the slave into external input channels (16-bit signed

integer)

R-M: Read the data from the slave into communication input channels (32-bit
floating point)
W:  Write computation channel data (16-bit signed integer) to the slave
W-M: Write computation channel data (32-bit signed integer) to the slave
R is selectable on the MV2000 when external input channels (/MC1 option) is installed.
R-M and W-M are selectable when the computation function (/M1 or /PM1 option) is

installed.

3-10
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3.5 Reading/Writing Data on Another Device from the MV via Modbus

¢ First/Last (MV channel numbers)
Enter the first and last channel numbers of input/output. The range of channels that

you can enter varies depending on the command type as follows:
R: 201 to 440, R-M: C01 to C60, W: 1 to 48, W-M: 101 to 160
e Address
Enter the slave device address in the range of 1 to 247.
* Regi.
Set the slave register number.
Enter an input register in the range of 30001 to 39999 and 300001 to 365536 or a hold
register in the range of 40001 to 49999 and 400001 to 465536.
The register numbers that you can specify vary depending on the command type. See
section 7.3 for details.
* Type
The data type.
Select INT16, UINT16, INT32_B, INT32_L, UINT32_B, UINT32_L, FLOAT_B, or
FLOAT_L.
The data type that you can specify vary depending on the command type. See section
7.3 for details.

Example of Entering Commands
See section 2.9.

Checking the Modbus Operating Status

Displaying the Modbus Operating Status
¢ Press DISP/ENTER and then select INFORMATION > MODBUS MASTER

Nofte
To display the MODBUS MASTER on the display selection menu, you need to change the

setting using the menu customize feature. Carry out the following steps.

¢ Press MENU and then select Menu tab > Menu customize > Display menu
1. Select INFORMATION > MODBUS MASTER using the arrow keys.
2. Press the View soft key.

Read cucle : 0= Inter-block delad @ Off
Time out : s Auto recoverd 2 2Zmin
Retrials L

— Communication conditions

Comm. Data Slave
Mo. Status First Last Address Resisters

1 R @ Good CE1 - C@l 1 J@8al
= 2 & Hone 1 -1 1 4E8E1
3 W @ Hone 181 - 181 1 4BBE3

Lt Register numbers

— Slave device addresses

[ENT RN RIS IV.Y. BT N1 Y

MV channels

L Detail code
Status lamp
—Cursor used to select a command
(Used to resume command transmission from the front panel keys)

IM MV1000-17E 311
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3.5 Reading/Writing Data on Another Device from the MV via Modbus

¢ Communication Conditions
The read cycle, Inter-block delay, Time out, Auto recovery, and Retrials settings are
displayed.

e Communication Status
The MV displays the communication status using status lamps and detail codes.

Status Lamp Detail Code Meaning
Green Good Communication is operating normally.
Yellow Command is readying.
Red Communication is stopped.
Common to yellow and red None No response from the slave device.
Func The slave device cannot execute the command
from the MV.
Regi The slave device does not have the specified
register.
Err There is an error in the response data from the
slave device (communication error).
(Space) The detail code does not appear until the status

is confirmed when communication is started.

Resuming Command Transmission
Using the front panel keys, you can resume command transmission to a slave device
whose communication is stopped (red status lamp).

1. Using the up and down arrow keys, select the command assigned to the slave
device that you want to resume transmission. The message “Push [right arrow]
key to refresh” appears.

2. Press the right arrow key. The MV will transmit a command to the specified slave
device.

Data during Connection Retrials

On a Modbus master, the communication input data and external input channel data

are held at the previous values while the command is being retried. If the command
transmission stops, the status lamp will turn red, and the communication input data and
external input channel data will be error data. For computation channels, the MV displays
“+OVER” or “~“OVER” according to the settings. The MV displays “******” for external
input channels.

Data Dropout

A data dropout occurs when the commands 1 to 16 do not complete within the read cycle
(see appendix 2). When a data dropout occurs, the communication input data is held at
the previous value. The Modbus status display shows a message indicating that a data
dropout occurred. If this happens, take measures such as making the read cycle longer
or reducing the number of commands. Be sure to confirm that no data dropout occurs on
the Modbus status log display.

3-12
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3.6 Usage Example of the Modbus Function

This section explains an example of setting two MV1000s that are connected via the
serial interface, one configured to be a Modbus master and another configured to be a
Modbus slave. This section refers to the MV1000 configured to be a Modbus master as
the MV1000 master and the MVV1000 configured to be a Modbus slave as the MV1000
slave.

System Configuration and Operation
The measurement channels, computation channels, and communication input data
shown below will be used. We assume that the serial interface is already configured.
Serial

Command communication
_—
‘ - Measured data (
|g Address: 1 Address: 2
o 9.—
A
MV1000 slave MV1000 master
(Modbus slave) (Modbus master)

Reads measured data from the MV1000 and
displays data on a computation channel
(/M1 or /PM1 option).

Measurement channel 1 Communication input data C01
Input range: —2.0000 to 2.0000 V

Computation channel 101
—2.0000 to 2.0000 V

\

Start the computation

\

Displayed in group 1

Operation

« The MV1000 master reads the measured value from the MV1000 slave channel 1 into
communication input channel CO1 and displays the value on computation channel
101. The MV displays computation channel 101 in group 1.

* The measured value of MV1000 slave channel 1 is transferred to the MV1000 master
as an integer in the range of —20000 to 20000.

* The MV1000 master displays values in the range of —2.0000 to 2.0000 V for values
in the range of —20000 to 20000. The value is linearly scaled using the following
equation.
The value on MV1000 master computation channel 101 = Communication input data
C01 x 0.0001

IM MV1000-17E 313
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3.6 Usage Example of the Modbus Function

Configuring the MV1000 Slave (Modbus Slave)
Configuring the Modbus Slave

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >

Communication (Serial) > Basic settings

hEt

Basic Setting Hode

Serial

Baud rate 668 bps

Data lenath | 8  hbit

Parity Even

Handshaking | OffiOff

Address 1

Protocal Hodbus
Ilm Hodbus Hodbu=-H
Parameter Setting
Address 1
Protocol Modbus

*

Configuring Measurement Channels

¢ Press MENU and then select Menu tab > Meas channel > Range, Alarm

[ =1
ST (S)
First-CH: Last-CH: 1
Range
Hode Range Span_L Span_ll
[Wo1t [ 2y [-2.eeee [ 2.eee8

Set the communication parameters the same as those of the master device.

Parameter Setting
First channel and last channel 1

Mode Volt
Range 2V
Span_L —2.0000
Span_U 2.0000

3-14
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3.6 Usage Example of the Modbus Function

Configuring the MV1000 Master (Modbus Master)

Set default values for parameters other than those listed below.

Configuring the Modbus Master

¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Serial) > Basic settings

Basic Setting Hode
Serial

Baud rate 668 bps
Data lenath g bit
Parity Even
Handshaking Off:0ff
Address 1
Protocal Hodbus-H

[ Normal | Hodbus o

Parameter Setting
Address 2
Protocol Modbus-M

*

Set the communication parameters the same as those of the slave device.

Setting Transmission Commands
¢ Press MENU and then select Menu tab > Basic setting mode > Menu tab >
Communication (Serial) > Modbus master > Command settings

Basic Setting Hode

Haster command number | 1-8
First Last Addr. Reai. Tvpe

1Rl [ca1 -[cer 4 [ 1 [ zeeal | INTIG
2| 0ff

3| off

4| 0ff

5|0ff

B|Off

T|0ff

8| 0ff

R-Hath | W [ H-lath |

Parameter Setting
Command type R-M
First and Last CO01
Address 1

Regi. 30001
Type INT16

Configuring Computation Channels
See section 2.10, “Usage Example of the Modbus Function.”

Assigning a Channel to a Group
See section 2.10, “Usage Example of the Modbus Function.”

Starting Computation
See section 2.10, “Usage Example of the Modbus Function.”

Checking the Modbus Operating Status
See section 2.10, “Usage Example of the Modbus Function.”

IM MV1000-17E
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Chapter 4

Commands

4.1

Command Syntax

Command Syntax
This section describes the MV setting, basic setting, and output command syntax (see
sections 4.4 to 4.10). ASCII codes (see appendix 1) are used for the character codes.
For the maintenance/test command syntax (see section 4.11) and instrument information
output command syntax (see section 4.12), see the corresponding sections or the
examples for each command.

Command name Terminator

..
(Delimiter)

(Sub delimiter)

Command example

SR002, SKIP;SR003,VOLT,2V,-1500,1800
- | — | | T | | Parameters
— Delimiter (,)

Command name (SR)

Sub delimiter (;)

Command Name
A command name is defined using two alphabet characters.

Parameters

Command parameters.
Parameters are specified using alphabet characters or numeric values.
Each parameter is separated by a delimiter (comma).
A numeric value is specified using an integer.
If the parameter is a numeric value, the valid range of the value varies depending on
the command.
Spaces before and after a parameter are discarded. (However, spaces are significant
in a parameter (unit) specified using an ASCII character string.) In the examples given
in this manual, spaces are not used.
You can omit parameters that do not need to be changed from their current settings.
However, delimiters cannot be omitted.
Example SR001,,2V<terminator>
If multiple parameters are omitted and delimiters occur at the end of the command,
those delimiters can be omitted.
Example SR001,VOLT,,, <terminator> — SR001, VOLT<terminator>

The number of digits is fixed for the parameters listed below. If you enter the wrong
number of digits, a syntax error will occur.
- Date  YY/MM/DD (eight characters)

YY: Enter the lower two digits of the year.

MM: Month

DD: Day
« Time HH:MM:SS (eight characters)

HH: Hour

MM: Minute

Ss: Second
* Channel number: Three characters
* Relay number: Three characters
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4.1 Command Syntax

Response

Query

» A question mark is used to specify a query.

* You can insert a question mark after a command or parameter to query the
corresponding command setting. Queries are not allowed on some commands. For
the query syntax of each command, see sections 4.4 to 4.7.

Example 1 SR[ pl]? You can execute SR? or SRp17?.
Example 2 SA[ pl[,p2]]1? Youcanexecute SA?, SApl?, and SApl,p2°?.

Delimiter
* Acomma is used as a delimiter.
» Separate each parameter with a delimiter.

Sub Delimiter

» Asemicolon is used as a sub delimiter.

* You can specify up to 10 commands consecutively by separating each command with
a sub delimiter. However, you cannot do this with the commands listed below and all
queries. Specify them independently.

» Output commands other than BO, CS, and IF
* Queries
* If there are consecutive sub delimiters, they are considered to be one. Sub delimiters at the
front and at the end of a command sequence are ignored.
Example ;SR001,VOLT;;;SR002, VOLT;<terminator> is interpreted as SR001, VOLT; S
R002, VOLT<terminator>.

Terminator

Use either of the following for the terminator.
+ CR+LF (0DH 0AH in ASCII code)

« LF (0OAH in ASCII code)

Nofte
» Do not specify a channel or relay number that is not available on the MV. If you do, an error
will occur.
» The total data length from the first character to the terminator must be less than 2048 bytes.
« Commands are not case-sensitive except for user-specified character strings.
« All commands that are listed with sub delimiters are executed even if any of the commands
is in error.

« Spaces that are inserted before and after a parameter are ignored. However, if spaces are
inserted before a command, after a sub delimiter, or after a query, an error will occur.

The MV returns a response (affirmative/negative response) to a command that is
delimited by a terminator.” The controller should follow the one command to one
response format. If the command-response rule is not observed, the operation is not
guaranteed. For the response syntax, see section 5.1.
* RS-422/485 commands (see section 4.9) and instrument information output commands
(section 4.12) are exceptions.
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4.2 A List of Commands

Setting Commands

Group/ Function Execution Administrator User See
Command Name Mode Page
Setting

SR Sets an input range Operation Mode Yes No 4-10
SO Sets a calculation expression Operation Mode Yes No 4-11
ER Sets the range of an external input channel Operation Mode Yes No 4-11
TJ Sets memory sampling Operation Mode Yes No 4-11
SA Sets an alarm Operation Mode Yes No 4-12
SW Sets the display update rate and auto-save interval ~ Operation Mode Yes No 4-13
TW Sets the secondary trend update rate Operation Mode Yes No 4-13
™ Sets manual sampling. Operation Mode Yes No 4-13
TE Sets sampling conditions of the event data Operation Mode Yes No 4-13
SZ Sets a zone Operation Mode Yes No 4-14
SP Sets the partial expanded display Operation Mode Yes No 4-14
ST Sets a tag Operation Mode Yes No 4-14
SX Sets a group Operation Mode Yes No 4-14
SL Sets a trip line Operation Mode Yes No 4-14
SG Sets a message Operation Mode Yes No 4-15
TH Sets the data storage directory on an external Operation Mode Yes No 4-15

storage medium
TZ Sets the file header Operation Mode Yes No 4-15
TF Sets the data file name Operation Mode Yes No 4-15
SD Sets the date and time Operation Mode Yes No 4-15
TT Sets the trend display Operation Mode Yes No 4-15
SE Sets the trend graph line width and the number of Operation Mode Yes No 4-16
grids

B Sets the bar graph display Operation Mode Yes No 4-16
SB Sets the bar graph of a channel Operation Mode Yes No 4-16
TN Sets the scale Operation Mode Yes No 4-16
SV Sets the moving average of a measurement channel Operation Mode Yes No 4-16
SC Sets a channel display color Operation Mode Yes No 4-16
TA Sets an alarm point mark Operation Mode Yes No 4-16
TG Sets a color scale band Operation Mode Yes No 4-16
SQ Sets the LCD brightness and screen backlight saver Operation Mode Yes No 4-17
TC Sets the background color Operation Mode Yes No 4-17
TP Sets auto group switching Operation Mode Yes No 4-17
TR Sets auto monitor recovery Operation Mode Yes No 4-17
TQ Sets a timer Operation Mode Yes No 4-17
TK Sets a match timer Operation Mode Yes No 4-17
TU Sets an event action Operation Mode Yes No 4-18
SK Sets a computation constant Operation Mode Yes No 4-18
Sl Sets rolling average on a computation channel Operation Mode Yes No 4-19
SJ Sets a TLOG timer Operation Mode Yes No 4-19
X Sets the ancillary operation of the start key Operation Mode Yes No 4-19
FR Sets the FIFO buffer acquisition interval Operation Mode Yes No 4-19
BH Sets a batch text field Operation Mode Yes No 4-20
EH Sets a calibration correction Operation Mode Yes No 4-20
BD Sets an alarm delay Operation Mode Yes No 4-20
SM Sets the custom menu Operation Mode Yes No 4-20
SY Sets the 4 panel display Operation Mode Yes No 4-22
TY Sets the file format Operation Mode Yes No 4-23
NF Sets the HISTORY key function Operation Mode Yes No 4-23

Yes: Command usable

No: Command not usable
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4.2 A List of Commands

Note

There are two execution modes on the MV. If you attempt to execute a command in the

wrong mode, a syntax error will occur. Use the DS command to switch to the appropriate

execution mode, and then execute the command. Query commands can be executed in

either mode.
Basic Setting Mode

A mode in which settings are changed after stopping measurements and computations.

Operation Mode

A mode in which commands other than those in Basic Setting Mode are used.

* The administrator and user indications in the table are the user levels that are specified

through the Ethernet communication login function. See section 2.1 for details.

Group/ Function Execution Administrator User See
Command Name Mode Page
Control
BT Sets a batch name Operation Mode Yes No 4-24
BU Sets a batch comment Operation Mode Yes No 4-24
ub Switches the display Operation Mode Yes No 4-24
PS Starts/stops measurements Operation Mode Yes No 4-25
AK Releases the alarm output (alarm acknowledge) Operation Mode Yes No 4-25
EV Executes manual sample, manual trigger, snapshot, Operation Mode Yes No 4-25
or forced timeout
CL Executes manual SNTP Operation Mode Yes No 4-25
CcV Switches the trend update rate Operation Mode Yes No 4-25
MS Writes a message (displays and writes) Operation Mode Yes No 4-25
BJ Writes a free message Operation Mode Yes No 4-25
EJ Changes the login password Operation Mode Yes Yes  4-25
TL Starts, stops, resets computation (MATH) or clears Operation Mode Yes No 4-26
the computation dropout status display
DS Switches the execution mode between operation and  All modes Yes No 4-26
basic setting
LO Loads setup data Operation Mode Yes No 4-26
LI Saves setup data Operation Mode Yes No 4-26
CM Sets communication input data Operation Mode Yes No 4-26
CE Enters data in an external input channel Operation Mode Yes No 4-26
EM Starts/stops the e-mail transmission Operation Mode Yes No 4-27
function
Cu Manually recovers Modbus Operation Mode Yes No 4-27
BV Enters characters’ All modes Yes No 4-27
KE Key operation command Operation Mode Yes No 4-27
YC Clears measured/computed data and initializes setup  Operation Mode Yes No 4-27
data
IR Resets a relative timer Operation Mode Yes No 4-27
MA Resets a match timer Operation Mode Yes No 4-27
NR Sets the trend update rate Operation Mode Yes No 4-27

* Can only be used in serial communications.

Yes: Command usable

No: Command not usable
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4.2 A List of Commands

Basic Setting Commands

« To activate the settings that are changed with the basic setting commands, you must
save the settings with the YE or XE command. Make sure to save the settings before
changing from Basic Setting Mode to Operation Mode. Otherwise, new settings will

not take effect.

» The settings that are returned in response to a query in Basic Setting Mode will

contain the new settings even if they are not saved. However, the new settings will
not take effect until they are saved. To activate the new settings, you must save the
settings with the YE or XE command as described earlier. If you clear the settings
or change the execution mode from Basic Setting Mode to Operation Mode without
saving the settings, the MV will return the original settings in response to a query.

Nofte

The settings that are changed with the YA, YK, RU, YQ, YS, YB, YD, WS, and WW commands
are activated after saving the new settings with the XE command and then power-cycling

the MV.

« Executing the YE or LO command will disconnect communications.

Group/Command Function Execution Mode Administrator User See
Name Page
Setting

(e Sets alarm and DO settings Basic Setting Mode Yes No 4-28
WH Sets an alarm hysteresis Basic Setting Mode Yes No 4-28
XV Sets the scan interval Basic Setting Mode Yes No 4-28
XB Sets the burnout detection Basic Setting Mode Yes No 4-28
xXJ Sets an RJC Basic Setting Mode Yes No 4-29
wu Sets environment settings Basic Setting Mode Yes No 4-29
XM Sets the memory sample condition Basic Setting Mode Yes No 4-31
RF Sets the key lock function Basic Setting Mode Yes No 4-31
RN Sets basic login settings Basic Setting Mode Yes No 4-31
RP Sets login and user limitations Basic Setting Mode Yes No 4-31
RO Sets report types and generation times Basic Setting Mode Yes No 4-32
RM Sets a report channel Basic Setting Mode Yes No 4-32
XG Sets the time zone Basic Setting Mode Yes No 4-32
XN Sets the date format Basic Setting Mode Yes No 4-33
YB Sets host information Basic Setting Mode Yes No 4-33
YD Sets network settings Basic Setting Mode Yes No 4-33
YA Sets the IP address, subnet mask, and default Basic Setting Mode Yes No 4-33

gateway
YK Sets the keepalive feature Basic Setting Mode Yes No 4-33
RU Sets DNS parameters Basic Setting Mode Yes No 4-33
WS Sets a server Basic Setting Mode Yes No 4-33
Ww Sets the Web homepage Basic Setting Mode Yes No 4-34
YQ Sets the application timeout Basic Setting Mode Yes No 4-34
YT Sets the FTP transfer timing Basic Setting Mode  Yes No 4-34
YU Sets the contents to be sent via e-mail Basic Setting Mode Yes No 4-34
YV Sets e-mail recipient addresses Basic Setting Mode Yes No 4-35
YW Sets the e-mail sender address Basic Setting Mode Yes No 4-35
YX Sets the e-mail SNTP server name Basic Setting Mode Yes No 4-35
YJ Sets a Modbus client destination server Basic Setting Mode Yes No 4-35
YP Sets basic Modbus client settings Basic Setting Mode Yes No 4-36
YR Sets a Modbus client transmission command Basic Setting Mode Yes No 4-36
WB Sets SNTP client settings Basic Setting Mode Yes No 4-36
wcC Sets the SNTP operation when memory start is Basic Setting Mode Yes No 4-36
executed
YS Sets serial interface parameters Basic Setting Mode Yes No 4-37
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4.2 A List of Commands

Group/Command  Function Execution Mode Administrator User See
Name Page
Setting (continued)

YL Sets Modbus master function settings Basic Setting Mode Yes No 4-37
YM Sets a Modbus master transmission command Basic Setting Mode Yes No 4-37
WR Sets the instrument information output Basic Setting Mode Yes No 4-38
XE Activates Basic Setting Mode Basic Setting Mode Yes No 4-38
YE Activates Basic Setting Mode (cold reset) Basic Setting Mode Yes No 4-39

Yes: Command usable
No: Command not usable

Output Commands

Group/Command  Function Execution Administrator User See

Name Mode Page

Control

BO Sets the byte output order All modes Yes Yes 4-39

CS Sets the checksum (can be used only during serial ~ All modes Yes Yes 4-39
communications)

IF Sets the status filter All modes Yes Yes 4-39

CC Disconnects the Ethernet connection All modes Yes Yes  4-39
(can be used only during Ethernet communications)

CB Sets the data output format All modes Yes Yes  4-40

Setup, measurement, and computed data output

FC Transmits screen image data All modes Yes Yes  4-40

FE Transmits setup data All modes Yes Yes 4-40

FD Transmits most recent measured/computed data Operation Mode  Yes Yes  4-40

FF Transmits FIFO data Operation Mode  Yes Yes  4-41

FL Transmits a log, alarm summary, or message All modes Yes Yes 4-41
summary

1S Transmits status information All modes Yes Yes 4-41

FU Transmits the user level All modes Yes Yes 4-41

FA Transmits instrument information All modes Yes Yes 4-42

ME Transmits data stored on an external storage Operation Mode  Yes No 4-42

medium or the internal memory (can be used
through either Ethernet or serial communications)

MO Manipulates or transmits data stored in the internal  Operation Mode  Yes No 4-42
memory

RS-422/485 commands

Esc O Opens a instrument All modes Yes Yes 4-43

Esc C Closes a instrument All modes Yes Yes 4-43

Common command

* Transmits instrument information All modes Yes Yes  4-43

Yes: Command usable
No: Command not usable
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4.2 A List of Commands

Maintenance/Test Commands (available when using the maintenance/test serv-

er function via the Ethernet interface)

Command Name Function Administrator User See
Page
close Disconnects the connection between other instruments Yes No 4-44
con Transmits connection information Yes Yes 4-44
eth Transmits Ethernet statistics Yes Yes 4-44
help Displays help Yes Yes 4-44
net Transmits network statistics Yes Yes 4-44
quit Disconnects the connection to the instrument that is being controlled Yes Yes 4-45

Yes: Command usable

No: Command not usable

Instrument Information Output Commands (available when using the instru-
ment information server function via the Ethernet interface)

Parameter Name  Function

See
Page

serial Transmits the serial number
host Transmits the host name
ip Transmits the IP address

4-45
4-45
4-45
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4.3

Examples of Entering Measurement Range Parameters

Setup Parameters

The measurement range and setup range of parameters used in a command vary
depending on the combination of the command, range, and options.

The span upper and lower limit parameters of the SR command (input range setting

command) requires all digits including fractional digits to be set. For example, if you want
to set the upper limit to 1.0000 V when the measurement range is —2.0000 V to 2.0000 V,
specify 10000. If you want to set the limit to 0.5000 V, specify 5000.

The table below gives examples.

Measurement |Input Type |[Selectable Range of The Range You Want to Set |Parameter

Range Parameter |Measurement Range

VOLT 20mv -20.000mV t020.000mvV | -10.000mV to 20.000mV -10000 to 20000

/SQRT 2V -2.0000V to 2.0000V -2.0000V to 0.5000V -20000 to 5000

TC R 0.0 to 1760.0 0.0 to 400.0 0 to 4000
K -200.0 to 1370.0 -200.0 to 1370.0 -2000 to 13700

RTD Pt100 -200.0 to 600.0 -10.0 to 500.0 -100 to 5000

DI LEVEL 0to1l 0 to 1 Otol

Measurement Range Parameters
The table below shows the relationship between the input types and range parameters.
For the selectable range, see the MV1000/MV2000 User’s Manual (IM MV1000-01E).

Input Type Input Type Range Range Required
Parameter Parameter Option
DC voltage VOLT 20mv 20MV
60mV 60MV
200mv 200MV
AY A
6V 6V
20V 20V
50V 50V
Thermocouple TC R R
S S
B B
K K
E E
J J
T T
N N
W W
L L
U U
Kp vs AuTFe KP /N3
PLATINEL PLATI /N3
PR40-20 PR /N3
NiNiMo NIMO /N3
WRe WRE
W/WRe26 W/WRE /N3
TypeN (AWG14) N2 /N3
RTD RTD Pt PT
JPt JPT
Pt50 PT50 /N3
Nil00 (SAMA) NIl /N3
Ni100 (DIN) NI2 /N3
Nil20 NI3 /N3
J263*B J263 /N3
Cub3 CU53 /N3

4-8
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4.3 Setup Parameters

Input Type Input Type Range Range Required
Parameter Parameter Option

RTD RTD Cul00 /N3
CulO:GE /N1
CulO:L&N /N1
CulO:WEED /N1
CulO:BAILEY /N1
Cul0:0.000392at20 /N1
Cul0:0.000393at20 /N1
Cu25:0.00425at0 /N1
Pt25 /N3

Contact input DI Level LEVEL
Cont CONT

1-5V voltage 1-5V 1-5V 1-5v

Channel Number Notations
The table below lists the channel notations that are used.

S H

Channel Type Model Channel Notation Notes
Measurement MV1000 001 to 024 Varies depending on the
channel number of inputs
MV2000 001 to 048 Varies depending on the
number of inputs
Computation MV1000 101 to 112 High-speed input model
channel 101 to 124 Medium-speed input model
MV2000 101 to 112 High-speed input model
101 to 160 Medium-speed input model
External input MV1000 - Not available
channel MV2000 201 to 440 with the /MC1 option
Manual sample MV1000 - Not available
MV2000 001 to 120 with the /MC1 option
Report channel MV1000 R0O1 to R12 High-speed input model
RO1 to R24 Medium-speed input model
MV2000 RO1 to R12 High-speed input model
R0O1 to R60 Medium-speed input model
Internal switch MV1000 S01 to S30
MV2000
Output relay MV1000 101 to 106
MV2000 101 to 106, 111 to 116, 121 Varies depending on the
to 126, 131 to 136 options
Constant MV1000 K01 to K60
MV2000
Communication MV1000 C01 to C24
input channel MV2000 C01 to C60
Display group MV1000 1to 10
MV2000 1to 36
Remote control MV1000 D01 to D08
terminal ‘MV2000
Pulse input MV1000 P01 to P08,
MV2000 Q01 to Q08
Flag MV1000 FO1 to FO8
MV2000

High-speed input model MV1004, MV1008, MV2008
Medium-speed input model MV1006, MV1012, MV1024
MV2010, MV2020, MV2030, MV2040, MV2048
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4.4 Setting Commands (Setting)

Example Set the channel 010 setting type to differential

4.4 Settl n g CO mman dS computation between channels with the reference
S tt. channel set to 001, and set the input type to TC.
( etun g) Set the measurement range to R. Set the span

lower limit to 10.0°C and span upper limit to 100.0°C.
SrR010, DELTA, TC,R,100,1000,001

SR Sets an input range o _ _
— Description* You cannot execute this command while the
To set a channel to skip MV is measuring, computing, or generating a
Syntax SR pl,p2<terminator> report
pl Measurement channel number « Set parameters p1 and p4 according to the
p2 Setting type (SKIP) table in section 4.3.
Query SR[ pl]? » For parameters p5 and p6, enter a value
Example  Skip channel 001. using 5 digits or less excluding the decimal
SRO01, SKIP point.

Description « You cannot execute this command while the
MV is measuring or computing.
» Achannel set to SKIP is not measured.
» Set parameter p1 according to the table in

To set a channel to scaling
Syntax SR pl,p2,p3,p4,p5,p6,p7,pP8,p9,p10
<terminator>

pl Measurement channel number

section 4.3. p2 Setting type (SCALE)

To set a channel to voltage, TC, RTD, or ON/OFF p3  Input type

input VOLT  DC voltage

Syntax SR pl,p2,p3,p4,p5<terminator> TC Thermocouple
pl Measurement channel number RTD RTD
P2 Input type DI ON/OFF input

VOLT DC voltage p4 Measurement range

TC Thermocouple p5 Span lower limit

RTD RTD p6 Span upper limit

DI ON/OFF input p7 Scaling lower limit (-30000 to 30000)
p3 Measurement range p8 Scaling upper limit (-30000 to 30000)
p4 Span lower limit p9 Scaling decimal place (0 to 4)
P5 Span upper limit P10 Unit (up to six alphanumeric characters)

Query SR[ pl]? Query SR[ pl]?

Example Set the channel 001 input type to TC type R, the Example Convert the DC voltage measured on channel
span lower limit to 0°C, and the span upper limit 002 to DC current. Set the input range to 6 V,
to 1760.0°C. the span lower limit to 1V, the span upper limit
SR001,TC,R,0,17600 to 5V, the scaling lower limit to 1.00 A, and the

scaling upper limit to 5.00 A.

SR002, SCALE, VOLT, 6V,1000,5000,100,5

00,2,A

Description* You cannot execute this command while the

MV is measuring, computing, or generating a
report.

» Set parameters p1 and p4 according to the
table in section 4.3.

Description *  You cannot execute this command while the
MV is measuring, computing, or generating a
report.

» Set parameters p1 and p3 according to the
table in section 4.3.

» For parameters p4 and p5, enter a value using
5 digits or less excluding the decimal point.

To set a channel to difference computation * For parameters p5 and p6, enter a value
Syntax SR pl,p2,p3,p4,p5,p6,p7<terminator> using 5 digits or less excluding the decimal
pl Measurement channel number point.
p2 Setting type (DELTA) » Set all parameters p7, p8, and p9 or omit all

p3  Input type three parameters.

VOLT  DC voltage To set a channel to square root computation
TC Thermocouple Syntax SR pl,p2,p3,p4,p5,p6,p7,p8,p9%,p10,pll
RTD RTD <terminator>
DI ON/OFF input pl Measurement channel number
p4 Measurement range p2 Setting type (SQRT)
p5 Span lower limit p3 Measurement range
p6  Span upper limit p4 Span lower limit

p5 Span upper limit
p6 Scaling lower limit (30000 to 30000)
p7 Scaling upper limit (30000 to 30000)

p7 Reference channel number (measurement
channel number)
Query SR[ pl]?
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4.4 Setting Commands (Setting)

Query
Example

Description

p8 Scaling decimal place (0 to 4)

P9 Unit (up to six alphanumeric characters)

P10 Low-cut function ON/OFF

pll Low-cut point (O to 50)

SR[ pl]?

Convert the DC voltage measured on channel

001 to a flow rate using the square root

computation. Set the input range to 6 V, the span

lower limit to 1V, the span upper limit to 5 V, the

scaling lower limit to 10.0 m¥s, and the scaling

upper limit to 100.0 m*/s.

SR001, SQRT, 6V, 1000,5000,100,1000,1,

m3/s

* You cannot execute this command while the
MV is measuring, computing, or generating a
report.

» Set parameters p1 and p3 according to the
table in section 4.3.

» For parameters p4 and p5, enter a value using
5 digits or less excluding the decimal point.

» Set all parameters p6, p7, and p8 or omit all
three parameters.

To set a channel to 1-5V DC input

Syntax

Query
Example

Description

SO
Syntax

SR pl,p2,p3,p4,p5,06,p7,p8,p9,p1l0

<terminator>

pl Measurement channel number

P2 Input type(1-5V)

p3 Measurement range (1-5V)

p4 Span lower limit (800 to 5200)

p5 Span upper limit (800 to 5200)

p6 Scaling lower limit (-30000 to 30000)

p7 Scaling upper limit (-30000 to 30000)

P8 Scaling decimal place (0 to 4)

P9 Unit (up to six alphanumeric characters)

P10 Low-cut function ON/OFF

SR[ pl]?

Set the channel 005 input type to 1-5V, the span

lower limit to 1V, the span upper limit to 5 V, and

turn the 1-5V low-cut function ON.

SrR005,1-5v,1-5v,1000,5000,,,,,0N

* You cannot execute this command while the
MV is measuring or computing.

» Set parameter p1 according to the table in
section 4.3.

» For parameters p4 and p5, enter a value using
4 digits or less excluding the decimal point.

» Set all parameters p6, p7, and p8 or omit all
three parameters.

Sets a calculation expression

SO pl,p2,p3,p4,p5,p6,p7<terminator>

pl Computation channel number

p2 Computation ON/OFF

p3 Calculation expression (up to 120
characters)

p4 Span lower limit (<9999999 to 99999999)

Query
Example

Description

ER

Syntax

Query
Example

Description

L

Syntax

Query
Example

Description

PS5 Span upper limit (-9999999 to 99999999)

p6 Span decimal place (0 to 4)

p7 Unit (up to six alphanumeric characters)

SO[ pl]~?

Compute the sum of channels 001 and 002

on channel 106. Set the span lower limit to

—10.0000, the span upper limit to 15.0000, and

the unit to V.

50106,0N,001+002,-100000,150000,4,V

* You can execute this command on models
with the /M1 math option.

* You cannot execute this command while the
MV is measuring or computing.

» For details on calculation expressions, see
section 2.2.

» Set parameter p1 according to the table in
section 4.3.

» For parameters p4 and p5, enter a value
using 7 digits or less excluding the decimal
for negative numbers and 8 digits or less for
positive numbers.

» Set all parameters p4, p5, and p6 or omit all
three parameters.

Sets the range of an external
input channel

ER pl,p2,p3,p4,p5,p6<terminator>
pl External input channel number

p2 External input channel ON/OFF

p3  Span lower limit (-30000 to 30000)

p4  Span upper limit (-30000 to 30000)

p5 Decimal place (0 to 4)

p6 Unit (up to six alphanumeric characters)
ER[ pl]?

Set the span of external input channel 201 to
—150.00 to 150.00.
201,0N,-15000,15000,2

You can execute this command on models with
the /MC1 external input channel option.

Sets memory sampling

TJ pl,p2<terminator>

pl Measurement, computation, or external
input channel number

r2 Memory sampling ON/OFF

TJ[ pl]?

Save channel 002 to memory.

TJ002, 0N

You can execute a computation channel (or

make a query) on models with the /M1 math

option. You can specify an external input channel

(or make a query) on models with the /MC1

external input channel option.
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4.4 Setting Commands (Setting)

SA Sets an alarm

To turn an alarm off

Syntax SA pl,p2,p3<terminator>
pl Measurement, computation, or external

input channel number

p2 Alarm number (1 to 4)
p3 Alarm ON/OFF state (OFF)

Query SA[ pll[,p2]11°?

Example  Turn off alarm number 1 on channel 010.
SA010,1,0FF

Description You can specify a computation channel (or make
a query) on models with the /M1 math option.
You can specify an external input channel (or
make a query) on models with the /MC1 external
input channel option.

To turn an alarm on
Syntax SA pl,p2,p3,p4,p5,p6,p7,p8
<terminator>
pl Measurement, computation, or external
input channel number
p2  Alarm number (1 to 4)
p3 Alarm ON/OFF state (ON)
p4 Alarm type
High limit alarm
Low limit alarm
Difference high limit alarm
Difference low limit alarm
High limit on rate-of-change alarm
Low limit on rate-of-change alarm
Delay high limit alarm
Delay low limit alarm
(The character is case-sensitive.)
p5 Alarm value
p6 Relay setting
ON Relay ON
OFF Relay OFF
p7 Relay number when p6 is ON
Empty when p6 is OFF
p8 Alarm detection ON/OFF
Query SA[ pl[,p2]]°?
Example  Set alarm number 1 on channel 002 to high limit
alarm (alarm value = 1000), and activate relay
101 when an alarm occurs.
SA002,1,0N,H,1000,0N, I01
Description = Parameter p3 cannot be set to ON if the input
range (SR command) is set to SKIP.
» Parameter p3 cannot be set to ON for a
computation channel if computation is OFF
(SO command).
» Parameter p3 cannot be set to ON for an
external input channel if the channel is OFF
(ER command).
» All alarm settings of a channel are turned OFF
if
* The input type is changed (VOLT, TC, etc).
* The input range is changed.
* The span and scaling values are changed
during scaling display (includes changing
the decimal place.)

(o T o T O e © B e

* The computation channel is turned ON/
OFF or the calculation expression or the
span value is changed on a computation
channel.

If you set p4 to h or |, they are valid only when

the measurement range is set to differential

computation between channels.

If you set p4 to R or r, set the interval for the

high/low limit on the rate-of-change with the

XA command.

If you set p4 to T or t, set the alarm delay with

the BD command.

Set the p5 alarm value in the following range

according to the p4 alarm type or the target

channel.
+ High limit, low limit, delay high limit, or
delay low limit alarm
» DC voltage, thermocouple, or RTD input
A value in the measurable range

» Contact input
Oor1

» Scaling (1-5V, scaling, or square root)
-5 10 105% of span (but, in the range of
—30000 to 30000)

 Difference high limit or difference low limit
alarm
A value in the measurable range

+ High limit on rate-of-change or low limit on
rate-of-change alarm
A value greater than equal to the value
with the least significant digit set to 1. For
example, the alarm value is 0.0001 for the
2V range.

The maximum alarm value that you can
specify is the maximum value in the
measurable range (but, in the range of
—30000 to 30000). For example, the it is
3.0000 for the 2V range. You can only set
the alarm value to 1 for a contact input.

» Computation channel
—9999999 to 99999999 (excluding the
decimal point. Set using an integer.)

» External input channel
—30000 to 30000

An error will occur if p7 is set to a number of a

relay that is not installed.

You can specify a computation channel (or

make a query) on models with the /M1 math

option.

For computation channels and external input

channels, you can specify only the following

alarm types: H (high limit alarm), L (low limit
alarm), T (delay high limit alarm), and t (delay
low limit alarm).

For computation channels, the alarm

hysteresis is fixed to zero. Use the XA

command to set the alarm hysteresis.
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SW

Syntax

Query
Description

w__

Syntax

Query
Example

Description

Sets the display update interval

and auto-save interval

SW pl,p2,p3,p4<terminator>

pl 1

p2 Waveform type (T-Y)

p3 Display update interval (5S, 10S, 15S, 30S,

1MIN, 2MIN, 5MIN, 10MIN, 15MIN, 20MIN,
30MIN, 1H, 2H, 4H, 10H)

p4 Auto-save interval (10MIN, 20MIN, 30MIN,

1H, 2H, 3H, 4H, 6H, 8H, 12H, 1DAY, 2DAY,
3DAY, 5DAY, 7DAY, 10DAY, 14DAY, 31DAY)

SW?

» You cannot execute this command while the
MV is measuring.

» The selectable auto-save interval (p4) varies
depending on the display update interval (p3)
setting. For details, see the MV1000/MV2000
User’s Manual.

* You can specify the data update intervals (p3)
5S and 10S only on high-speed input models
(MV1004, MV1008, and MV2008). You can
specify 15S on medium-speed input models
set to fast sampling mode and high-speed
input models.

» Set the data update interval (p3) to an interval
slower than the scan interval.

» The p4 setting is valid when the saving
method to the external storage medium is set
to auto with the XM command (p1 in the XM
command set to AUTO).

» Set the trend update interval with the NR
command after setting the data update interval
and auto save interval with the SW command.

» The data update interval (p3) can only be set
to an interval slower than the scan interval.
(The scan interval is set using p3 in the XV
command.)

» The selectable range of auto save interval (p4)
varies depending on the data update interval
(p3) setting and the number of channels that
is set with the TJ command.

Sets the secondary trend update

rate

TW pl<terminator>

pl Data update rate (5S, 10S, 15S, 30S, 1MIN,

2MIN, 5MIN, 10MIN, 15MIN, 20MIN, 30MIN,
1H, 2H, 4H, 10H)

TW?

Set the update rate to 2 minutes.

TW2MIN

» Set the data update interval (p1) to an interval
slower than the scan interval.

* You can specify the data update intervals (p1)
5S and 10S only on high-speed input models
(MV1004, MV1008, and MV2008). You can
specify 15S on medium-speed input models
set to fast sampling mode and high-speed
input models.

M _

Syntax

Query
Example

Description

IE

Syntax

Query
Example

Description

Sets manual sampling.

™ pl,p2,p3<terminator>

pl Manual sampling channel number

p2 Enable/Disable (ON, OFF)

p3 Measurement, computation, or external

input channel number

T™™[ pl]?

Assign measurement channel 002 to manual

sampling number 001.

T™001,0N, 002

* You can execute this command on models
with the /MC1 external input channel option.

* You can assign a computation channel on
models with the /M1 math option.

Sets sampling conditions of the
event data
TE pl,p2,p3,p4,p5,pb<terminator>
pl 1
p2 Sample rate (25MS, 125MS, 250MS,
500MS, 18, 28, 58, 10S, 30S, 1MIN, 2MIN,
5MIN, 10MIN)
p3 Sample mode
FREE Starts data acquisition at memory
start and stops data acquisition at
memory stop.
SINGLETRIGGER
Acquires data for a specified time
once after a trigger occurs and
stops.
REPEATTRIGGER
Acquires data for a specified time
after a trigger occurs and waits for
the next trigger.
p4 Sample time (10MIN, 20MIN, 30MIN, 1H,
2H, 3H, 4H, 6H, 8H, 12H, 1DAY, 2DAY,
3DAY, 5DAY, 7DAY, 10DAY, 14DAY, 31DAY)
p5 Pre-trigger length (0, 5, 25, 50, 75, 95, 100)
percent
p6 Key trigger source ON/OFF
Parameters p5 to p6 are valid when p3 is set to
SINGLETRIGGER or REPEATTRIGGER.
TE[ pl]l?
Acquire data at a sampling rate of 125-ms over
10 minutes using a single trigger.
TE1,125MS, SINGLETRIGGER, 10MIN
You cannot specify a sampling rate that is faster
than the scan interval.
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SZ
Syntax

Query
Example

Description

sP__
Syntax

Query
Example

Description

Sets a zone

SZ pl,p2,p3<terminator>

pl Measurement, computation, or external

input channel number

P2 Bottom edge of zone (0 to 95) [%]

p3 Top edge of zone (5 to 100) [%]

SZ[ pl]l?

Display channel 002 in a 30%-to-50% zone.

57002, 30,50

* You can specify a computation channel (or
make a query) on models with the /M1 math
option. You can specify an external input
channel (or make a query) on models with the
/MC1 external input channel option.

» The width of the waveform display area along
the amplitude axis is assumed be 100%.

* The zone width must be at least 5%.

» Set the top edge of the zone to a value greater
than the bottom edge of the zone.

Sets the partial expanded display

SP pl,p2,p3,pé4<terminator>

pl Measurement, computation, or external

input channel number

p2 Partial expanded setting ON/OFF

p3 Boundary position (1 to 99) [%]

p4 Boundary value

SP[ pl]?

Partially expand the display of channel 001. Set

the boundary position to 25% and the boundary

value to 1.00 V.

SP001,0N, 25,100

* You can specify a computation channel (or
make a query) on models with the /M1 math
option. You can specify an external input
channel (or make a query) on models with the
/MC1 external input channel option.

» Parameter p2 cannot be set to ON if the input
range (SR command) is set to SKIP.

» Parameter p2 cannot be set to ON for a
computation channel if computation is OFF
(SO command).

» Parameter p2 cannot be set to ON for an
external input channel if the channel is OFF
(ER command).

» The range between the span upper and
lower limits (scale upper and low limits when
scaling is enabled) is assumed to be 100% for
parameter p3.

* You can set p4 in the range of (span upper
limit — 1) to (span lower limit + 1). If scaling is
enabled, you can set p4 in the range of (scaling
upper limit — 1) to (scaling lower limit + 1).

» The decimal place and the number of digits
are set to the same values as the span and
scaling settings (see the SR command).

ST

Syntax

Query
Example

Description

SX

Syntax

Query
Example

Description

SL
Syntax

Query

* You can execute this command (or make a
query) when the partial expanded display
function is set to USE (XU command).

» You cannot execute this command if the
partial expanded display range is not available
(such as when the span width is set to 1).

Sets a tag

ST pl,p2<terminator>

pl Measurement, computation, or external

input channel number

p2 Tag (up to 16 characters)

ST[ pll?

Set the channel 002 tag to TAG2.

ST002, TAG2

» For the characters that can be used in a tag,
see appendix 1, “ASCII Character Codes.”
However, you cannot use a semicolon or
comma in a tag.

* You can specify a computation channel (or
make a query) on models with the /M1 math
option. You can specify an external input
channel (or make a query) on models with the
/MC1 external input channel option.

Sets a group

SX pl,p2,p3<terminator>

pl Group number

p2 Group name (up to 16 characters)

p3 Channel configuration

SX[ pl]>?

Assign channels 001, 003, 004 to 006 to group
number 1 and assign GROUP2 for the group
name.

SX1,GROUP2,001.003.004-006

Assign channels by using a period to separate
each channel or a hyphen to specify a range of
channels.

For the characters that can be used in a group
name, see appendix 1, “ASCII Character Codes.”
However, you cannot use a semicolon or comma
in a group name.

Sets a trip line

SL pl,p2,p3,p4,p5,pb<terminator>

pl Group number

P2 Trip line number (1 to 4)

p3  Trip line display ON/OFF

pr4 Display position (0 to 100)

p5 Display color (RED, GREEN, BLUE,
B.VIOLET, BROWN, ORANGE,
Y.GREEN, LIGHTBLUE, VIOLET, GRAY,
LIME, CYAN, DARKBLUE, YELLOW,
LIGHTGRAY, PURPLE, BLACK, PINK,
L.BROWN, L.GREEN, DARKGRAY, OLIVE,
DARKCYAN, S.GREEN)

p6 Line width (1, 2, 3)

SL[ pl[,p2]17?
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Example Display trip line 1 in red at the 10% position of
group 1. Set the line width to 1.
SL1,1,0N,10,RED, 1

Description The width of the waveform display area along the
amplitude axis is assumed be 100%.

SG Sets a message
Syntax SG pl,p2<terminator>

pl Message number (1 to 100)
P2 Message (up to 32 characters)

Query SG[ pl]?

Example Set character string “MESSAGE1” in message
number 2.
SG2,MESSAGEL

Description For the characters that can be used in a
message, see appendix 1, “ASCII Character
Codes.” However, you cannot use a semicolon or
comma in a message.

TH Sets the data storage directory
on an external storage medium
Syntax TH pl<terminator>

pl Directory name (up to 20 characters)
Query TH ?
Example Save data to the DATA1 folder on the external
storage medium.

THDATAL
TZ Sets the file header
Syntax T7Z pl,p2<terminator>
pl 1
p2 File header (up to 50 characters)
Query TZ[ pl]?
Example Set the header to MV1000DATA.
TZ1,MV1000DATA
TF Sets the data file name
Syntax TF pl,p2,p3<terminator>
pl 1

p2 Configuration
BATCH File name specified by the batch
function
DATE User-assigned character string +
the date
SERIAL User-assigned character string + a
serial number
p3 User-assigned name (up to 16 characters)
(valid when p2 is DATE or SERIAL)
Query TF[ pl]?
Example Set the file name to the user-assigned string
MV 1DATA followed by a serial number.
TF1, SERIAL,MV1DATA

SD

Syntax

Query
Example

Description

1T

Syntax

Query
Example

Sets the date and time
SD pl,p2<terminator>
pl Date (YY/MM/DD)

YY Year (00 to 79)
MM Month (01 to 12)
DD Day (01 to 31)
p2 Time (HH/MM/SS)
HH Hour (00 to 23)
MM Minute (00 to 59)
Ss Second (00 to 59)
SD?
Set the internal clock to 13:00:00, October 1,
2005.

SD05/10/01,13:00:00

The syntax for p1 and p2 is fixed to eight

characters. Use the syntax below. Do not insert

spaces; otherwise an error will occur.

p1=YY/MM/DD (Lower two digits of the year/
month/day)

p2 = HH:MM:SS (Hour:minute:second)

Sets the trend display
TT pl,p2,p3,p4,p5<terminator>
pl Graph display direction

HORIZONTAL Horizontal display

VERTICAL Vertical display

WIDE Horizontal wide
display

SPLIT Horizontal split
display

p2 Clear waveform at start ON/OFF
p3 Message display direction

HORIZONTAL
VERTICAL
p4 Scale display digits
NORMAL 3-digit display
FINE 4-digit display
p5 Current value display
MARK Display using a mark
BARGRAPH Display using a bar

graph

TT?

Set the waveform to horizontal display and the
message direction to vertical, and display the
waveform by clearing the existing waveform at
memory start.
TTHORIZONTAL, ON, VERTICAL

IM MV1000-17E
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SE

Syntax

Query
Example

IB__
Syntax

Query
Example

SB
Syntax

Query
Example

Description

IN __
Syntax

Query
Example

SV

Syntax

Sets the trend graph line width
and the number of grids

SE pl,p2<terminator>

pl Trend line width (1 to 3) [dot]

p2  Number of grids (4 to 12, AUTO)

SE?

Set the trend waveform line width to 1 dot and
the number of grids to 10.

SE1,10

Sets the bar graph display
TB pl<terminator>
pl Bar graph display direction
HORIZONTAL
VERTICAL
TB?
Display the bar graph horizontally.
TBHORIZONTAL

Sets the bar graph of a channel

SB pl,p2,p3<terminator>

pl Measurement, computation, or external
input channel number

p2 Base position of the bar graph display

NORMAL Normal (lower limit)
CENTER
LOWER Lower limit
UPPER Upper limit
p3  Number of scale divisions (4 to 12)
SB[ pl]?

Set the number of scale divisions of the channel
002 bar graph to 5, and display the bar graph
from the span lower limit (scale lower limit if
scaling is enabled).

SB002, NORMAL, 5

You can specify a computation channel (or make
a query) on models with the /M1 math option.
You can specify an external input channel (or
make a query) on models with the /MC1 external
input channel option.

Sets the scale

TN pl,p2,p3<terminator>

pl Measurement, computation, or external
input channel number

p2 Display position (OFF, 1 to 10)

p3  Number of divisions (4 to 12, C10)

TN[ pl]?

Set the channel 003 scale position to 2 and the

number of divisions to 10.

TN003,2,10

Sets the moving average of a
measurement channel

SV pl,p2,p3<terminator>

pl Measurement channel number

Query
Example

SC

Syntax

Query
Example

Description

A __

Syntax

Query
Example

Ic
Syntax

Query
Example

p2 Moving average ON/OFF

p3  Number of samples for computing the
moving average (2 to 400) [times]

SV[ pl]l?

Set the number of samples for computing the

moving average on channel 002 to 12.

SV002,12

Sets a channel display color

SC pl,p2<terminator>

pl Measurement, computation, or external
input channel number

p2 Display color (see SL (sets a trip line))

sc[ pll?

Set the channel 002 display color to blue.

SC002, BLUE

You can specify a computation channel (or make

a query) on models with the /M1 math option.

You can specify an external input channel (or

make a query) on models with the /MC1 external

input channel option.

Sets an alarm point mark

TA pl,p2,p3,p4,p5,p6,p7<terminator>

pl Measurement, computation, or external
input channel number

p2 Mark type
ALARM
FIXED Fixed mark

p3 Scale board display ON/OFF

p4 Alarm level 1 color (see SL (sets a trip line))

Alarm mark

p5 Alarm level 2 color (see SL (sets a trip line))
p6 Alarm level 3 color (see SL (sets a trip line))
p7 Alarm level 4 color (see SL (sets a trip line))
TA[ pl]~?

Display alarm marks on the channel 004 scale.
TA004,ALARM, ON

Sets a color scale band

TG pl,p2,p3,p4,p5<terminator>

pl Measurement, computation, or external
input channel number

p2 Area (OFF, IN, OUT)

p3 Display color (see SL (sets a trip line))

p4 Display position lower limit

p5 Display position upper limit

TG[ pl]?

Set the color scale band range to —1.0000 to

0.5000 V (2 V range) on channel 005, and set

the display color to green.

TG005, IN, GREEN,-10000,5000
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Syntax

Query
Example

Description

Ic
Syntax

Query
Example

Ir__
Syntax

Query
Example

IR __
Syntax

Query
Example

Sets the LCD brightness and
screen backlight saver

SQ pl,p2,p3,pd4<terminator>

pl LCD brightness

1-8 MV1000
1-6 MV2000

p2 Type of display backlight saver function
OFF Disable the saver function
DIMMER Dim
TIMEOFF  Turn OFF

p3 Time to switch to saver mode
1MIN, 2MIN, 5MIN, 10MIN, 30MIN, 1H
p4 Event that causes the MV to return from
saver mode
KEY Pressing of a key
KEY+ALARM Pressing of a key or an alarm
occurrence
SQ?
Set the LCD brightness to 2 and the screen
backlight saver function to dim. Set the time to
switch to saver mode to 5 minutes and the event
that causes the MV to return from saver mode to
pressing of a key.
SQ2, DIMMER, 5MIN, KEY
If p2 is set to OFF, do not specify p3 or p4.

Sets the background color

TC pl,p2<terminator>

pl Display screen (WHITE, BLACK)

p2 Historical trend display (WHITE, CREAM,
LIGHTGRAY, BLACK)

TC?

Set the display background to black and the

historical display background to cream.

TCBLACK, CREAM

Sets auto group switching

TP pl<terminator>

pl Auto scroll time (5S, 10S, 20S, 30S, 1MIN)
TP?

Switch the group at 5-s intervals.

TP5S

Sets auto monitor recovery

TR pl<terminator>

pl Auto recovery time (OFF, 1MIN, 2MIN,
5MIN, 10MIN, 20MIN, 30MIN, 1H)

TR?

Set the auto recovery time to 5 minutes.

TRSMIN

o

Sets a timer

If p2 is set to OFF (no timer)

Syntax

TQ pl,p2<terminator>
pl Timer number (1 to 4)
p2 Timer type (OFF)

If p2 is set to ABSOLUTE (absolute time)

Syntax

TQ pl,p2,p3,p4<terminator>

pl Timer number (1 to 4)

p2 Timer type (ABSOLUTE)

p3 Time interval (1MIN to 6MIN, 10MIN, 12MIN,
15MIN, 20MIN, 30MIN, 1H to 4H, 6H, 8H,
12H, 24H)

p4 Reference time (hh)
hh Hour (00 to 23)

If p2 is set to RELATIVE (relative time)

Syntax

Query
Example

K __

TQ pl,p2,p3,p4<terminator>
pl Timer number (1 to 4)

p2 Timer type (RELATIVE)

p3 Time (hh:mm)

hh Hour (00 to 24)

mm Minute (00 to 59)
p4 Reset at computation start (ON/OFF)
Q[ pl]?

Set the timer number 1 timeout value to 10 hours 30
minutes. Do not reset at start.
TQl,1,RELATIVE,10:30,0FF

Sets a match timer

If p2 is set to OFF (not use a match timer)

Syntax

TK pl,p2<terminator>
pl Timer number (1 to 4)
p2 Timer designation (OFF)

If p2 is set to DAY (time designation)

Syntax

TK pl,p2,p3,p4,p5<terminator>

pl Timer number (1 to 4)

p2 Timer designation (DAY)

p3 Day (1to 28)

p4  Time (hh:mm) (00:00 to 23:59)

p5 Timer operation (SINGLE, REPEAT)
SINGLE Single operation
REPEAT Repetitive operation

If p2 is set to WEEK (day of week/time designation)

Syntax

TK pl,p2,p3,p4,p5<terminator>

pl Timer number (1 to 4)

p2 Timer designation (WEEK)

p3 Designation of the day of the week (SUN,
MON, TUE, WED, THU, FRI, SAT)

p4  Time (hh:mm) (00:00 to 23:59)

p5 Timer operation (SINGLE, REPEAT)
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If p2 is set to MONTH (day/time designation)

Syntax

TK
pl
p2
r3
r4
PS5

pl,p2,p3,p4,p5<terminator>

Timer number (1 to 4)

Timer designation (MONTH)

Day (1 to 28)

Time (hh:mm) (00:00 to 23:59)
Timer operation (SINGLE, REPEAT)

If p2 is set to YEAR (month/day/time designation)

Syntax

Example

Query
Example

Iy __
Syntax

TK
pl
p2
r3

p4

P5
p6

pl,p2,p3,p4,p5,p6<terminator>

Timer number (1 to 4)

Timer designation (YEAR)

Month designation (JAN, FEB, MAR, APR,
MAY, JUN, JUL, AUG, SEP, OCT, NOV,
DEC)

Day designation (1 to 31) The selectable
range varies on the specified month.

Time (hh:mm) (00:00 to 23:59)

Timer operation (SINGLE, REPEAT)

Specify 8:30 on April 28 every year for timer

number 3.

TK3,APR,28,08:30, REPEAT

TK[ pl]?

Specify hour 21 every Thursday for timer number

2.

TK2, WEEK, THU, 21:00, REPEAT

Sets an event action
TU pl,p2,p3,p4,p5,p6,p7<terminator>

pl
P2

p3

p4

Logic number (1 to 40)

Event type

NONE

REMOTE

RELAY Alarm output relay

SWITCH Internal switch

ALARM Alarm occurrence

TIMER Timer expiry

MATCHTIMETIMER  Match time expiry

USERKEY USER key

Event detail

p2=REMOTE Remote number (1 to
8)

p2=RELAY Relay number

p2=SWITCH Internal switch
number

p2=TIMER Timer number (1 to 4)

p2=MATCHTIMETIMERMatch timer number
(1to4)
p2=0Other Space
Action type
MEMORYSTART/STOP
MEMORYSTART
MEMORYSTOP
TRIGGER
ALARMACK
MATHSTART/STOP
MATHSTART
MATHSTOP
MATHRESET

Event trigger
Alarm acknowledge

p5

po6

p7

SAVEDISPLAY Save display data to
an external storage
medium

SAVEEVENT Save event data to an
external storage medium

MESSAGE Write a message

SNAPSHOT

MANUALSAMPLE

TIMERRESET Reset the relative timer

DISPLAYRATEL1/2 Switch the trend update
rate

DISPLAYGROUPCHANGE Switch the display group

FLAG Raise a flag

TIMEADJUST Synchronize the clock

PANELLOAD Load settings

Event detail 2
p4=TIMERRESET  Timer number (1 to 4)
p4=DISPLAYGROUPCHANGE Group number

p4=FLAG Flag number (1 to 8)

p4=MESSAGE Message number (1 to
100)

p4=PANELLOAD Setup file number (1 to
3)

Event detail 3

p4=MESSAGE Method of specifying
the destination where
messages are written
ALL All display groups
SELECT A specified display
group

Event detail 4
If p6 is set to SELECT Group number

Some p4 parameters (action type) are not
selectable depending on p2 (event type).
Some p4 parameters (action type) are not
selectable depending on the settings or on the
installation of options.

Query
Example

TU[ pl]?
Execute memory start with the remote control input

(terminal 1).
TUREMOTE, 1, MEMORYSTART

Description Set parameter p3 (relay number, internal switch)
according to the table in section 4.3.

SK Sets a computation constant
Syntax SK pl,p2<terminator>
pl Constants number
p2 Constant (-9.9999E+29 to —1.0000E-30,
0, 1.0000E-30 to 9.9999E+29, 5 significant
digits)
Query SK[ pl]?
Example  Set constants number KO1 to 1.0000E-10.

SKKO01,1.0000E-10

Description «

You can execute this command on models
with the /M1 math option.

You cannot execute this command while the
MV is measuring or computing.

Set parameter p1 according to the table in
section 4.3.
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Si

Syntax

Query
Example

Description

SJ
Syntax

Query
Example

Description

Sets rolling average on a

computation channel

ST pl,p2,p3,pd4<terminator>

pl Computation channel number

p2 Moving average ON/OFF

p3 Sampling interval (1S, 2S, 3S, 4S, 5S, 6S,
108, 12S, 158, 20S, 30S, 1MIN, 2MIN,
3MIN, 4MIN, 5MIN, 6MIN, 10MIN, 12MIN,
15MIN, 20MIN, 30MIN, 1H)

P4 Number of samples (1 to 1500)

SI[ pl]?

Set the computation channel 107 rolling average

to ON, the sampling interval to 1 minute, and the

number of samples to 20.

SI107,0N, 1MIN, 20

* You can execute this command on models

with the /M1 math option.
« If p2is set to OFF, do not specify p3 or p4.
» Set the sampling interval greater than or equal
to the scan interval.

Sets a TLOG timer

SJ pl,p2,p3,p4,p5<terminator>

pl Computation channel number

p2 Timer (1to 4)

p3 Conversion of the time unit for TLOG.SUM

computation

OFF No conversion.

/S Convert as though the physical
values are integrated in units of
seconds.

/MIN Convert as though the physical
values are integrated in units of
minutes.

/H Convert as though the physical
values are integrated in units of
hours.

pr4 Reset ON/OFF

p5 Timer type
TIMER
MATCHTIMETIMER

SJ[ pl]>

Set timer 1 to computation channel number 110.

Do not convert the unit time and enable the reset

function.

SJ110, 1, OFF, ON

* You can execute this command on models
with the /M1 math option.

» Set parameter p1 according to the table in
section 4.3.

* You cannot execute this command while the
MV is computing.

* About p3
Because the sampled data is integrated
over each scan interval, the physical value
integrated over a given period may be different
from the actual integrated value. This occurs
if the given period is not equal to the scan
interval. In such case, set p3 to the same unit

X

Syntax

Query
Example

FR__

Syntax

Query
Example

Description

as that of the physical value being measured.
The integrated value is found according to the
following converting equations that depend on
the parameter.

OFF > (measured value)

/S > (measured value) x scan interval

/MIN ¥ (measured value) x scan
interval/60

/HOUR X (measured value) x scan
interval/3600

The scan interval unit is seconds.

Sets the ancillary operation of
the start key

TX pl<terminator>

pl Computation operation (OFF, START,
RESET+START)

TX?

Configure the MV so that the start key also starts

computation.

TXSTART

Sets the FIFO buffer acquisition

interval

FR pl<terminator>

pl 1 (fixed)

pl FIFO acquisition interval (25MS, 125MS,

250MS, 500MS, 18, 28, 5S)

FR?

Set the FIFO acquisition interval to 1 s.

FR1,1S

Set the acquisition interval to a value greater

than the scan interval.

+ If you set the scan interval to a value greater
than the acquisition interval with the XV
command or from the screen, the acquisition
interval is automatically set equal to the scan
interval.

* The MV has a circular FIFO (First In First Out)
buffer. The MV acquires measured/computed
values to the internal memory at given time
intervals after the power is turned ON and
transmits the data when a FF command is
received. The previous output position is
held for each connection. Upon receiving
an FF command, the MV transmits the next
data and updates the output position. This
scheme compensates for the differences in
the processing power of the measurement PC
and the communication delay. This enables
data to be retrieved without dropouts if the
measurement PC reads the data before the
ring buffer is overwritten. For the output flow
diagram of FIFO data, see appendix 5.
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BH
Syntax

Query
Example

Description

EH

Sets a batch text field

BH pl,p2,p3,p4<terminator>

pl 1

p2 Field number (1 to 8)

p3 Field title (up to 20 characters)

p4 Field characters (up to 30 characters)Field
title (up to 30 characters)

BH[ pl,[ p2]]?

Set the title to “OPERATOR” and the text to

“DAQSTATION?” for field number 2.

BH1,2,0PERATOR, DAQSTATION

For the characters that can be used, see

appendix 1.

Sets a calibration correction

If p2 is set to BEGIN

Syntax

EH pl,p2,p3<terminator>

pl Measurement channel number

p2 Type of operation (BEGIN)

P3  Number of break points in the calibration
segment (OFF, 2 to 16)
OFF Calibration OFF
2to 16 Number of break points

If p2 is set to SET

Syntax

Description

EH pl,p2,p3,p4,p5<terminator>

pl Measurement channel number

p2 Type of operation (SET)

p3 Break point designation (1 to 16)

p4 True value of the specified break point

p5 Measured value of the specified break

point

» Set parameter p1 according to the table in
section 4.3.

» The selectable range of p4 and p5 varies
depending on the current set range.

+ If set to scale range, the selectable range of
p4 and p5 is —30000 to 30000.

» Set true value p4 so that the value increases
as break point p3 increases.

If p2 is set to END

Syntax

Example

Description

EH pl,p2<terminator>
pl Measurement channel number
p2 Type of operation (END)

Example in which three break points are

specified on CH2

EH002,BEGIN, 3

EH002,SET,1,0,1

EHO002,SET,2,50,49

EHO002,SET, 3,100,101

EH002, END

« First, execute this command with the type of
operation set to BEGIN to specify the number
of break points.

Set the values for the specified number of the
break points using the SET operation.
Execute this command with the type of
operation set to END to finalize the settings.
The EH2? command transmits the CH2
settings.

The output example is as shown in the
example above.

You cannot execute this command while the
MV is computing.

BD Sets an alarm delay

Syntax BD pl,p2<terminator>
pl Measurement, computation, or external

input channel number

p2 Alarm delay (1 to 3600) [s]

Query BD[ pl]?

Example  Set the channel 001 alarm delay to 120 s.
BD001,120

Description Set parameter p1 according to the table in
section 4.3.

SM Sets the custom menu

To set the main menu

Syntax

SM pl,p2,p3,p4,p5,p6,p7,p8,p9

<terminator>

pl
p2 to p9

Example

Type (DISP_MAIN)

Menu items to be displayed
The menu items are displayed in the
specified order.

Only the specified menu items are
displayed.

TREND

DIGITAL

BAR

OVERVIEW

INFORMATION

TRENDHISTORY

LOG

4PANEL

ESC

EXPAND

SEPARATOR

Set the first menu item to TREND and the

second menu item to TRENDHISTORY.
SMDISP MAIN, TREND, TRENDHISTORY,

Description

If you omit parameters p2 and subsequent
parameters, all menus items will be hidden.
A command error will occur if you specify the
same menu item multiple times.

You can specify up to three separators. If you
specify more than three, an error will occur.
You cannot omit parameters by using
delimiters (, ,).

4PANEL is available only on the MV2000.

If you set the first menu item to SEPARATOR,
it will be ignored.
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To set a submenu

Syntax

SM pl,p2,p3,....<terminator>
pl Type (DISP_SUB)
p2 Menu type (TREND, DIGITAL, BAR,

TRENDHISTORY, OVERVIEW,
INFORMATION, LOG, 4PANEL)

p3 and up

Menu items to be displayed in the submenu
The items are displayed in the specified

order.

Only the specified menu items are

displayed.

If p2 is TREND [select from the items below]

GROUP1-GROUP36
ALL CHANNEL
SCALE
DIGITAL
MESSAGE DISP
TREND SPACE
AUTO

EXPAND
SEPARATOR
FINE GRID
AUTO_ZONE

Group designation
All channel display
Scale display
Digital display
Message display
Trend space

Auto switching

Fine grid ON/OFF
Auto zone display/
normal display

If p2 is DIGITAL [select from the items

below]
GROUP1-GROUP36
AUTO
EXPAND
SEPARATOR

Group designation
Auto switching

If p2 is BAR [select from the items below]

GROUP1-GROUP36
AUTO

EXPAND
SEPARATOR

Group designation
Auto switching

If p2 is TRENDHISTORY [select from the

items below]
GROUP1-GROUP36
SEPARATOR

Group designation

If p2 is OVERVIEW [select from the items

below]
CURSOR
TO_ALARM
TO_TREND
TO_DIGITAL
TO_BAR
EXPAND
SEPARATOR

If p2 is INFORMATION [select from the items

below]
ALARM
MESSAGE
MEMORY
MODBUS_CLIENT

Cursor display

To alarm summary
To trend display

To digital display

To bar graph display

Alarm summary
Message summary
Memory summary
ModbusTCP status
display

Example

MODBUS_MASTER  ModbusRTU status

display
RELAY Relay status display
REPORT Report display
TO_HISTORY To historical display

TO HISTORY D
TO HISTORY E
TO OVERVIEW

To historical (display)
To historical (event)
To overview display

SORT_KEY Switch the sort key

SORT_ORDER Switch the sort order

DISP ITEM Switch Date/
Username

DATA KIND Switch the data type

DATE/FILE Switch Date/
Filename

SELECT SAVE Select save

REPORT_CHANNEL  Switch the report
channel display

ALL SAVE

MANUAL SAVE Save manual sample
REPORT_SAVE Save report
EXPAND

SEPARATOR

DATA SAVE MODE Data save mode
COLUMN_BAR Stacked bar graph
COLUMN_BAR_DISP 1-column display/2-
column display
COLUMN_BAR SELECT
Select a bar graph/
select a group
REPORT GROUP1-GROUP6
Select a report group
on the MV2000
REPORT GROUP1-GROUP4
Select a report group
on the MV1000
If p2 is LOG [select from the items below]

LOGIN LOG Login log
ERROR_LOG Error log
COMMU_LOG Communication log
FTP_LOG FTP log
WEB_LOG Web log
MAIL LOG E-mail log
SNTP_LOG SNTP log
DHCP_LOG DHCP log
MODBUS_LOG Modbus log
SEPARATOR
If p2 is 4PANEL [select from the 5 items
below]

4PANEL1-4PANEL4 4 panel designation
SEPARATOR

Display SCALE and DIGITAL for the first and
second submenu items under the TREND main
menu item.

SM DISP_SUB, TREND, SCALE, DIGITAL
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Description

Selectable items for p3 and subsequent

parameters vary depend on the p2 setting.

* If you omit parameters p3 and subsequent
parameters, all menus items will be hidden.

» A command error will occur if you specify the
same menu item multiple times.

» You can specify up to three separators. If you
specify more than three, an error will occur.

* You cannot specify EXPAND for LOG and
4PANEL.

* You cannot omit parameters by using
delimiters (, ,).

+ If you execute SM DISP_SUB?, the MV also
transmits submenus of main menu items that
are turned Off.

 If you set the first menu item to SEPARATOR,
it will be ignored.

» The Show/Hide setting for the group

designation parameters, GROUP1 to

GROUP36, and the auto switching parameter,

AUTO, are applied universally to Trend,

Digital, Bar Graph, and Historical Trend. (For

example, if you set AUTO to Hide for Trend

and then set AUTO to Show for Digital, AUTO
will be set to Show for Trend, Digital, Bar

Graph, and Historical Trend.)

To set the function menu

pl Type (FUNC)
p2-p28
The menu items for the functions you select

Menu items to be displayed

from below are displayed in the specified
order.
Only the specified menu items are displayed.

ALARMACK Alarm acknowledge

MESSAGE

FREE MESSAGE

TRIGGER Event trigger

SAVE DISPLAY Save the display data

SAVE_EVENT Save the event data

MANUAL SAMPLE

SNAPSHOT

BATCH

MATH START/STOP

MATH RESET

MATH ACK Math data dropout
acknowledge

KEYLOCK Enable/disable key
lock

LOGOUT

PASSWORD CHANGE
EMAIL START/STOP
EMAIL TEST

FTP TEST

Example

Description

Query

SY

Syntax

SNTP
MEDIA EJECT

SYSTEM INFO
NETWORK_ INFO
TEXT_FIELD
4PANEL
JUMP_DISPLAY

RATE CHANGE

FAVORITE REGIST
SAVE_STOP

TIMER RESET
PAUSE DISPLAY
LCD_SAVER
MATCH T RESET

Eject the storage
medium

System information
Network information
Text field display

Register the home
display

Display rate 1/display
rate 2

Register as favorite
Stop the save
operation

Stop the monitor
Backlight saver
Reset the single
match timer

Display FREE MESSAGE and SNAPSHOT for
the first and second function menu items.
SMFUNC, FREE_MESSAGE, SNAPSHOT

A command error will occur if you specify the

same menu item multiple times.
You cannot specify SEPARATOR.
You cannot omit parameters by using

delimiters (, ,).

You cannot hide LOGOUT. If it is not included
in the parameters, it is displayed as the last

menu item.

SM ?
To query all menu items
SM DISP MAIN?

To query all main menu items
SM DISP_SUB?
To query all submenu items
SM DISP_SUB, TREND?
To query the Trend submenu items
SM FUNC?
To query all function menu items

Sets the 4 panel display

SY pl,p2,p3,p4,p5,p6,p7,p8,p9,p10,

pl
pl
p2
p3
p4

l<terminator>

1

Screen number (1 to 4)
Screen group name (up to 16 characters)

Screen 1 type

TREND Trend display
DIGITAL Digital display
BAR Bar graph display
OVERVIEW
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Query
Example

Description

Iy
Syntax

Query
Example

Description

ALARM Alarm summary

MESSAGE Message summary

MEMORY Memory summary

MODBUS-M Modbus master status
display

MODBUS-C Modbus client status
display

RELAY Relay status display

REPORT Report display

COLUMN BAR  Stacked bar graph

p5 Group number to be displayed on screen 1
p6 Screen 2 type (see p4)
p7 Group number to be displayed on screen 2
P8 Screen 3 type (see p4)
P9 Group number to be displayed on screen 3
P10 Screen 4 type (see p4)
P11 Group number to be displayed on screen 4
SY[ pl,[ p2]]>?
Set screen number 1 as follows:
4 panel name: TEMP
Screen 1: Trend display, group 1
Screen 2: Digital display, group 3
Screen 3: Alarm summary
Screen 4: Overview
SY1,1, TEMP, TREND, 1, DIGITAL, 3, ALARM,
1, OVERVIEW
» The group designations (p5, p7, p9, and p11)
are valid only if the corresponding display
types (p4, p6, p8, and p10) are {TREND,
DIGITAL, BAR}.
* The setting p4=MODBUS-M is valid only if the
serial interface protocol is set to MODBUS-M.
* The setting p4=REPORT or COLUMN_BAR
is valid only on models with the /M1 MATH
option.

Sets the file format

TY pl,p2
pl 1
p2 File format
TEXT Saves files in text format

BINARY Saves files in binary format

TY?

Save files in text format.

TY TEXT

* You can specify the file format for display data
and event data files.

» The ways you can save files whose file format
can be specified are auto save, save unsaved
data, manual save, and FTP data transfer.

» If you are using a communication command to

transmit a data file in the internal memory, it is
transmitted in binary format regardless of the
file format setting.

NF__

Syntax

Query
Example

If you are using a communication command
to transmit a data file on an external storage
medium, it is transmitted in the format that the
file is stored on the external storage medium.
If the MV is operating as an FTP server and
you retrieve a data file in the internal memory
via FTP, the data will be in binary format
regardless of the file format setting. If you are
retrieving a data file on an external storage
medium, the file will be in the format that the
file is stored in the external storage medium.
If the MV is operating as an FTP client and
you retrieve a data file in the internal memory
or a data file on an external storage medium
via FTP, the MV transmits the file in the
specified format.

Sets the HISTORY key function

NF
pl

P2

p3

NF

pl,p2,p3<terminator>
Key function
HISTORY  Use as a key to move the
historical trend display
FAVORITE Use as a favorite key
Display group number registered in the
favorite function

Valid when p1 is set to FAVORITE

SAVED Displays the screen in the
registered group
CURRENT  Displays the screen in the

current displayed group
Time axis zoom registered in the favorite
function
Valid when p1 is set to FAVORITE

SAVED Displays the screen using the
registered time axis zoom
CURRENT  Displays the screen using the

current time axis zoom
2

Use the HISTORY key as a favorite key and
display the screen in the current displayed group
using the current time axis zoom.

NF

FAVORITE, CURRENT, CURRENT

Description Parameter p2 and p3 settings are valid only
when the key function (p1) is set to FAVORITE.
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4.5 Setting Commands
(Control)

BT Sets a batch name
Syntax BT pl,p2,p3<terminator>
pl 1
p2 Batch number (up to 32 alphanumeric
characters)
p3 Lot number (up to 8 digits)
Query BT[ pl]?

Example Set the batch name configuration to batch
number PRESSSLINE and lot number 007.
BT1, PRESS5LINE, 007

BU Sets a batch comment
Syntax BU pl,p2,p3<terminator>
pl 1

p2 Comment number (1 to 3)
p3 Comment character sting (up to 50

characters)
Query BU[ pl,[ p2]]2
Example  Set comment number 2 to “THIS_PRODUCT_IS
_COMPLETED.”

BU1,2,THIS PRODUCT IS COMPLETED

ub Switches the display

To switch back to the display that was shown
before you started to change the settings with
communication commands

Syntax UD pl<terminator>
pl Screen switch (0)

Example  Switch back to the display that was shown
before you started to change the settings with
communication commands.

UDO

To change to one screen display
Syntax UD pl,p2,p3<terminator>
pl Screen switch (1)
p2 Display item

TREND Trend display
DIGITAL Digital display
BAR Bar graph display

OVERVIEW  Overview display
(alarm indicator)

ALARM Alarm summary display
MESSAGE Message summary display
MEMORY Memory summary display

MODBUS-M  Modbus master status display
MODBUS-C  Modbus client status display
RELAY Relay status display
REPORT Report display
HISTRICAL Historical display
COLUMN_ BAR Stacked bar graph

p3  Group number

Example Set the display to one screen trend display and
set the group number to 4.
UD1, TREND, 4
Description « The setting p2=MODBUS-M is valid only if the
serial interface protocol is set to MODBUS-M.
* The setting p2=REPORT or COLUMN_BAR
is valid only on models with the /M1 MATH
option.

To change to 4 panel display
Syntax UD pl,p2,p3,p4,p5,p06,p7,p8,p9
<terminator>
pl Screen switch (2)
p2 Screen 1 type (see SY (Sets the four panel
display))
p3  Group number to be displayed on screen 1
p4 Screen 2 type (see SY (Sets the four panel
display))
p5 Group number to be displayed on screen 2
p6 Screen 3 type (see SY (Sets the four panel
display))
p7 Group number to be displayed on screen 3
P8 Screen 4 type (see SY (Sets the four panel
display))
p9 Group number to be displayed on screen 4
Example  Assign group 1 to screen 1, group 2 to screen 2,
group 3 to screen 3, group 4 to screen 4, and set
all screen types to trend display.
UD2, TREND, 1, TREND, 2, TREND, 3, TREND, 4
Description This setting is valid on the MV2000.

To display the specified 4 panel number
Syntax UD pl,p2<terminator>
pl Display type (3)
P2 4 panel configuration number
0 Display the specified 4 panel
configuration screen.
1-4 Display the 4 panel configuration
specified by SY (sets the four
panel display).

To set the operation screen switching
Syntax UD pl,p2,p3,p4,p5,p6,p/<terminator>
pl Screen switch (4)
p2 Automatic display switching ON/OFF
p3 Switch between all channel display and
group display (ALL, GROUP)
p4 Scale display ON/OFF
pS5 Digital display ON/OFF
p6 Message display method
1 Normal display
2 List display
p7 Trend space ON/OFF
p8 Auto zone ON/OFF
r9 Fine grid ON/OFF
Example  Enable the automatic display switching, switch
to the group display, set the scale display to ON,
and set the digital display to OFF.
UD4, ON, GROUP, ON, OFF
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Description « Parameter p2 is valid for the trend, digital, or
bar graph displays. Use the TP command to
set the scroll interval.

» Parameters p3 to p7 are valid for the trend

display.
PS Starts/stops measurements
Syntax PS pl<terminator>
pl Measurement start/stop
0 Start
1 Stop
Example Start measurement.
PSO

Description When the MV starts measuring, it records the
display, event, and report data to the internal
memory.

AK Releases the alarm output (alarm
acknowledge)

Syntax AK pl<terminator>

pl Alarm acknowledge execution (0)
Example Release the alarm output (execute alarm
acknowledge).

AKO

EV Executes manual sample,
manual trigger, snapshot, or
forced timeout

Syntax EV pl<terminator>

pl Operation type

Execute manual sampling.

Activate a manual trigger.

Take a snapshot.

Expire the display data timer.

4 Expire the even data timer.

Execute manual sampling.

EV1

Description EV1 is valid only when the key trigger is set
to ON with the TE command (sets sampling
conditions of the event data). It functions the
same as the key trigger.

w N P O

Example

CL Executes manual SNTP
Syntax CL pl<terminator>

pl Manual SNTP execution (0)
Synchronize the clock manually.
CLO

Example

CVv Switches the trend update rate
Syntax CV pl<terminator>

pl Display rate (0, 1)

0 Switch to the primary trend update
rate (standard rate)
1 Switch to the secondary trend

update rate

Example

MS

Syntax

Example

Description

BJ

Syntax

Example

Description

EJ

Syntax

Example

Change the trend update rate to the secondary
trend update rate.
Ccvl

Writes a message (displays and
writes)
MS pl,p2,p3<terminator>
pl Message number (1 to 100)
p2 Destination where messages will be written
GROUP  Specify a single group
ALL All groups
p3  Group number
Write the message number 8 message to group
1.
MS8, GROUP, 1
» This command displays the message to the
screen and writes the message in the display
data and event data.
+ If you omit p2, the message is written to all
groups.

Writes a free message

BJ pl,p2,p3,pé4<terminator>

pl Message number (1 to 10)

p2 Message (up to 32 characters)

p3 Destination type where messages will be

written
GROUP Specify a single group
ALL All groups

p4 Destination where messages will be written
If p3 is set to GROUP

Use message number 3 and write the word

“ALARM” to all groups.BJ3,ALARM,ALL

If you omit p3, the message is written to all

Group number

groups.

Changes the login password

EJ pl,p2,p3<terminator>

pl Old password (up to eight alphanumeric
characters)

p2 New password (up to eight alphanumeric
characters)

p3  New password (up to eight alphanumeric
characters)

Change the old password “PASS001” to the new

password “WORDO005.”

EJPASS001,WORD0O05, WORD0O05
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L

Syntax

Example

Description

DS

Syntax

Example

Description

LO
Syntax

Example

Starts, stops, resets
computation (MATH) or clears
the computation dropout status
display

TL pl<terminator>

pl Operation type

0 Computation start
1 Computation stop
2 Computation reset
3 Clear the computation dropout

status display
Start computation.
TLO
* You cannot execute this command while setup
data is being saved or loaded.
* You can execute this command on models
with the /M1 math option.

Switches the execution mode
between operation and basic
setting

DS pl<terminator>

pl Eventtype

0 Operation Mode

1 Basic Setting Mode
Set the mode to Basic Setting Mode.
DS1

* You cannot set p1 to 1 while the MV is
measuring or computing, while the MV is
formatting an external storage medium, or
while the MV is saving data to an external
storage medium.

* You cannot set p1 to 0 while the MV is
formatting an external storage medium or
while the MV is saving data to an external
storage medium.

» To activate the settings that are changed with
the basic setting commands, you must save
the settings with the XE command. Make sure
to save the settings with the XE command
before changing from Basic Setting Mode to
Operation Mode. Otherwise, new settings will
not take effect.

 If you execute the DS command while the
screen display is stopped, the monitor will
resume.

Loads setup data
LO pl,p2<terminator>
pl File name (up to 32 characters)
p2 Media designation
0 CF slot
1 usB
Load setup data from the setup file SETFILE1
(.pdl extension).
LOSETFILEL

Description

LI
Syntax

Example

Description

CM

Syntax

Query
Example

Description

CE

Syntax

Query
Example

Description

» Do not specify the file name extension.

 If you omit p2, the media designation is set to
the CF slot.

« This command loads the setup data of both
Setting Mode and Basic Setting Mode.

« This command loads the setup data in the root
directory of the specified storage medium.

* You cannot execute this command only if an
external storage medium is inserted in the
drive.

* You cannot execute this command while the
MV is memory sampling.

» Because the MV restarts after executing this
command, communications will be dropped.

Saves setup data
LI pl<terminator>
pl File name (up to 32 characters)
p2 Media designation
0 CF slot
1 usSB
Save the setup data of both the setting and basic
setting commands to the file SETFILE2 on a CF
card.
LISETFILE2
» Do not specify the file name extension.
* If you omit p2, the media designation is set to
the CF slot.

* The .pdl extension is added to the saved file.
* You cannot execute this command only if an
external storage medium is inserted in the

drive.

Sets communication input data
CM pl,p2<terminator>
pl Communication input channel number
p2 Communication input data
The selectable range is —=9.9999E+29
to —1.0000E-30, 0, and 1.0000E-30 to
9.9999E+29.
Five significant digits.
CM?
Set communication input channel C01 to
communication input data 1.0000E—10.
CMC01,1.0000E-10
You can execute this command on models with
the /M1 math option.

Enters data in an external input
channel

CE pl,p2<terminator>

pl External input channel number

p2 Data value (-30000 to 30000)

CE[ pl]?

Set external input channel number 440 to 12345.
CE440,12345

You can execute this command on models with
the /IMC1 external input channel option.
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EM Starts/stops the e-mail YC Clears measured/computed data
transmission function and initializes setup data
Syntax EM pl<terminator> Syntax YC pl<terminator>
pl Operation type pl Type of data to be cleared
0 Start 0 Clear measured/computed data
1 Stop and initialize setup data
Example Start the e-mail transmission function. 2 Clear measured/computed data
EMO
Description To use the e-mail transmission function, IR Resets the relative timer
you must set the Ethernet interface, e-mail )
addresses, and contents to be transmitted. Syntax IR pl<terminator>
pl Timer number to be reset
0 All timers
CU ___  Manually recovers Modbus 1-4 Timer number 1 to 4
Syntax CU pl<terminator>
pl Communication type MA Resets a match timer
0 Modbus client (Ethernet)
1 Modbus master (serial) Syntax HA Pl )
P1 Match timer number to be reset (1 to 4)
Example  Reset match timer number 3.
BV Enters characters MA3
Syntax BV pl,p2<terminator> Description ¢« An error will occur if the timer operation of the
pl 0 match timer is set to repeat.
p2 Character string (up to 100 characters) » Nothing will occur if the single match timer has
Example  Enter user123. not expired.
BV0O,userl23
NR Sets the trend update rate
KE Key operation command Syntax ~ NR pl,p2<terminator>
Syntax KE pl<terminator> pl 1
pl Key type p2 Trend update rate [/div] (15S, 30S, 1MIN,
F1-F7 Soft keys 1to 7 2MIN, 5MIN, 10MIN, 15MIN, 20MIN, 30MIN,
ESC ESC key 1H, 2H, 4H, 10H)
MENU MENU key Query NR[ pl[,p2]]?
FUNC FUNC key Example Set the trend update rate to 5 min/division.
START START/STOP key NR1, SMIN
HISTORY HISTORY key Description «  You cannot set the trend update rate if the
USER USER key memory data type is event + display.
T/DIV T/DIV key » The logging number is fixed to 1.
0-9 Number 0 to 9 keys » Set the data update rate and auto save rate
MINUS Number minus key first with the SW command and then set the
DOT Number decimal key trend update rate with the NR command.
DISP DISP/ENTER key
UP Up arrow key
DOWN Down arrow key
RIGHT Right arrow key
LEFT Left arrow key
Example Press the DISP/ENTER key.
KEDISP
Description Operates in the same way as the keys on the
MV. For a key sequence, transmit the commands
in the same order that you would press the keys
on the MV.
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WO _  Sets alarm and DO settings
To set alarm and DO settings
Syntax WO pl,p2,p3,p4,p5<terminator>
pl Alarm setting
p2 Reflash operation ON/OFF
p3 Interval for the low limit on the rate-of-
change (1 to 32)
p4 Interval for the high limit on the rate-of-
change (1 to 32)
p5 Alarm status indicator hold/nonhold
HOLD
NONHOLD

To set the internal switch

Syntax WO pl,p2<terminator>
pl DO type (SWITCH)
P2 AND switch number

NONE No AND setting
501 Specify only S01
S01-Sxx Specify S01 to Sxx

xx = {02 to 30}

To set the output relay

Syntax WO pl,p2,p3,p4,p5<terminator>
pl DO type (RLY)
P2 Relay number

NONE No AND setting
101 Specify only 101
I01-Ixx Specify 101 to Ixx

xx = {02 to 36}

p3 Energize/De-energize the relay

DE_ENERGIZE

ENERGIZE
p4 Relay hold/nonhold

NONHOLD

HOLD
p5 Relay action on ACK

NORMAL

RESET

Description Set parameter p2 according to the table in
section 4.3.

Query WO[ pl]?

Example  Set the output relay to no AND operation and the
relay action to energize and release the relay
output when an alarm acknowledge is received
regardless of the alarm status.

WORLY, NONE, ENERGINE, HOLD, RESET

WH Sets an alarm hysteresis

For measurement channels
Syntax WH pl,p2,p3<terminator>
pl Channel type (MEASURE)
P2 High and low limit alarm hysteresis (0 to 50)
p3 Difference high and low limit alarm
hysteresis (0 to 50)

For computation channels
Syntax WH pl,p2<terminator>
pl Channel type (MATH)
p2 High and low limit alarm hysteresis (0 to 50)

For external input channels

Syntax WH pl,p2<terminator>
pl Channel type (EXTERNAL)
p2 High and low limit alarm hysteresis (0 to 50)

Query WH[ pl]?

Example  For measurement channels, set the high and low
limit alarm hysteresis to 4.0% and the difference
high and low limit alarm hysteresis to 0.0%.
WHMEASURE, 40, 0

Description You can set alarm settings on computation
channels on models with the /M1 math option.
You can set alarm settings on external input
channels on models with the /MC1 external input
channel option.

XV Sets the scan interval
Syntax XV pl,p2,p3,p4<terminator>
pl 1 (fixed)

p2 Scan interval mode
NORMAL Normal mode

FAST Fast sampling mode
p3  Scan interval (25MS, 125MS, 250MS, 1S,
28, 5S)

p4 A/D integration time (AUTO, 600Hz, 50Hz,
60Hz, 100ms)

Query XV?

Example Set the scan interval to 1 second in normal
mode.
XVNORMAL, 1

Description The combinations of scan interval modes and
scan intervals vary depending on the model.
See the MV1000/MV2000 User’s Manual (IM
MV1000-01E) for details.
You can set p4 to 600Hz when the scan interval
is set to fast sampling mode. You can set p4 to
100ms when the scan interval is set to 2s or 5s.

XB Sets the burnout detection
Syntax XB pl,p2<terminator>

pl Measurement channel number
P2 Burnout procedure
OFF Not processed
Up Set the measured result to +over
DOWN Set the measured result to —over
Query XB[ pl]?
Example  Set the measured result to UP (+over) if a
burnout is detected on channel 001.
XB001,UP
Description Set parameter p1 according to the table in
section 4.3.
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XJ Sets an RJC
To use the internal compensation circuit
Syntax XJ pl,p2<terminator>

pl Measurement channel number
p2 Reference junction compensation
designation (INTERNAL)
Query XJ[ pll?
Example Set the channel 001 RJC to the internal
compensation circuit.
XJ001, INTERNAL

To use an external RJC
Syntax XJ pl,p2,p3<terminator>
pl Measurement channel number
p2 Reference junction compensation
designation (EXTERNAL)
p3 External RJC value (20000 to 20000)
Query XJ[ pll?
Example Set the channel 002 RJC to external and set the
compensation value to 0 pV.
XJ002, EXTERNAL, O
Description « Set parameter p1 according to the table in
section 4.3.
» The unit of parameter p3 is pV.

wu Sets environment settings
Setup itemsGENERAL, BATCH, DISPLAY, MESSAGE, INPUT,
ALARM, SECURITY, MEDIA, MATH, REPORT,
SERVICEPORT, DECIMALPOINT, POP3

General environment settings
Syntax WU pl,p2,p3<terminator>
pl Setting type (GENERAL)
p2 Tag/channel number selection
TAG
CHANNEL
p3 Language
ENGLISH
JAPANESE
CHINESE
GERMAN
FRENCH
KOREAN
Example Select tag display and set the language to
English.
WUGENERAL, TAG, ENGLISH

Channel number

To set the batch function

Syntax WU pl,p2,p3,pd4<terminator>
pl Setting type (BATCH)
p2 Batch function ON/OFF
p3  Number of lot number digits (OFF, 4, 6, 8)
p4 Auto increment ON/OFF

Description Parameters p3 and p4 are valid only when p2 is
ON.

To set the display
Syntax WU pl,p2<terminator>
pl Setting type (DISPLAY)
p2 Trend type (T-Y)
p3 Partial expansion ON/OFF
p4 Trend update rate switching ON/OFF

To set message settings
Syntax WU pl,p2,p3,p4<terminator>
pl Setting type (MESSAGE)
p2 Method of writing messages from keys
COMMON Applied to all display groups
SEPARATE Applied to a specified display
group
p3 Power failure message ON/OFF
p4 Change message ON/OFF

To set the input
Syntax WU pl,p2<terminator>
pl Setting type (INPUT)
p2 Detection of values exceeding the scale
FREE When the measurement range is
exceeded
OVER When £105% of the scale is
exceeded

To set alarm settings
Syntax WU pl,p2<terminator>
pl Setting type (ALARM)
p2 Alarm suppression function ON/OFF

To set security settings
Syntax WU pl,p2,p3<terminator>
pl Setting type (SECURITY)

p2 Keys
OFF Disable security
KEYLOCK  Lock the keys
LOGIN Enable the login function
p3 Communication
OFF Disable security
LOGIN Enable the login function

Set media settings
Syntax WU pl,p2,p3<terminator>
pl Setting type (MEDIA)
P2 Auto save function ON/OFF
p3 Media FIFO ON/OFF
Example  Use media FIFO.
WUMEDIA, ON, ON
Description Parameter p3 is valid only when p2 is ON.
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To set computation settings
Syntax WU pl,p2,p3,p4<terminator>
pl Setting type (MATH)
p2 Display on error
+OVER
-OVER
p3 Data when the SUM or AVE value overflows
ERROR  Set the computed result to
computation error
SKIP Discard the data that overflowed
and continue the computation
LIMIT Process the data as follows:
+ High or low limit value in
the measurement range for
measurement channels that do
not use linear scaling
» High or low limit value in the
scaled range for measurement
channels that use linear scaling
» High or low limit value
in the specified span for
measurement channels
p4 Data when the MAX, MIN, or P-P value
overflows
OVER  Compute using the overflow data
SKIP Discard the data that overflowed
and continue the computation

To set report settings

Syntax WU pl,p2,p3,p4<terminator>
pl Setting type (REPORT)
P2 Report computation type 1

MAX Maximum value

MIN Minimum value

AVE Average value

SUM Sum value

INST Instantaneous value
p3 Report computation type 2

OFF Disable report computation

MAX Maximum value

MIN Minimum value

AVE Average value

SUM Sum value

INST Instantaneous value
p4 Report computation type 3

Same as p3.
p5 Report computation type 4

Same as p3.

p6 Generation of “hourly+daily,” “daily+weekly,”
and “daily+monthly” files
COMBINE  Output to a single file.
SEPARATE Output to separate files.

For parameters p2 to p5, the same computation

type cannot be specified except for OFF.

Auto service port
Syntax WU pl,p2,p3,p4,p5<terminator>
pl Setting type (SERVICEPORT)
p2 FTP service port (1 to 65535)
p3 Web service port (1 to 65535)
p4 SNTP service port (1 to 65535)
p5 Modbus service port (1 to 65535)
Query WUl pl]?

To set the decimal type
Syntax WU pl,p2
pl Setting type (DECIMALPOINT
p2 Decimal type
POINT Set the decimal to a period
COMMA Set the decimal to a comma
Query WU [pl]?
Example Set the decimal to a comma.
WU DECIMALPOINT, COMMA
Description < The specified decimal type is applied to the
following items.

Items That the Decimal Type Setting Applies To
Item Detailed ltems

File output Display data file

Event data file

Manual sample file

Report data file

Display Trend display (digital display, scale
display)

Digital display

Bar graph display

Overview

Historical display (digital display, scale
display)

4 panel display

Report display

Web screen All channel information display
E-mail Instantaneous data
Report data

» The specified decimal type is not applied to
the following items.
Items That the Decimal Type Setting Does Not Apply

To

Item Detailed Items

File output Setup file

Setup display Span, scale, and alarm settings for

measured, computed, and external
input channels

Computation constant

Hysteresis value (fixed decimal place)

Communication Command and response syntax for

(setup/output) communication commands

« The decimal for items that the decimal type
setting does not apply to is displayed with a

period.

To set POP3 parameters
Syntax WU p1,p2,p3
pl Setting type (POP3)
P2 Number of seconds until sending e-mail to
the SMTP server (0 to 10)
p3 POP3 login method
PLAIN Plain password
APOP APOP password
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XM Sets the memory sample
condition
Syntax XM pl<terminator>

pl Data type
DISPLAY Display data

EVENT Event data
E+D Display data and event data
Query XM?
Example Set the memory sampling condition to display
data.
XMDISPLAY
RF Sets the key lock function
p1=KEY

Syntax RF pl,p2,p3,p4,p5,p6,p7<terminator>
pl Type (KEY)
p2 START/STOP key (FREE, LOCK)
p3 HISTORY key (FREE, LOCK)
p4 MENU key (FREE, LOCK)
p5 USER key (FREE, LOCK)
p6 DISP/ENTER key (FREE, LOCK)
p7 TIDIV key (FREE, LOCK)

p1=FUNC (function keys)

Syntax RF pl,p2,p3,p4,pP5,p6,p7,p8
<terminator>
pl Type (FUNC)
p2 Alarm acknowledge (FREE, LOCK)
p3 Message/batch (FREE, LOCK)
p4 Math (FREE, LOCK)
p5 Data save (FREE, LOCK)
p6 E-mail/FTP (FREE, LOCK)
p7 Time set (FREE, LOCK)
p8 Display function (FREE, LOCK)

p1=MEDIA (external storage media)
Syntax RF pl,p2,p3<terminator>
pl Type (MEDIA)
p2 External storage media operation (FREE,
LOCK)
p3 Load setup (FREE, LOCK)
Query RE[ pl]?
Example Lock the MENU key (leave other keys unlocked).
RFKEY, FREE, FREE, LOCK, FREE, FREE, FREE

RN Sets basic login settings
Syntax RN pl,p2<terminator>
pl Auto logout (OFF, 1MIN, 2MIN, 5MIN,
10MIN)
p2 Operation when logged out
OFF Disable the MV operation

DISPLAY  Allow only display-related
operations
Query RN?
Example Set the auto logout time to 1 minute, and disable
the MV operation when logged out.
RN1MIN, OFF

RP__

Syntax

Sets login and user limitations
RP pl,p2, - <terminator>

pl User limit number (1 to 10)

p2 User limit item (KEY, FUNC, MEDIA)

Description Parameters p3 and subsequent parameters vary

p2=KEY

depending on the p2 setting as follows:

p3 START/STOP key (FREE, LOCK)
p4 HISTORY key (FREE, LOCK)

p5 MENU key (FREE, LOCK)

p6 USER key (FREE, LOCK)

p7 DISP/ENTER key (FREE, LOCK)
p8 T/DIV key (FREE, LOCK)

p2=FUNC (function keys)

Query
Example

p3 Alarm acknowledge (FREE, LOCK)
p4 Message/batch (FREE, LOCK)

p5 Math (FREE, LOCK)

p6 Data save (FREE, LOCK)

p7 E-mail/FTP (FREE, LOCK)

p8 Time set (FREE, LOCK)

p9 Display function (FREE, LOCK)

RP[ pl, [ p2]]?

Lock the START, HISTORY, and DISP/ENTER
keys.

RP1,KEY, LOCK, LOCK, , , LOCK

p2=MEDIA (external storage media)

Syntax

Query
Example

RP pl,p2,p3<terminator>

p2 User limit item (MEDIA)

p3 External storage media operation (FREE,
LOCK)

p4 Load setup (FREE, LOCK)

RP[pl]>?

Limit access to the external storage medium and

the loading of setup data.

RPMEDIA, LOCK, LOCK

Description If key lock is enabled, setup data cannot be

loaded. You can place limitations on the loading
of setup data for users that are logged in.
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RO Sets report types and generation
times

To specify no report types

Syntax RO pl<terminator>
pl Report type (OFF)

Query RO?

Example  Set the report to none.

ROOFF
Description You can execute this command on models with
the /M1 math option.

To specify hourly, daily, hourly+daily, or

daily+monthly reports

Syntax RO pl,p2,p3<terminator>
pl Report type

HOUR Hourly report

DAY Daily report

HOUR+DAY Hourly and daily reports

DAY+MONTH Daily and monthly reports
p2 Date of generation (dd)

dd Day (01 to 28)
p3 Time of generation (hh)

hh Hour (00 to 23)

Query RO?

Example  Generate a daily report at hour 9 everyday
(parameter p2 (“05” in this example) is invalid in
this case).

RODAY, 05,09

Description «  You can execute this command on models

with the /M1 math option.

» Parameter p2 is discarded if it is specified for

reports other than monthly and daily reports.

To specify daily+weekly reports
Syntax RO pl,p2,p3<terminator>
pl Report type (DAY+WEEK)
p2 Day of generation (SUN, MON, TUE, WED,
THU, FRI, SAT)
p3 Time of generation (hh)
hh Hour (00 to 23)
Query RO?
Example  Generate a daily report at hour 9 every day and
a weekly report at hour 9 every Tuesday.
RODAY+WEEK, TUE, 09
Description You can execute this command on models with

the /M1 math option.

RM Sets a report channel
To not use a report channel

Syntax RM pl,p2<terminator>
pl Report channel number
p2 Report channel ON/OFF (OFF)
Query RM[ pl]?
Example Disable the channel 001 report channel.
RM001,OFF

You can execute this command on models
with the /M1 math option.

» Set parameter p1 according to the table in
section 4.3.

Description «

To use a report channel

Syntax

Query
Example

RM
pl
P2
P3

p4

RM
Us

pl,p2,p3,pé4<terminator>

Report channel number

Report channel ON/OFF (ON)
Measurement, computation, or external
input channel number to be reported
Conversion of the time unit for TLOG.SUM
computation

OFF No conversion.

/S Convert as though the physical
values are integrated in units of
seconds.

/MIN Convert as though the physical
values are integrated in units of
minutes.

/H Convert as though the physical
values are integrated in units of
hours.

/DAY Convert as though the physical
values are integrated in units of
days.

[ pl]?

e report channel number RO1. Set the channel

number for generating reports to 001 and convert

the units of the summed value to seconds.

RM

Description ¢

XG
Syntax

RO1,0N,001,/S

You can execute this command on models
with the /M1 math option.

Set parameters p1 and p3 according to the
table in section 4.3.

About p4

Because the sampled data is integrated

over each scan interval, the physical value
integrated over a given period may be different
from the actual integrated value. This occurs
if the given period is not equal to the scan
interval. In such case, set p4 to the same unit
as that of the physical value being measured.
The integrated value is found according to the
following converting equations that depend on
the parameter.

OFF X (measured value)

/S > (measured value) x scan interval

/MIN X (measured value) x scan interval/60

/HOUR Z (measured value) x scan
interval/3600

/DAY X (measured value) x scan
interval/86400

The scan interval unit is seconds.

Sets the time zone

XG
pl

P2

pl,p2<terminator>

Offset time from GMT (-1300 to 1300)
Upper 2 digits: Hour (00 to 13)

Lower 2 digits: Minute (00 to 59)

Time deviation limit (OFF, 10S, 20S, 30S,
1MIN, 2MIN, 3MIN, 4MIN, 5MIN)
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Example Set the offset time from the GMT to 9 hours
ahead and the deviation limit to 30 s.
XG0900, 308

XN Sets the date format

Syntax XN pl<terminator>
pl Date format (Y/M/D, M/D/Y, D/M/Y, D.M.Y)

Query XN?

Example Set the date format to Y/M/D.

XNY/M/D
YB Sets host information

Syntax YB pl,p2<terminator>
pl Host name (up to 64 characters)
p2 Domain name (up to 64 characters)

Query YB?

Example Set the host name to mv1000 and the domain
name to mvadv.dagstation.com.
YBmv1000,mvadv.dagstation.com

YD Sets network settings

To not automatically obtain network parameters
Syntax YD pl,p2,p3<terminator>
pl Automatic allocation (NOT)

To automatically obtain network parameters

Syntax YD pl,p2,p3<terminator>
pl Automatic allocation (USE)
p2 Obtain DNS info (USE, NOT)
p3 Automatic host name registration (USE,

NOT)

Query ¥YD?

Example Set the IP address to auto allocation, get DNS
information, and automatically register the host
name.

YDUSE, USE, USE
YA Sets the IP address, subnet
mask, and default gateway

Syntax YA pl,p2,p3<terminator>
pl IP address (0.0.0.0 to 255.255.255.255)
p2 Subnet mask

(0.0.0.0 to 255.255.255.255)
p3 Default gateway
(0.0.0.0 to 255.255.255.255)
Query YA?
Example Set the IP address to 192.168.111.24, the subnet

mask to 255.255.255.0, and the default gateway
to 0.0.0.0.
YA192.168.111.24,255.255.255.0,0.0.0.0

Description The settings specified with this command take
effect when you save the settings with the XE
command and power-cycle the MV.

YK Sets the keepalive feature
Syntax YK pl<terminator>
pl Keepalive ON/OFF
Query YK?
Example Disable keepalive.

YKOFF

Description The settings specified with this command take
effect when you save the settings with the XE
command and power-cycle the MV.

RU Sets DNS parameters
To set server parameters
Syntax RU pl,p2,p3<terminator>

pl Setting type (SERVER)

p2 Primary DNS server address
(0.0.0.0 to 255.255.255.255)

p3 Secondary DNS server address
(0.0.0.0 to 255.255.255.255)

To set suffix parameters
Syntax RU pl,p2,p3<terminator>

pl Setting type (SUFFIX)

p2 Domain suffix 1 (up to 64 characters)
p3  Domain suffix 2 (up to 64 characters)

Query RU[ pl]?

Example  Set domain suffix 1 to rec1.dagstation.com and
domain suffix 2 to rec2.daqgstation.com.
RUSUFFIX, recl.dagstation.com, rec2.dagstation.com
WS __  Sets a server
Syntax WS pl,p2<terminator>
pl Server type (FTP, WEB, MODBUS, SNTP)
p2 Server usage (USE, NOT)
Query WS[ pl]l?
Example Enable the Web server.
WSWEB, USE
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ww
Syntax

Query
Example

Description

Ya

Sets the Web homepage
WW pl,p2,p3,pd4<terminator>
pl Homepage type
OPERATOR Operator page
MONITOR  Monitor page
p2 Homepage ON/OFF
p3 Authentication

OFF No authentication
ADMIN Administrator privileges
USER User privileges

p4 Command input (USE, NOT)

WW[ pl]?

Enable the operator page, disable the

authentication, and enable command input.

WWOPERATOR, ON, OFF, USE

» Parameter p3 and p4 are valid when p2 is ON.

» Parameter p4 is valid when p1 is set to
OPERATOR.

Sets the application timeout

To not use the timeout feature

Syntax

Query
Example

Description

YO pl<terminator>

pl Application timeout (OFF)

YQ?

Disable timeout.

YQOFF

The settings specified with this command take
effect when you save the settings with the XE
command and power-cycle the MV.

To use the timeout feature

Syntax

Query
Example

Description

yYr__
Syntax

Query
Example

YQ pl,p2<terminator>

pl Application timeout (ON)

p2 Timeout value [minutes] (1 to 120)

YQ?

Enable the application timeout and set the
timeout value to 3 min.

YQON, 3

The settings specified with this command take
effect when you save the settings with the XE
command and power-cycle the MV.

Sets the FTP transfer timing

YT pl,p2,p3<terminator>

pl Auto transfer when display and event data
files are generated (ON/OFF)

p2 Auto transfer when report data files are
generated (ON/OFF)

p3 Auto transfer when snapshot data files are
generated (when snapshot is executed) (ON/
OFF)

YT?

Auto transfer display and event data files. Do not

transfer report data files. Do not transfer image

data files.

YTON, OFF, OFF

Description If the method to save data to an external storage

YU

medium is set to Auto, the MV automatically
transfers data files as they are generated.
For media storage settings, see the MV1000/
MV2000 User’s Manual.

Sets the contents to be sent via
e-mail

To send changes in the alarm status

Syntax

Query
Example

YU pl,p2,p3,p4,05,p06,p7,p8,p9,p10,
pll,pl2<terminator>
pl Transmitted content (ALARM)
p2 Recipient 1 ON/OFF
p3 Recipient 2 ON/OFF
p4  Alarm transmission of alarm number 1 ON/OFF
p5 Alarm transmission of alarm number 2 ON/OFF
p6 Alarm transmission of alarm number 3 ON/OFF
p7 Alarm transmission of alarm number 4 ON/OFF
p8 Include instantaneous data ON/OFF
P9 Include source URL ON/OFF
p10 Subject (up to 32 alphanumeric characters)
pl1 Header 1 (up to 64 characters)
P12 Header 2 (up to 64 characters)
YU[ pl]?
Transmit alarms of alarm numbers 1 to 4
including instantaneous data but not including
the source URL to recipient 1. Set the subject to
“ALM” and header 1 to “LP2.”
YUALARM, ON, OFF, ON, ON, ON, ON, ON, OFF, AL
M, LP2

To send e-mail at scheduled times

Syntax

Query
Example

YU pl,p2,p3,p4,p5,p6,p7,p08,p9,p10,

pll,pl2<terminator>

pl Transmitted content (TIME)

p2 Recipient 1 ON/OFF

p3 Interval for sending e-mail to recipient 1
(1H, 2H, 3H, 4H, 6H, 8H, 12H, 24H)

p4 Time when e-mail is sent to recipient 1 (00:00
to 23:59)

p5 Recipient 2 ON/OFF

p6 Interval for sending e-mail to recipient 2
(1H, 2H, 3H, 4H, 6H, 8H, 12H, 24H)

p7 Time when e-mail is sent to recipient 2 (00:00
to 23:59)

p8 Include instantaneous data ON/OFF

p9 Include source URL ON/OFF

p10 Subject (up to 32 alphanumeric characters)

pl1l Header 1 (up to 64 characters)

pl12 Header 2 (up to 64 characters)

YU[ pl]?

Send e-mail at 17 hours 15 minutes every day

to recipient 1. Do not include instantaneous data

but include the source URL. Set the subject to

“GOOD” and header 1 to “LP2.”

YUTIME,ON, 24H,17:15,OFF,,,OFF, ON,

GOOD, LP2

4-34

IM MV1000-17E



4.6 Basic Setting Commands

To send system notifications

Syntax YU pl,p2,p3,p4,p5,p6,p7<terminator>
pl Transmitted content (SYSTEM)
p2 Recipient 1 ON/OFF
p3 Recipient 2 ON/OFF
p4 Include source URL ON/OFF
p5 Subject (up to 32 alphanumeric characters)
p6 Header 1 (up to 64 characters)
p7 Header 2 (up to 64 characters)

Query YU[ pl]?

Example  Send system notification e-mail messages
including the source URL to recipient 1. Set the
subject to “SystemAlert” and header 1 to “LP2.”
YUSYSTEM, ON, OFF, ON, SystemAlart, LP2

To send report generation notifications
Syntax YU pl,p2,p3,p4,p5,p6,p7<terminator>
pl Transmitted content (REPORT)
p2 Recipient 1 ON/OFF
p3 Recipient 2 ON/OFF
p4 Include source URL ON/OFF
p5 Subject (up to 32 alphanumeric characters)
p6 Header 1 (up to 64 characters)
p7 Header 2 (up to 64 characters)
Query YU[ pl]?
Example Send report generation notification e-mail
messages including the source URL to recipient
1. Set the subject to “Report” and header 1 to
“LP2.”
YUREPORT, ON, OFF, ON, Report, LP2
Description « For the contents of system notifications, see
section 2.3.
* Report generation notification can be used on
models with the /M1 math option.
» For e-mail settings, see section 2.3.

>

Sets e-mail recipient addresses
Syntax YV pl,p2<terminator>
pl Recipient selection
1 Recipient 1
2 Recipient 2
p2 Recipient address (up to 150 alphanumeric
characters)
Query YV[pl]?
Example Set recipient 1 to “mvuser1@daqgstation.com”
and “mvuser2@daqstation.com.”

YV1,mvuserl@dagstation.com mvuser2@

dagstation.com
Description = To set multiple recipients, separate each
recipient with a space.
» For e-mail settings, see section 2.3.

YW Sets the e-mail sender address
Syntax YW pl<terminator>
pl Sender address (up to 64 alphanumeric

characters)
Query YW?
Example Set the sender address to “mvadv.”
YWnmvadv

Description For e-mail settings, see section 2.3.

YX Sets the e-mail SMTP server
name
Syntax YX pl,p2,p3<terminator>
pl SMTP server name (up to 64 characters)
p2 Port number (0 to 65535)
p3  Authentication
OFF No authentication
POPBEFORESMTP Execute POP Before
SMTP
Query YX?
Example Set the SMTP server to “smtp.dagstation.com,”
the port number to “25,” and execute POP
Before SMTP.
YX smtp.dagstation.com,25, POPBEFORESMTP
Description For e-mail settings, see section 2.4.

YJ Sets a Modbus client destination
server

Syntax YJ pl,p2,p3,p4,p5<terminator>
pl Server number (1 to 16)
p2 Port number (0 to 65535)
p3 Host name (up to 64 characters)
p4  Unit number registration

AUTO  Not use the unit number
FIXED Use a fixed unit number
p5  Unit number (0 to 255)

Query YJ[ pl]?

Example Set the port number of server number 3 to 502,
the host name to mv2000, the unit number
registration to FIXED, and the unit number to
127.
¥J3,502,mv2000, FIXED, 127
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Ye

Syntax

Query
Example

YR

Syntax

Sets basic Modbus client

settings

YP pl,p2<terminator>

pl Read cycle (125MS, 250MS, 500MS, 1S,
28, 58S, 108)

p2 Retry interval (OFF, 10S, 20S, 30S,1MIN,
2MIN, 5MIN, 10MIN, 20MIN, 30MIN, 1H)

YP?

Set the read cycle to 500 ms and the retry

(reconnection) interval to 10 minutes.

YP500MS, 10MIN

Sets a Modbus client
transmission command

YR pl,p2,p3-:-<terminator>

pl Command number (1 to 16)

p2 Command type (OFF, R, R-M, W, W-M)

Description Parameters p3 and subsequent parameters vary

depending on the p2 setting as follows:

If p2 is OFF

There are no parameters after p2.

If p2 is R [read into external input channels]

p3  First channel (external input channel
number)

p4 Last channel (external input channel
number)

p5 Server number (1 to 16)

p6 First register number (30001 to 39999,
40001 to 49999, 300001 to 365536, 400001
to 465536)

p7 Register data type (INT16, UINT16,
INT32_B, INT32_L, UINT32_B, UINT32_L)

If p2 is R-M [read into communication input

channels]

p3  First channel (communication input channel
number)

p4 Last channel (communication input channel
number)

p5 Server number (1 to 16)

p6 First register number (30001 to 39999,
40001 to 49999, 300001 to 365536, 400001
to 465536)

p7 Register data type (INT16, UINT16,
INT32_B, INT32_L, UINT32_B, UINT32_L,
F LOAT_B, FLOAT_L)

If p2 is W [write measurement channels]

p3  First channel (Measurement channel
number)

p4 Last channel (Measurement channel
number)

p5 Server number (1 to 16)

p6 First register number (40001 to 49999,
400001 to 465536)

p7 Register data type (INT16, FLOAT_B,
FLOAT_L)

If p2 is W-M [write computation channels]
p3  First channel (computation channel number)
p4 Last channel (computation channel number)
p5 Server number (1 to 16)
p6 First register number (40001 to 49999,

400001 to 465536)
p7 Register data type (INT16, UINT16,
INT32_B, INT32_L, FLOAT_B, FLOAT L)

Query YR[ pl]?

Example  Set the command type of command number 5 to
W, the first channel to 01, the last channel to 04,
the server number to 1, the first register number
to 40001, and the register data type to INT16.
YR5,W,01,04,1,40001, INT16

Nofte
Parameter p3 must be less than or equal to p4.
Parameters p3, p4, and p7 determine the number of registers to
be read or written. An error will occur if the valid range of registers
indicated in p6 is exceeded.

WB Sets SNTP client settings

Syntax WB pl,p2,p3,p4,p5,p6<terminator>
pl SNTP client function usage (USE, NOT)

P2 SNTP server name (up to 64 alphanumeric
characters)

p3  SNTP port number (0 to 65535)

p4 Access interval (OFF, 1H, 8H, 12H, 24H)

p5 Reference time for the access interval (00:00
to 23:59)

p6  Timeout value (10S, 30S, 90S)

If you set p1 to NOT, p2 to p6 are invalid.

Query WB?

Example  Enable the SNTP client function, set the server
name to sntp.dagstation.com, the port number
to 123, the access interval to 24 hours, the
reference time to 12:00, and the timeout value to
30 seconds.

WBUSE, sntp.dagstation.com,123,24H,12:00,30S

WC Sets the SNTP operation when
memory start is executed

Syntax WC pl<terminator>
pl Time adjustment by SNTP at memory start
(ON/OFF)
Query We?
Example  Enable the time adjustment by SNTP at memory
start.
WCON
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YS
Syntax

Query
Example

Description

YL

Syntax

Query
Example

Description

Sets serial interface parameters
YS pl,p2,p3,p4,p5,p6<terminator>
pl Baud rate (1200, 2400, 4800, 9600, 19200,
38400)
p2 Data length (7, 8)
p3 Parity check (ODD, EVEN, NONE)
p4 Handshaking (OFF:OFF, XON:XON, XON:
RS, CS:RS)
p5 RS-422/485 address (01 to 99)
p6 Protocol (NORMAL, MODBUS,
MODBUS-M)
YS?
Set the baud rate to 9600, the data length to 8,
the parity check to ODD, handshaking to OFF:
OFF, the RS-422/485 address to 02, and the
protocol to NORMAL.
YS9600,8,0DD, OFF:0FF, 02, NORMAL
» The settings specified with this command take
effect when you save the settings with the XE
command and power-cycle the MV.
* You can execute this command on models
with the /C2 or /C3 serial interface option.

Sets Modbus master function

settings

YL pl,p2,p3,p4,p5<terminator>

pl Read cycle (125MS, 250MS, 500MS, 1S,

28, 5S, 10S)
p2 Timeout (125MS, 250MS, 500MS, 1S, 2S,
58, 10S, 1MIN)

p3 Retrials (OFF, 1 to 5, 10, 20)

p4 Command wait time (OFF, 5MS, 10MS,

15MS, 45MS, 100MS)

p5 Auto recovery (OFF, 1MIN, 2MIN, 5MIN,

10MIN, 20MIN, 30MIN, 1H)

YL?

Set the read cycle to 500 ms, the timeout to 250

ms, the retrials to 2, the command wait time to

10 ms, and the auto recovery to 5 min.

YL500MS, 250MS, 2, 10MS, SMIN

* You can execute this command on models
with the /C2 or /C3 serial interface option.

* You can use this command when the serial
interface protocol is set to Master. For serial
interface settings, see section 3.3.

» The settings specified with this command take
effect when you save the settings with the XE
command and power-cycle the MV.

YM

Sets a Modbus master
transmission command

To not assign a command

Syntax

Query
Example

YM pl,p2<terminator>

pl Registration number (1 to 16)

p2 Command ON/OFF (OFF)

YM[ pl]?

Do not assign a command to command
registration number 1.

YM1,OFF

To set a command for reading data into external
input channels

Syntax

Query
Example

YM pl,p2,p3,p4,p5,p6,p7<terminator>

pl Registration number (1 to 16)

p2 Command type (R)

p3  First channel number (external input channel
number)

p4 Last channel number (external input channel
number)

p5 Slave device address (1 to 247)

p6 First register number (30001 to 39999,
40001 to 49999, 300001 to 365535, 400001
to 465535)

p7 Type of data assigned to the register (INT16,
UINT16, INT32_B, INT32_L, UINT32_B,
UINT32_L)

YM[ pl]°?

Register the following command in command

registration number 2: Read the 32-bit signed

integer data that is assigned to registers 30002

(upper 16 bits) and 30004 (lower 16 bits) on the

slave device at address 5 into MV external input

channels 201 to 203.

YM2,R,201,203,5,30002, INT32_B

To set a command for reading data into
communication input channels

Syntax

Query
Example

YM pl,p2,p3,p4,p5,p6,p7<terminator>

pl Registration number (1 to 16)

p2 Command type (R-M)

p3 First channel number (communication input
channel number)

p4 Last channel number (communication input
channel number)

p5 Slave device address (1 to 247)

p6 First register number (30001 to 39999,
40001 to 49999, 300001 to 365535, 400001
to 465535)

p7 Type of data assigned to the register
(INT16, UINT16, INT32_B, INT32_L,
UINT32_B, UINT32_L, FLOAT_B,
FLOAT_L)

YM[ pl]?

Register the following command in command

registration number 2: Read the 32-bit signed

integer data that is assigned to registers

30002 (upper 16 bits) and 30004 (lower 16

bits) on the slave device at address 5 into MV

communication input channels C02 to C05.

YM2,R-M,C02,C05,5,30003,INT32 B
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4.6 Basic Setting Commands

To set a command for writing measurement

channels

Syntax

Query
Example

YM pl,p2,p3,p4,p5,p6,p7<terminator>

pl Registration number (1 to 16)

p2 Command type (W)

p3 First channel number (measurement
channel number)

p4 Last channel number (measurement
channel number)

p5 Slave device address (1 to 247)

p6 First register number (40001 to 49999,
400001 to 465535)

p7 Type of data assigned to the register (INT16,
FLOAT_B, FLOAT_L)

YM[ pl]?

Register the following command in command

registration number 3: Write the measured data

of channels 003 to 006 to registers 40003 to

40006 on the slave device at address 7.

YMm3,w,003,006,7,40003, INT16

To set a command for writing computation

channels

Syntax

YM pl,p2,p3,p4,p5,p6,p7<terminator>
pl Registration number (1 to 16)

p3  First channel number
Measurement channel number (1 to 48) if
p2is setto W
Computation channel number (101 to 124) if
p2 is set to W-M

p4 Last channel number (1 to 48)
Measurement channel number (1 to 48) if
p2is setto W
Computation channel number (101 to 124) if
p2 is set to W-M

p5 Server number (1 to 16)

p6 First register number (40001 to 499991,
400001 to 465536)

p7 Register data type

INT16 16-bit signed integer

UNIT16 16-bit unsigned integer

INT32 B  32-bit signed integer (Big
Endian)

INT32 L  32-bit signed integer (Little
Endian)

FLOAT B  32-bit floating point (Big
Endian)

FLOAT L  32-bit floating point (Little
Endian)

> e dt (WM) Example  Using command number 1, write the data from
p ommand type (V¥V- measurement channels 1 to 16 to the registers
p3  First channel number (computation channel at server number 3 starting from registergnumber
number) 40001 in 32-bit floating point format (Big Endian).
p4 Last channel number (computation channel YM1,W,1,16,3,40001, FLOAT B
number) Query YM?
p> Slave device address (1 to 247) Description The selectable range of the first channel number
p6 First register number (40001 to 49999, (p3) and last channel number (p4) varies
400001 to 465535) depending on the model.
p7 Type of data assigned to the register (INT16,
lL:’I'_"(‘;TG’L';“T”—B’ INT32_L, FLOAT_B, WR Sets the instrument information
Query YM[ pl]? output )
Example Register the following command in command Syntax WR pl,p2,p3, pZ_Ktermmatop
registration number 2: Write the 16-bit signed pl Memo.ry/Me(#a state ON/OFF
integer computed data of channels 101 to 105 p2 Self dlagr.105|.s ON/OFF
to the first register 40003 on the slave device at p3  Communication error ON/OFF
address 5. p4 Memory stop ON/OFF
YM2,W-M,101,105,5,40003, INT16 Query wR? o _
Description* You can execute this command on models Example  Output various information.
with the /C2 or /C3 serial interface option. FIRON, ON, O, ON
. You can use this c?mmand when the serlaTI XE Activates Basic Setting Mode
interface protocol is set to Master. For serial —
interface settings, see section 2.3. Syntax ~ XE pl<terminator>
+ The settings specified with this command take pl Store or discard the settings (STORE,
effect when you save the settings with the XE ABORT)
command and power-cycle the MV. Example  Save the setup data of the basic setting
. . commands.
To seta commarjd for writing floating type data YESTORE
into Modbus registers i Description To activate the settings that are changed with
Syntax  YM pl,p2,p3,p4,p3,p6, pi<terminator> the basic setting commands, you must save the
i; 82:22:3 ?yL:Jrzber (11016) settings with the XE command. Make sure to
W Write data from measurement save the settings with the XE command before
channels changing from Basic Setting Mode to Operation
WM Write data from computation Mode. Otherwise, new settings will not take
channels effect.
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4.6 Basic Setting Commands/4.7 Output Commands (Control)

YE

Syntax

Example

Activates Basic Setting Mode
(cold reset)
YE pl<terminator>
pl Setting activation
STORE  Start by saving the basic settings
ABORT  Start without saving basic settings
Start by saving the basic settings.
YESTORE

4.7 Output Commands
(Control)
BO Sets the byte output order
Syntax BO pl<terminator>
pl Byte order
0 Transmits the data MSB first.
1 Transmits the data LSB first.
Query BO?
Example  Output the data MSB first.
BOO

Description This command applies to the byte order of

CS

Syntax

Query
Example

numeric data for BINARY output.

Sets the checksum
CS pl<terminator>
pl Checksum usage

0 Not calculate (value fixed to zero)
1 Calculate

CS?

Enable (calculate) the checksum.

cs1

Description You can only use this command for serial

IF
Syntax

Query
Example

communications.

Sets the status filter

IF pl,P2<terminator>

pl Filter value of status information 1 to 4
(0.0.0.0 to 255.255.255.255)

p2 Filter value of status information 5 to 8
(0.0.0.0 to 255.255.255.255)

IF?

Set the status filter value to 1.0.4.0 and

255.127.63.31.

IF 1.0.4.0,255.127.63.31

Description See chapter 6 for details.

CcC
Syntax

Example

Disconnects the Ethernet
connection

CC pl<terminator>

pl Disconnection (0)

Disconnect the connection.

cco
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4.7 Output Commands (Control)/4.8 Output Commands (Setting/Measured/Computed Data Output)

CB

Syntax

Sets the data output format
CB pl<terminator>
pl Output format

0 Standard output (including the
data of SKIP and OFF channels)
1 Do not output the data of SKIP and

OFF channels

Description « This setting is independent for each

Nofte

connection.
» This command only affects the communication
section and has no effect on the front panel

4.8

Output Commands
(Setting/Measured/
Computed Data Output)

settings.
» Valid range of commands
Output data Corresponding
command
Instantaneous data (binary) FD1, FF
Instantaneous data (ASCII) FDO
Decimal place and unit information FE1
(ASCII)
Setup channel information (binary) FE5
Configured alarm output (binary) FE6

Initialization of BO/CS/IF/CB command settings

* For serial communications
Settings entered using the BO/CS/IF/CB commands revert
to their default values when the MV is reset (when the MV is
power cycled or the user exits from Basic Setting Mode).
« Byte output order, checksum, data output format: 0
« Status filter: 255.255.255.255
If you reset the MV, specify these settings again.

¢ For Ethernet communications
Settings entered using the BO/IF/CB commands revert to their
default values when the connection to the MV is dropped. After
reconnecting the MV, specify the settings again.

FC__

Syntax

Example

Transmits screen image data

FC pl<terminator>

pl GET (Output the screen image data)
Output screen image data from the MV.
FCGET

Description Captures the current MV screen and transmits

FE__

Syntax

Example

the data in PNG format.

Transmits setup data
FE pl,p2,p3<terminator>
pl Output data type

0 Setting commands setup data

1 Decimal place and unit information

2 Basic setting commands setup
data

4 Setup data file

5 Setup channel information output

6 Alarm information output

p2 First channel number (measurement/
computation/external input channel)

p3 Last channel number (measurement/
computation/external input channel)

Output the setting commands setup data of

channels 001 to 005 from the MV.

FEO, 001,005

Description ¢ Set the first channel number and last channel

FD__

Syntax

Example

number parameters so that the last channel
number is greater than or equal to the first
channel number.

» Parameters p2 and p3 are valid when p1 is set
to 0, 1, 2, 5, or 6. All channels are specified if
parameters p2 and p3 are omitted.

» Set parameters p2 and p3 according to the
table in section 4.3.

Transmits most recent
measured/computed data
FD pl,p2,p3<terminator>

pl Output data type

0 Output the most recent measured/
computed/external input data in
ASCII format

1 Output the most recent measured/

computed/external input data in
binary format
6 Output relay status and internal
switch status
p2 First channel number (measurement/
computation/external input channel)
p3 Last channel number (measurement/
computation/external input channel)
Output from the MV the most recent measured/
computed data of channels 001 to 005 in ASCII
format.
FDO, 001,005
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4.8 Output Commands (Setting/Measured/Computed Data Output)

Description

FF
Syntax

Example

Description

* The most recent measured/computed data
corresponds to the most recent measured/
computed data in the internal memory when
the MV receives the FD command.

» Set the first channel number and last channel
number parameters so that the last channel
number is greater than or equal to the first
channel number.

» Parameters p2 and p3 are valid when p1
is set to 0 or 1. All channels are specified if
parameters p2 and p3 are omitted.

» Set parameters p2 and p3 according to the
table in section 4.3.

Transmits FIFO data

FF pl,p2,p3,pé4<terminator>
pl Operation type
GET Transmit the next block
RESEND Retransmit the previous output
RESET Set the most recent data position
(block) to the read position of the
FIFO buffer (block)

p2 First channel number (measurement/

computation/external input channel)

p3 Last channel number (measurement/

computation/external input channel)

p4 Maximum number of blocks that are to be

loaded

1200 MV1004/MV2008/MV1008

240 MV1006/MV1012/MV1024/
MV2010/MV2020/MV2030/
MV2040/MV2048

60 Models with the /MC1 external
input channel option

If the measured/computed/external input

data is less than the specified number of

blocks, the MV transmits the available data.

Transmit two blocks of FIFO data from channels

1to0 10.

FFGET, 001,010,2

» The FIFO buffer is a cyclic buffer, which
overwrites the oldest data. Use the FR
command to set the acquisition period.

* The MV transmits the specified number of
blocks (p4), starting with the block after the
previously read block.

Make sure to read the data within the following
buffer period to prevent data dropouts.
+ MV1004
FIFO buffer size: 240 cycles (scan interval)
Maximum buffer period: 240 x (acquisition
interval). Resending is not
possible after the buffer
period elapses.

» Parameters p2 and p4 are valid when p1 is set
to GET.

« If p4 is omitted, the MV transmits all blocks.

» Set the first channel number and last channel
number parameters so that the last channel
number is greater than or equal to the first
channel number.

FL__

Syntax

Example

Description

Syntax

Example

Description

FU__

Syntax

Example

Description

» For the output flow diagram of FIFO data, see
appendix 5.

» Set parameters p2 and p3 according to the
table in section 4.3.

Transmits a log, alarm summary,
or message summary

FL pl,p2<terminator>

pl Log type
COM Communication
FTPC FTP client
ERR Operation error
LOGIN Login log
WEB Web operation
EMAIL E-mail
SNTP SNTP access log
DHCP DHCP access log
ALARM Alarm summary
MSG Message summary
MODBUS Modbus communication log

P2 Maximum read length of the log

1-200 Parameter p1 is COM or
MODBUS

1-1000 Parameter p1is ALARM

1-450 Parameter p1is MSG

1-50 Parameter p1 is some type

other than those above
Transmit the 10 most recent operation error logs.
FLERR, 10
» Transmits the log that is stored in the MV.
* If p2 is omitted, the MV transmits all written
logs.

Transmits status information
IS pl<terminator>
pl Status information output

0 Status information 1 to 4

1 Status information 1 to 8
Transmit status information 1 to 4.
IS0
The output status can be masked using the
status filter (IF command). For details on the
status information, see chapter 6.

Transmits the user level
FU pl<terminator>
pl User information output
0 Information about the user
currently logged in
1 Information about the user logged
into a general-purpose service
Transmit information about the user logged into a
general-purpose service.
FUl
Transmits information about the user that is
connected to the MV.
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4.8 Output Commands (Setting/Measured/Computed Data Output)

FA__

Syntax

ME

Syntax

Example

Description

Transmits instrument

information

FA pl<terminator>

pl Information type

Ip Address information including the

IP address, subnet mask, default
gateway, and DNS server address
as well as the host name and
domain name

Transmits data stored on an
external storage medium or
internal memory

ME pl,p2,p3<terminator>

pl Operation type

DIR Transmit the file list

GET Output (first time)

NEXT Output (subsequent times). This
parameter is used to output the
remaining data when the first
output operation is not enough to
output all of the data.

RESEND Retransmit the previous output

DEL Delete

DIRNEXT  Transmits the subsequent file
list after the file list is transmitted
by using the DIR command. The
number of transmitted lists is the
p3 value specified with the DIR
command. If you execute this
command after all lists have been
output, .the MV transmits the
following data.

EACRLF
ENCRLF

CHKDSK Checks the disk. Transmits the
free space on the external storage
medium.

p2 Path name (up to 100 characters)
Specify a full path.
p3  Maximum number of files from the list to be

transmitted (1 to 1000)

If omitted, the MV transmits the entire file list

in the specified directory.

» Transmit the list of all files in the DRVO
directory.
MEDIR, /DRV0/

» Transmit a list of 10 files in the DRVO directory.
MEDIR, /DRVO/, 10

» Transmit the data in the file 72615100.DAD in
the DRVO/DATAO directory.
MEGET, /DRVO/DATA0/72615100.DAD

» Parameter p2 is valid when p1 is set to DIR,
GET, DEL, or CHKDSK.

» Parameter p3 is valid when p1 is set to DIR.

« If an error occurs during data transmission,
you can retransmit the data by setting p1 to
RESEND.

Path Name Specifications
* The first level directories are as follows:

Path that starts with /MEMO/DATA/  Internal

memory

Path that starts with /DRVO0/ External storage

medium

* Path names are case-sensitive.
* You can access files whose name is less than

or equal to 48 characters in up to three directory

levels.

* Wild cards have the following limitations.

* When parameter p1 is DIR, * can be
specified for parameter p2.

+ If the path ends with a slash, it is equivalent
to specifying * for the path.

Example: /DRVO/DATAO0/ and /DRVO/
DATAO/" are equivalent.

» For the file name and extension, characters
starting with * are considered to be arbitrary.
Example: Let us assume that there are

five files: ab001.ef1, ab002.
ef1, ab001.ef2, ab002.ef2, and
ab001.yyy.

If you specify ab’01.ef1, ab001.
ef1 and ab002.ef1 are selected.
If you specify ab001.e™1, ab001.
ef1 and ab001.ef2 are selected.

MO Manipulates or transmits data

stored in the internal memory
Syntax MO pl,p2,p3<terminator>
pl Operation type
DIR Data list output
GET Data output
SIZE Data size output
p2 Output data type
MANUAL Manually sampled data
REPORT
p3 Specified file name
Example  Transmit report data from the MV.
MOGET, REPORT
Description Parameter p3 is valid when p1 is set to GET or
SIZE.
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4.9 Output Commands (RS-422/485 Commands)/4.10 Output Commands (Special Response Commands)

4.9

Output Commands
(RS-422/485 Commands)

ESC O

Syntax

Example

Opens an instrument

The ASCII code for ESC is 1BH. See appendix 3
for details.

ESC O pl<terminator>

pl Instrument address (01 to 99)

Open the instrument at address 99, and enable
all commands.

ESC 099

Description « Specifies the address of the instrument to

ESCC

Syntax

Example

communicate with.

* You can only open one instrument.

*  When you open an instrument with the ESC O
command, another instrument that is currently
open is automatically closed.

* When the MV receives this command
normally, the MV transmits the data “ESC O
oa”

» Normally, either CR+LF or LF can be used for
the terminator in communication commands.
However, the terminator for this command
must be set to CR+LF.

Closes an instrument

The ASCII code for ESC is 1BH. See appendix 3
for details.

ESC C pl<terminator>

pl Instrument address (01 to 99)

Close the instrument with the address 77.

ESC C77

Description « Releases the connection with the instrument.

* When the MV receives this command
normally, the MV transmits the data “ESC C
oo.”

* Normally, either CR+LF or LF can be used for
the terminator in communication commands.
However, the terminator for this command
must be set to CR+LF.

4.10 Output Commands (Special
Response Commands)

*| Transmits instrument
information
Syntax *I<terminator>

Description Transmits the maker, model, serial number, and
firmware version in a comma-separated ASCII
text with a terminator at the end.

Example = YOKOGAWA,MV1000, 99AA0123,F1.01

IM MV1000-17E
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4.11 Maintenance/Test Commands (available when using the maintenance/test server function via the Ethernet interface)

4.11 Maintenance/Test
Commands (available when
using the maintenance/
test server function via the
Ethernet interface)

close_ Disconnects the connection
between other instruments
Syntax close,pl,p2:p3<terminator>
pl MV port (1 to 65535)
p2 PC IP address
(0.0.0.0 to 255.255.255.255)
p3 PC port (0 to 65535)
Example close,34159,192.168.111.24:1054
EOQ
Description You cannot use this command to disconnect
a server port. You cannot use this command
to disconnect a port of an instrument that is
being controlled. Use the quit command for this

purpose.
con Transmits connection
information
Syntax con<terminator>
Example
con
EA

00/00/00 12:34:56

Active connections

Proto Local Address Foreign Address State
TCP  192.168.111. 24:34159 192.168.111. 24:1053 ESTABLISHED
TCP 0. 0. 0. 0:34155 0. 0. 0. 0: 0 LISTEN
TCP 0. 0. 0. 0:34159 0. 0. 0. 0: 0 LISTEN
TCP 0. 0. 0. 0:34150 0. 0. 0. 0: 0 LISTEN
EN
TCP
The protocol used.
Local Address
The MV socket address.
Displays “IP address:port number.”
Foreign Address
The destination socket address.
Displays “IP address:port number.”
State
Connection state.
ESTABLISHED
Connection established.
eth Transmits Ethernet statistics
e —
Syntax eth<terminator>
Example
eth
EA

00/00/00 12:34:56

Ethernet Statistics

Name In Pkt In Err Out Pkt Out Err 16 Coll

1o0 0 0 0 0 0
mb0 74 0 64 0 0
EN

help Displays help
Syntax help [,pl]l<terminator>
pl Command name
(close, con, eth, help, net, quit)

Example

help

EA

con - echo connection information
eth - echo ethernet information
help - echo help

net - echo network status

quit - close this connection

EN

net _  Transmits network statistics
Syntax net<terminator>

Example

net

EA

00/00/00 12:34:56

Network Status

APP: power on time = 00/00/00 12:34:56

APP: applalive = disable
APP: genedrops =0

APP: diagdrops =0

APP: ftpsdrops =0

TCP: keepalive = 30 s
TCP: connects = 14

TCP: closed =0

TCP: timeoutdrop =0

TCP: keepdrops =0

TCP: sndtotal = 53

TCP: sndbyte =
TCP: sndrexmitpack =
TCP: sndrexmitbyte =
TCP: rcvtotal =
TCP: rcvbyte =
DLC: 16 collisions =
EN

o o o - o o

TCP: keepalive
Keepalive check cycle.
TCP: connects
Total number of connections established.
TCP: closed
Total number of closed connections.
TCP: timeoutdrop
Total number of dropped connections due
to TCP retransmission timeout. When the
transmitted packet is not received, the
MV retransmits the packet at given time
intervals. If the packet is not received after 14
retransmissions, a timeout occurs, and the MV
drops the connection.
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quit

Syntax

TCP: keepdrops

Total number of dropped connections due to

TCP keepalive timeout.
TCP: sndtotal

Total number of sent packets.
TCP: sndbyte

Total number of sent bytes.
TCP: sndrexmitpack

Total number of retransmitted packets.
TCP: sndrexmitbyte

Total number of retransmitted bytes.
TCP: rcvtotal

Total number of received packets.
TCP: rcvbyte

Total number of received bytes.
DLC: 16 collisions
Number of collision incidents. A collision occurs
when two or more instruments on the network
attempt to transmit a packet simultaneously.
The tendency for collisions to occur increases
when the network is congested. “16 collisions”

refer to 16 consecutive collision incidents.

Disconnects the connection
to the instrument that is being
controlled

quit<terminator>

412

Instrument Information
Output Commands
(available when using the
instrument information
server function via the
Ethernet interface)

The instrument information server function interprets one

UDP packet to be one command and returns a single packet

(containing MV information) in response to the command.

Port number 34264/udp
Data format ASCII
Receive buffer size 128

Send buffer size 512

Maximum number of parameters 32

In the command packet, list the parameters for the
information you want to query.

Parameter  Description

serial Queries the serial number.

host Queries the host name. (The host name specified in section 3.2.)
ip Queries the IP address. (The IP address specified in section 3.2.)
Example  Query the IP address and host name. (The first

Description «

box below shows the command packet. The
second box shows the response packet.)

ip host

EA

ip = 192.168.111.24
host = MV1000-1

EN

Separate each parameter with one or more
spaces (space, tab, carriage return, line feed).
» Parameters are not case-sensitive.

* Undefined parameters are ignored.

» Parameters exceeding the number of
maximum parameters (32) are ignored.
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4-45

—— H



Chapter 5 Responses

5.1

Response Syntax

The following table shows the types of responses for various commands described in the

previous chapter.

The MV returns a response (affirmative/negative response) to a command that is
delimited by a terminator. The controller should follow the one command to one response
format. If the command-response rule is not observed, the operation is not guaranteed.

Basic Setting commands

Output commands

Control

Commands Response
Group Affirmation Negation

Setting commands  |Setting Affirmative response Single negative
Control response or multiple

negative responses

Setup, measured, and Text output

computed data output Binary output

RS-422/485 Dedicated response No response
Special response Dedicated response

commands

*

For details on the responses of the instrument information server function, see section 5.4.
For details on responses to special commands, see section 4.10.

Note

“CRLF” used in this section denotes carriage return line feed.

Affirmative Response
If a command is processed normally, the MV returns an affirmative response.
¢ Syntax
EOCRLF

* Example
EO

Single Negative Response
If a command fails to be processed normally, the MV returns a single negative response.
¢ Syntax

El nnn mmm- - -mCRLF
nnn Error number (001 to 999)
mmm- - -m Message (variable length, one line)
Space
¢ Example
E1 001 "System error"

Multiple Negative Responses

» If there is an error in any of the multiple commands that are separated by sub
delimiters, the MV returns multiple negative responses.

* The MV transmits a response for each command that causes an error.

 If there are multiple commands that have errors, the MV transmits negative responses
separated by commas.

» The error position numbers are assigned in order to the series of commands. The first
command is assigned the number 1.
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Response Syntax

Text Output

Binary Output

¢ Syntax
E2 ee:nnnCRLF
E2_ee:nnn, ee:nnn, ***,ee:nnnCRLF
ee Error position (01 to 10)
Error number (001 to 999)

Space

nnn

e Example
E2 02:001

(When there is only one error)
(When there are multiple errors)

For information about text data types and data formats, see section 5.2.

* Syntax
EACRLF
............... CRLF
............... CRLF
............... CRLF
ENCRLF

Conceptual Diagram

]ASCII format

Binary format

| 1byte
AEs nBs CR LF
Binary header
Data length

(12 bytes) ataleng

Flag ID Header sum
Binary data / Binary data
Binary footer i
(2 bytes) Data sum
EBCRLF

Indicates that the data is binary.

Data Length

The number of bytes in “flag + identifier + header sum + binary data + data sum.”

Header Sum

The sum value of “data length + flag + identifier.”

Binary Value

For information about output formats of various data types, see section 5.3.
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Data Sum
The sum value of the binary data.

Note

The MV transmits the data length in the binary header section according to the byte order that
is specified with the BO command.

Flag

Bit

Name (Abbreviation) Flag Meaning of the Flag
0

O =~ N W oo~

BO MSB
Cs No

Output byte order
Checksum availability

Middle In the middle of or at the end of

continuous data

ID

When the BO flag is 0, the MV transmits the high byte first. When the BO flag is 1, the MV
transmits the low byte first.

If checksum is enabled (parameter = 1) using the CS command parameter, a sum value is
inserted in the header sum and data sum sections. If checksum is disabled (parameter =
0), a zero is inserted in the header sum and data sum sections. For a sample function that
calculates the sum value, see “Calculating the Sum Value” on the next page.

If the amount of data to be transmitted in response to an ME command is large, the MV may
not be able to transmit all the data in one output request (parameter GET). If this happens,
the END flag is set to 0.You must request for subsequent data (parameter NEXT) until the
END flag becomes 1.

The bits whose name and flag are indicated as “~” are not used. Their values are undefined

An ID number indicating the binary data type. The table below indicates the data types
and the corresponding output commands. Binary data files that are not indicated in the
table below are considered undefined files.

ID Binary Data Type Type Format Output
Number Command
0 Undefined file File (*.*) - ME

1 Instantaneous data Data Yes FD

1 FIFO data Data Yes FF

13 Screen data file File (* . PNG) - ME, FC
15 Display data file (binary) File (* . DAD) No ME

16 Event data file (binary) File (* . DAE) No ME

17 Manually sampled file File (* . DAM) Yes ME, MO
18 Report file File (* . DAR) Yes ME, MO
19 Setup data file File (* . PDL) No ME, FE4
25 Configured channel information output Data Yes FE5

26 Configured alarm information output Data Yes FE6

29 Display data file (text) File (* . TDD) Yes ME

30 Event data file (text) File (* . TDE) Yes ME

Yes: Disclosed. No: Undisclosed. —: Common format.
The table above shows the different types of binary data.

There are two binary data types: data and file.

¢ Data
* You can transmit measured/computed data by using the FD command.
* You can transmit FIFO data by using the FF command.
» The data format is disclosed. See section 5.3 for details.
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e File
» Display data (binary), event data (binary), and setup data files can be used on the
DXA120 DAQSTANDARD that comes with the package. For details, see the DXA120
DAQSTANDARD User’s Manual IM04L41B01-61E.
» Files in a general format can be opened using commercially-sold software programs.
» Other files are in text format. You can use any text editor to open these files.

Calculating the Sum Value

If you set the CS command parameter to 1 (enabled), the MV transmits the checksum
value only during serial communications. The checksum is used in TCP/IP and is derived
according to the following algorithm.

Buffer for Calculating the Sum Value
* The header sum is calculated from the data length, flag, and ID (fixed to 6 bytes).

» The data sum is calculated from the binary data.

1 byte Paddlngl

- [ 1 1 [ [ Jo
(1) (@) 3) (4) (5) (6)

If the data length of the buffer is odd, a zero is padded so that it is even. (1) through
(6) indicated in the figure above are summed as unsigned two-byte integers (unsigned
short). If the digit overflows, 1 is added. Finally, the result is bit-wise inverted.

Sample Function

Below is a sample function that determines and returns the sum value. Your program
can compare the value returned by the sample function with the header sum of the
output binary header section and the data sum of the output binary footer section to
see if they are correct.

/*

* Sum Calculation Function (for a 32-bit CPU)

*

* Parameter buff: Pointer to the head of the data for calculating the sum

* len: Length of the data for calculating the sum
* Returned value:  The calculated sum
*/

int cksum(unsigned char *buff, int len)

{

unsigned short *p; /* Pointer to the next two-byte data word in the buffer that is
to be summed. */

unsigned int csum; /[* Checksum value */

int 1i;

int odd;

csum = 0; /* Initialize. */

odd = len%2; /* Check whether the number of data points is odd. */

len >>= 1; /* Determine the number of data points using a “short”

data type. */
p = (unsigned short *)buff;

for (i=0;i<len;i++) /* Sum using an unsigned short data type. */

csum += *p++;

IM MV1000-17E



5.1 Response Syntax

if (odd) { /* When the data length is odd */
union tmp({ /* Pad with a 0, and add to the unsigned short data. */

unsigned short s;

unsigned char cl2];

}tmp;

tmp.c[1l] = 0;

tmp.c[0] = *((unsigned char *)p);

csum += tmp.s;

}

if ((csum = (csum & Oxffff) + ((csum>>16) & Oxffff)) Oxffff)
/* Add the overflowed digits *
csum = csum - Oxffff; /* If the digit overflows again, add a 1. */
return ((~csum) & Oxffff); /*bitinversion*/

RS-422/RS-485 Responses
The following table shows RS-422/RS-485 interface commands and their responses.
Command Description Response
Syntax
ESC Oxx CRLF Opens a device  * Response from the device with the specified address
ESC Oxx CRLF
* No response if the device with the specified address
does not exist’
ESC Cxx CRLF Closes a device  * Response from the device with the specified address
ESC Cxx CRLF
* No response h: the device with the specified address
does not exist
* Possible reasons for not finding a device with the specified address are: (1) there is an error in
the command, (2) the specified address does not match the device address, (3) the device is
not turned ON, and (4) the device is not connected via the serial interface.

+ The “xx” in the table indicates the device address. Specify the address that is
assigned to the device in the range of 01 to 99.

* You can only open one device at any given time.

« If a device is opened with the ESC O command, all commands are enabled on the
device.

» If a device is opened with the ESC O command, any other device that is open is
automatically closed.

» Normally, either CR+LF or LF can be used for the terminator in communication
commands. However, the terminator for these commands must be set to CR+LF.

Nofte
The ASCII code for ESC is 1BH. See appendix 1 for details.
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Text Data Output Format

The table below lists the available text data types. This section will explain each format.
The table below indicates the data types and the corresponding output commands.

Data Type

Corresponding Output Command

Setting data/basic setting data
Decimal place and unit information

Measured, computed, and external input data
Relay and internal switch status
Communication log

FTP client log

Operation error log

Login log

Web operation log

E-mail log

SNTP access log

DHCP access log

Modbus communication log
Alarm summary

Message summary

Status information

Ethernet information

File list

Check disk result

Manually sampled data and report data information

User information

FEO, FE2
FE1

FDO

FD6
FLCOM
FLETPC
FLERR
FLLOGIN
FLWEB
FLEMAIL
FLSNTP
FLDHCP
FLMODBUS
FLALARM
FLMSG
1s0,IS1
FAIP
MEDIR
MECHKDSK
MODIR
FUO, FU1

Note

“CRLF” used in this section denotes carriage return line feed.

Setting Data/Basic Setting Data

The MV returns the setting/basic setting data in response to an FE command.
» The MV returns the data in order as listed in the table in section 4.2, “A List of
Commands.” However, the MV does not return the setting data for the following

commands

¢ Setting commands (setting)
SD and FR commands

¢ Setting commands (control)
All commands from BT to IR

* Basic setting commands
XE, YO, YE, and YC commands

» The output format of the setting/basic setting data conforms to the syntax of each

command.

* The MV returns multiple lines for some commands (for example, commands that are

specified for each channel).

¢ Syntax

The MV returns the two-character command name and subsequent parameters in the

following syntax.
EACRLF
ttsss- - +sCRLF

ENCRLF

5-6
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tt Command name (SR, SA---, XA, XI-)
sss- - +s Setting/basic setting data (variable length, one line)

* Example

EA
SR001,VOLT, 20mV, 0,20
SR002,VOLT, 20mv, 0,20

Decimal Place and Unit Information

The MV returns decimal place and unit information in response to an FE command.
You can use the CB command to specify whether or not the MV will return the data of
measurement channels set to SKIP and computation channels set to OFF.

Syntax

The MV returns the data for each channel in the following syntax.

EACRLF

s_cccuuuuuu, ppCRLF

ENCRLF
s Data status (N, D, or S)
N: Normal
D: Differential input
S: Skip (When the measurement range is set to SKIP for a
measurement channel or when the channel is turned OFF for a
computation channel)
cce Channel number (3 digits)
001 to 048: Measurement channel
101to160: Computation channel
201 to 440: External input channel
uuuuuu  Unit information (six characters, left-justified)
mv__ mV
\Y : Vv
~C : °C
XXXKKX : (User-defined character string)
pp Decimal place (00 to 04)

No decimal (00000) for 00.

One digit to the right of the decimal (0000.0) for 01.
Two digits to the right of the decimal (000.00) for 02.
Three digits to the right of the decimal (00.000) for 03.
Four digits to the right of the decimal (0.0000) for 04.
Space

* Example

EA
N 001mv ,01
N 002mv ,01
EN
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Measured, Computed, and External Input Data
» The MV returns measured, computed, and external input data in response to an FD

command.

* You can use the CB command to specify whether or not the MV will return the data of
measurement channels set to SKIP and computation channels set to OFF.

* Syntax

The MV returns the data along with the date and time information for each channel in
the following syntax.

EACRLF

DATE yy/mo/ddCRLF
TIME hh:mm:ss.mmmtCRLF

s_cccalazasasuuuuuufdddddE-ppCRLE

ENCRLF

Yy
mo

dd
hh
mm
ss

mmm

ccc

alazaszai4

uuuuuu

Year (00 to 99)

Month (01 to 12)

Day (01 to 31)

Hour (00 to 23)

Minute (00 to 59)

Second (00 to 59)

Millisecond (000 to 999. A period is placed between seconds and
milliseconds.)

Reserved (Space.)

Data status (N, D, S, O, E, or B)

N: Normal

D: Differential input

S : Skip

0: Overflow

E: Error

B: Burnout

Channel number (3 digits)

001 to 048: Measurement channel
101to160: Computation channel
201 to 440: External input channel

a1 Alarm status (level 1)

az  Alarm status (level 2)

as  Alarm status (level 3)

as  Alarm status (level 4)

(Each statusis setto H, L, h, 1, R, r, T, t, or space.)

((H: high limit alarm, L: low limit alarm, h: difference high-limit alarm, 1:
difference low-limit alarm, R: high limit on rate-of-change alarm, r: low
limit on rate-of-change alarm, T: delay high limit alarm, t: delay low limit
alarm, space: no alarm)

Unit information (six characters, left-justified)

mv__ mV

\Y : \Y

~C : °C

XXXKKXK : (User-defined character string)
Sign (+, -)
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ddddd Mantissa (00000 to 99999, 5 digits)
« Eight digits for computed data.
» For abnormal data (data status is E) or data whose mantissa or
exponent exceeds the range (data status is O), the mantissa is set to
99999 (99999999 for computed data).
pp Exponent (00 to 04)
Space

* Example

EA

DATE 99/02/23

TIME 19:56:32.500

N 001h mv +12345E-03
N 002 mv -67890E-01
S 003

EN

Note

* The MV does not return data for channels that do not exist (not even the channel number).
» For channels set to skip, the values from the alarm status to exponent will be spaces.

Relay and Internal Switch Status

The MV returns the relay status and internal switch status in response to an FD
command.

¢ Syntax

EACRLF

I01-I06:aaaaaaCRLF
Il11-Tl16:aaaaaaCRLF
I21-I26:aaaaaaCRLF
I31-I36:aaaaaaCRLF
S01-S30:aaa- - *CRLF

ENCRLF
aaa- -+ Indicates the relay statuses in ascending order by relay number from the
left.
1: Relay ON
0: Relay OFF
-: Relay not installed
Example 1

When relays 101 to 104 are ON, and 105 and 106 are not installed (for the MV1000)
EA

I01-106:1111--

I11-T16:————---

I21-I26:-——---

S01-130:000000000000000000000000000000
EN
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Communication Log

The MV returns the communication log in response to an FL command.

The MV returns logs of setting/basic setting/output commands and responses. The
MV retains a maximum of 200 logs. Logs that exceed 200 are cleared from the oldest
ones.

Syntax
EACRLF

yy/mo/dd_hh:mm:ss n uuu---ufd mmm- -+ mCRLF

ENCRLF
vy Year (00 to 99)
mo Month (01 to 12)
dad Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
ss Second (00 to 59)
n Connection ID. A number used to identify the user that is connected.

0: Serial
1to 3: Ethernet
uuu- - -u User name (up to 20 characters)

f Multiple command flag
Space: Single
* Multiple

(If you transmit multiple commands separated by sub delimiters at once,
this flag is set to an asterisk. The MV divides the multiple commands
into individual commands and stores a log for each command and a log
for each response.
d Input/Output
>: Input
<: Output
mmm- + -m Message (up to 20 characters)
* The communication log contains only the error number and not the
error message section.
* Normally, the MV returns the data as-is, but in some cases, it returns
a special message. The special messages are described below.

Reception
(Over length) : Command length exceeded.
(Over number) : Number of commands exceeded.
(Serial error): Received an error character through serial

communications.
Transmission

(ddd byte) : Data output (where ddd is the number of
data values)

(Login) : Login

(Logout) : Logout

(Disconnected) : Forced disconnection (occurs when the

connection is disconnected when transmitting
data via the Ethernet interface).
(Time out) : Timeout, keepalive, TCP retransmission, etc.
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FTP Client Log

e Example

E1l nnn:

E2 ee:nnn:

Space

Single negative response (where nnn is the

error number)

Multiple negative response (where ee is the

error position and nnn is the error number)

The following example shows the log that is generated when you transmit
“BO1;?2?7?;PS0” (multiple commands separated by sub delimiters). The commands
are separated and returned in order with the multiple command flag “*” attached.

EA

99/05/11 12:31:11 1 12345678901234567890*> BO1
99/05/11 12:31:11 1 12345678901234567890*< EO
99/05/11 12:31:11 1 12345678901234567890*> 2?7272
99/05/11 12:31:11 1 12345678901234567890*< E2 01:124
99/05/11 12:31:11 1 12345678901234567890*> PSO
99/05/11 12:31:11 1 12345678901234567890*< EO

EN

The MV returns the FTP client log in response to an FL command.

The MV retains a maximum of 50 file transfer logs. Logs that exceed 50 are cleared
from the oldest ones.

For a description of the error codes, see the MV1000/MV2000 User’s Manual (IM
MV1000-01E).

Syntax
EACRLF
yy/mo/dd hh:mm:ss nnn xxxxxxxxx k ffffffff ---CRLF
ENCRLF

%% Year (00 to 99)

mo Month (01 to 12)

dd Day (01 to 31)

hh Hour (00 to 23)

mm Minute (00 to 59)

ss Second (00 to 59)

nnn Error code (001 to 999)

xxxxxxxxx Detailed code (nine characters)

k Server type (P, S)

P: Primary
S: Secondary
fff--- File name (up to 51 characters including the extension)
_ Space
* Example

EA
99/07/26 10:00:00 P display.dsp
99/07/27 10:00:00 P setting.pnl
99/07/28 10:00:00 123 HOSTADDR P trend.png
EN
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5.2 Text Data Output Format

Operation Error Log

Login Log

The MV returns the operation error log in response to an FL command.

The MV retains a maximum of 50 operation error logs. Logs that exceed 50 are
cleared from the oldest ones.

The MV does not return other communication messages (400 to 999) and status
messages (500 to 599).

For a description of the error codes, see the MV1000/MV2000 User’s Manual (IM
MV1000-01E).

Syntax

EACRLF

yy/mo/dd hh:mm:ss nnn uuu---uCRLF

ENCRLF

vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
ss Second (00 to 59)
nnn Error code (001 to 999)
uuu- - -u Error message

_ Space

Example

EA

99/05/11 12:20:00 212 "Range setting error"
99/05/11 12:30:00 217 "Media access error"
EN

The MV returns the log of users that have logged in and logged out in response to an
FL command.

The MV retains a maximum of 50 login/logout logs. Logs that exceed 50 are cleared
from the oldest ones.

If the power goes down while you are logged in, you will be logged out. In this case,
however, this logout will not be recorded in the log.

Syntax

EACRLF

yy/mo/dd hh:mm:ss xXXXXXxXXXXX nnn_uuu- - uCRLF

ENCRLF
%% Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
ss Second (00 to 59)
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xxxxxxxxxx  Returns a login history left-justified.

nnn

uuu - - -

* Example
EA

99/05/11
99/05/11
99/05/11
99/05/11
EN

Web Operation Log

» The MV returns the log of operations on the Web screen in response to an FL

command.

Login: Login
Logout: Logout
NewTime: New time
TimeChg: Time change
PowerOff: Power Off
PowerOn: Power On
TRevStart: Start of gradual time adjustment
TRevEnd: End of gradual time adjustment
TimeDST: Switching of the daylight savings time
SNTPtimset: Time change by SNTP
Operation property
KEY: Key operation
COM: Communication
REM: Remote
ACT: Event action
SYS: System
User name (up to 20 characters)
Space
12:20:00 Login KEY administrator
12:30:00 Logout KEY administrator
12:20:00 Login COM user
12:30:00 Logout COM user

* The MV retains a maximum of 50 operations. Logs that exceed 50 are cleared from

the oldest ones.

* Syntax
EACRLF

yy/mo/dd_hh:mm:ss ffffff eee ??272--

- ?CRLF

ENCRLF

Yy
mo

dd
hh
mm
ss
fEffff

Year (00 to 99)
Month (01 to 12)
Day (01 to 31)
Hour (00 to 23)
Minute (00 to 59)

Second (00 to 59)
Requested operation

SCREEN:

KEY:
MSG:

CREATE:

Screen change

Key operation

Message assignment/write
File generation
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eee

Error code when executing the requested operation
All spaces: Success
001 to 999: Failure (error code)
-? Parameter for each event (see below)
When ££££ff = SCREEN
yy/mo/dd hh:mm:ss ffffff eee ddddd nnCRLF
ddddd Screen type

nn

TREND: Trend display

DIGIT: Digital display

BAR: Bar graph display
HIST: Historical trend display
oV: Overview display

Group number (01 to 36)
e When £££££F
yy/mo/dd hh:mm:ss ffffff eee kkkkkCRLF

= KEY

kkkkk Type of key that was used
DISP: DISP/ENTER key
UP: Up key
DOWN : Down key
LEFT: Left key
RIGHT: Right key
HIST: HISTORY key

* When ££f£ffff = MSG

yy/mo/dd_hh:mm:ss ffffff eee mmm- - -mCRLF
mmm- - -m Message (up to 32 characters)

e When ff££f£ff
yy/mo/dd hh:mm:ss ffffff eee kkkkkkkkkkkCRLF
kkkkkkkkkkk File type

= CREATE

DisplayFile: Display data file
EventFile: Event data file
_ Space
* Example
EA
01/02/11 12:20:00 SCREEN 275 TREND 01
01/02/11 12:21:00 SCREEN BAR
01/02/11 12:30:00 KEY UP
01/02/11 12:31:00 KEY RIGHT
01/02/11 12:40:00 MSG Hello-Hello
EN
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E-mail Log

The MV returns the e-mail transmission log in response to an FL command.

The MV retains a maximum of 50 operations. Logs that exceed 50 are cleared from
the oldest ones.

Syntax

EACRLF

yy/mo/dd_hh:mm:ss ffffff eee n uuu---uCRLF

ENCRLF

vy Year (00 to 99)

mo Month (01 to 12)

dd Day (01 to 31)

hh Hour (00 to 23)

mm Minute (00 to 59)

ss Second (00 to 59)

fEf£f£ff E-mail type
ALARM: Alarm mail
TIME: Scheduled mail
REPORT: Report timeout mail
FAIL: Power failure recovery mail
FULL: Memory full mail
TEST: Test mail
ERROR: Error message mail

eee Error code
All spaces: Success
001 to 999: Error code

n Recipient list
1: List1
2: List2

+: List1andlist2
uuu- -+ -u Series of recipient e-mail addresses (up to 30 characters)
Space

* Example

When list 1 is “user1@daqgstation.com user2@dagmaster.com” and
list 2 is “adv1@dagmaster.com adv2@dagstation.com”

EA

01/05/11 12:20:00 ALARM + userl user2 advl adv2
01/05/11 12:30:00 REPORT 375 1 userl user?2

EN
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5.2 Text Data Output Format

SNTP Log

* The MV returns the SNTP log in response to an FL command.
* The MV retains a maximum of 50 accesses to the SNTP server.
* Syntax

EACRLF

yy/mo/dd _hh:mm:ss nnn xxxxxxxxxxXCRLF

ENCRLF
vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
ss Second (00 to 59)
nnn Error number (000 to 999)
xxxxxxxxxx Detailed code (nine characters)
SUCCESS: Success
OVER: Over the limit
DORMANT : Internal processing error
HOSTNAME: Failed to look up the host name
TCPIP: Internal processing error
SEND: Failed to send the request
TIMEOUT: A response timeout occurred
BROKEN: Packet was corrupt
LINK: The data link is disconnected
_ Space
* Example
EA
01/05/11 12:20:00 SUCCESS
01/05/11 12:21:00 SUCCESS
01/05/11 12:30:00 292 HOSTNAME
EN
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5.2 Text Data Output Format

DHCP Log

The MV returns the DHCP log in response to an FL command.
The MV retains a maximum of 50 accesses to the DHCP server.

Syntax
EACRLF
yy/mo/dd_hh

ENCRLF

Yy
mo
dd
hh
mm
Ss

nnn

XXXXXXXXX

mm:ss NNn_ XXXXXXXXXCRLF

Year (00 to 99)

Month (01 to 12)

Day (01 to 31)

Hour (00 to 23)

Minute (00 to 59)

Second (00 to 59)

Error number (000 to 999)
Description given in the table.
Detailed code (nine characters)
Description given in the table.
Space

The table below shows the contents of the log for normal operation.

Error Number Detail Code Description

562 ON Detected that an Ethernet cable was connected.
OFF Detected that an Ethernet cable was disconnected.

563 RENEW Requesting address renewal to the DHCP server.
RELEASE Requesting address release to the DHCP server.

564 RENEWED Address renewal complete.
EXTENDED Address release extension request complete.
RELEASED Address release complete.

565 IPCONFIG IP address configured.

566 NOREQUEST Configured not to register the host name.

567 UPDATE Registered the host name to the DNS server.

568 REMOVE Removed the host name from the DNS server.

IM MV1000-17E
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5.2 Text Data Output Format

The table below shows the contents of the log when an error occurs.

Error Number Detail Code Description
295 REJECT Address obtained by DHCP is inappropriate.
296 ESEND Failed to send to the DHCP server.
ESERVER DHCP server not found
ESERVFAIL No response from the DHCP server.
ERENEWED Address renewal rejected by the DHCP server.
EEXTENDED Address lease extension request rejected by the DHCP
server.
EEXPIRED Address lease period expired by the DHCP server.
297 INTERNAL Host name registration failure (transmission error
reception timeout, etc.)
FORMERR Host name registration failure (format error: DNS
message syntax error)
SERVFAIL Host name registration failure (server failure: DNS
server processing error)
NXDOMAIN Host name registration rejection (non existent domain)
NOTIMP Host name registration rejected (not implemented)
REFUSED Host name registration rejected (operation refused)
YXDOMAIN Host name registration rejected (name exists)
YXRRSET Host name registration rejected (RR set exists)
NXRRSET Host name registration rejected (RR set does not exist)
NOTAUTH Host name registration rejection (not authoritative for
zone)
NOTZONE Host name registration rejection (different from zone
section)
NONAME Host name not entered on the MV.
298 INTERNAL Host name removal failure (transmission error,
reception timeout, etc.)
FORMERR Host name removal failure (format error: DNS message
syntax error)
SERVFAIL Host name removal failure (server failure: DNS server
processing error)
NXDOMAIN Host name removal rejection (non existent domain)
NOTIMP Host name removal rejected (not implemented)
REFUSED Host name removal rejected (operation refused)
YXDOMAIN Host name removal rejected (name exists)
YXRRSET Host name removal rejected (RR set exists)
NXRRSET Host name removal rejected (RR set does not exist)
NOTAUTH Host name removal rejection (not authoritative for zone)
NOTZONE Host name removal rejection (different from zone
section)
NOTLINKED Physical layer was disconnected when removing the
host name.
* Example
EA
01/05/11 12:20:00 563 RENEW
01/05/11 12:20:01 564 RENEWED
01/05/11 12:20:01 565 IPCONFIG
01/05/11 12:21:02 567 UPDATE
EN
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5.2 Text Data Output Format

Modbus Communication Log
* The MV returns the Modbus communication log in response to an FL command.
* The MV retains a maximum of 50 Modbus communication events.
e Syntax
EACRLF
yy/mo/dd hh:mm:ss ¢ xxxxxxx kkkk nn dCRLF

ENCRLF
8% Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
ss Second (00 to 59)
c Communication type (C or M)

C: Modbus client (Ethernet)
M:  Modbus master (serial)
xxxxxxx Even that occurred (seven characters)

DROPOUT : Communication could not keep up, and a dropout
occurred.
ACTIVE: Activated.
READY : Command ready state.
CLOSE: Disconnected.
HALT: Command halted.
kkkk Detail (four characters)
GOOD: Normal operation
NONE : No response from the slave device.
FUNC: Received a function error.
REGI: Received a register error.
ERR: Received a packet error.
LINK: Ethernet cable disconnected (Modbus client).
HOST: Unable to result the IP address from the host name
(Modbus client).
CNCT: Failed to connect to the server (Modbus client).
SEND: Failed to send the command (Modbus client).
BRKN: Failed to receive the command.
Space At command start
nn Command number (1 to 16, space)
d Command type (R, W, space)
R: Read
W: Write
_ Space
 Example
EA
01/05/11 12:20:00 C DROPOUT
01/05/11 12:21:00 C READY NONE 01 R
01/05/11 12:25:00 C HALT NONE 01 R
EN
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5.2 Text Data Output Format

Alarm Summary
* The MV returns the alarm summary in response to an FL command.
* The MV retains a maximum of 1000 alarm events.
Alarm events that exceed 1000 are cleared from the oldest ones.
* Syntax
EACRLF
yy/mo/dd hh:mm:ss_kkk ccc ls nnnnnnnnnnCRLF

ENCRLF
yy/mo/dd hh:mm:ss Time when the alarm occurred
vy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
Ss Second (00 to 59)
kkk Alarm cause
OFF: Alarm release
ON: Alarm occurrence
ACK: Alarm acknowledge
cce Measurement, computation, or external input channel number
1 Alarm level (1 to 4)
s Alarm type (H, h, L, 1, R, r, T, or t)
nnnnnnnnnn  Alarm sequence
_ Space

For all-channel alarms, the channel number, alarm level, and alarm status items
are all set to asterisk.

¢ Example
EA

01/05/11 12:20:00 ON 001 1L
01/05/11 12:30:00 OFF 131 3t
01/05/11 12:31:00 OFF *** *%*
01/05/11 12:32:00 ACK

EN

SN
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5.2 Text Data Output Format

Message Summary
* The MV returns the message summary in response to an FL command.
* The MV retains a maximum of 100 messages. Messages that exceed 100 are cleared
from the oldest ones.

* Syntax
EACRLF
yy/mo/dd hh:mm:ss mmm--:- ggg::- zzz uuu--: nnn--*CRLF
ENCRLF
\%% Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
ss Second (00 to 59)

mmm- - - Message (32 characters. Spaces are padded when the number of
characters is less than 32 characters.)
ggg- - + Message write destination group (11 characters)

XX, XX, XX, XX 3 Displays groups that have message written in, each
group separated by a comma (up to four groups)
ALL: All groups

z72 Operation property
KEY: Key operation
COM:  Communication
REM: Remote
ACT: Event action
SYs: System
uuu- - - User name (up to 20 characters)
nnn- - - Message sequence number (0 for add messages)

_ Space
 Example
EA
01/05/11 12:20:00 operation-start 01,02,03,04 KEY admin 11
01/05/11 12:20:00 operation-start 01,02 KEY admin 11
01/05/11 12:20:00*0123456789%abcdefg 01,02,03,04 KEY admin 12
EN
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5.2 Text Data Output Format

Status Information
* The MV returns the operation status of the recorder in response to an IS command.
The output format varies between 1S0 and 1S1.
» For details on status information, see section 5.2, “The Bit Structure of the Status
Information.”

Output in response to the IS0 command

¢ Syntax
EACRLF

aaa.bbb.ccc.dddCRLF
ENCRLF

aaa Status information 1 (000 to 255)
bbb Status information 2 (000 to 255)
cce Status information 3 (000 to 255)
ddd  Status information 4 (000 to 255)

* Example
EA

000.000.032.000
EN

Output in response to the IS1 Command

* Syntax
EACRLF

aaa.bbb.ccc.ddd.eee.fff.ggg.hhhCRLF
ENCRLF

aaa Status information 1 (000 to 255)
bbb Status information 2 (000 to 255)
cce Status information 3 (000 to 255)
ddd  Status information 4 (000 to 255)
eee Status information 5 (000 to 255)
fff Status information 6 (000 to 255)
999 Status information 7 (000 to 255)
hhh  Status information 8 (000 to 255)

¢ Example
EA

000.000.032.000.000.000.000.000
EN

+ Status information 3, 4, 7, and 8 are edge operation. They are cleared when read
using the IS command.

+ Status information 1, 2, 5, and 6 are level operation. They are not cleared when read.
They are cleared when the causing event clears.

» The status information is made up of bits that correspond to each event. Each bit can
be turned ON/OFF with a filter.

» If an event occurs for a bit set to OFF by the filter, status information 3, 4, 7, and 8
ignore the event. Status information 1, 2, 5, and 6 hold the event.

» The default filter setting is ON for all bits.
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5.2 Text Data Output Format

Ethernet Information
* The MV returns the Ethernet information in response to an FA command.

File List

* Syntax
EACRLF

IP Address

Subnet mask

IXXX XXX . XXX .XXXCRLF

IXXX XXX . XXX . XXXCRLF

Default Gateway :xXx.XXX.XxX.xXxCRLF

Primary DNS

IXXX XXX XXX . XXXCRLF

Secondary DNS = :XXX.XXX.XXX.XXXCRLF
Host YYyyr et CRLF
Domain ZZZ e CRLF
ENCRLF
XXX IP address number (000 to 255)
yyy* -+ Hostname (up to 64 characters)
zzz+ -+ Domain name (up to 64 characters)

* The MV returns the file list or the file data sizes for the specified directory on the MV’s
external storage medium in response to the ME command.

* Syntax
EACRLF
yy/mo/dd hh:mm:ss ssssssss fff-:: 0 xxx-:-:CRLF
ENCRLF
Yy Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
Ss Second (00 to 59)
ssssssssss  Data size of the file ( 0t0 99999999) [byte(s)]
fff--- File name (51 characters including the extension. If it is less than
51, spaces are entered.)
If this is a directory, the characters <DIR> are shown at the
position displaying the file data size.
XXX+ Data serial number (16-digit hexadecimal)

Space

The data serial number is included for files in the DATA directory in the internal
memory. For other files, the data serial number is spaces.
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5.2 Text Data Output Format

Check Disk Result

Example 1

File list output of an external storage medium

EA

05/02/24 20:07:12 1204 setting.pnl
05/02/24 20:18:36 <DIR> DATAO

EN

Example 2

File list output of the DATA directory in the internal memory
EA

05/02/24 20:07:12 1204 006607 050101 000402.DAD
05/02/24 20:07:12 1204 006608 050101 000403.DAD
EN

0 1ABCDE123
0 1234567890123456

The MV returns the free space on the storage medium in response to an ME command.
Syntax
EACRLF
zzz-++ Kbyte freeCRLF
ENCRLF
zzz- -+  Free space on the storage medium (16 digits)
Space
Example
EA
12345678 Kbyte free
EN
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5.2 Text Data Output Format

Manually Sampled Data and Report Data Information
The MV returns manually sampled and report data information in response to an MO

command.
e Syntax
EACRLF
slll:--- yy/mo/dd hh:mm:ss bbbb fff-::CRLF
ENCRLF
s Data flag
Space Confirmed data
+: Data that was overwritten
* Data being added
111---  File number (10 digits)
%% Year (00 to 99)
mo Month (01 to 12)
dd Day (01 to 31)
hh Hour (00 to 23)
mm Minute (00 to 59)
ss Second (00 to 59)
bbbb Number of events (four characters)
fff---  File name (up to 48 characters including the extension)
_ Space
* Example
EA
+ 6 05/03/04 00:00:00 20 aaaa30312345.DAR
7 05/03/05 00:00:00 20 30400005.DAR
8 05/03/06 00:00:00 20 30500005.DAR
* 9 05/03/06 13:00:00 20 uuuu0005.DAR
EN
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5.2 Text Data Output Format

User Information

The MV returns the user name, user level, and other information in response to an FU
command.

Syntax
EACRLF
p_1 uuu---CRLF
ENCRLF
p Login method
E: Ethernet
S: RS-232 or RS422/RS485
K: Login using keys
1 User level
A:  Administrator
U: User
uuu- - - User name (up to 20 characters)
_ Space
Example 1

When you send the FUO command, the MV returns only the information about the user
himself or herself that is logged in.

EA

E A admin

EN

Example 2
When you send the FU1 command, the MV returns information about all users logged

in through a general-purpose service or through keys.
EA

K A
E A
EU
EU
EN

admin_ abc
admin def
user0033
user0452
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5.3

Binary Data Output Format

This section describes the binary data output format that is disclosed.

For information about other binary data, see section 5.1.

Instantaneous data (measured/computed/external input) and FIFO data
Configured channel information data

The MV returns measured data and computed data using signed 16-bit integer and

Configured alarm information data
Manual sample file

Report sample file

Display data (text)

Event data (text)

signed 32-bit integer, respectively. These integers can be understood as physical values
by adding a decimal point and unit. The decimal place can be determined using the FE
command.

Examples of Obtaining Physical Values from Binary Data

Binary Value Decimal Place Code Physical Value (Measured Value)
10000 0 10000

10000 1 1000.0

10000 2 100.00

10000 3 10.000

10000 4 1.0000

Nofte

“CRLF” used in this section denotes carriage return line feed.

IM MV1000-17E
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5.3 Binary Data Output Format

MeasuredlComputed Data and FIFO Data
The MV returns the measured/computed data in response to an FD command.

* The MV returns the FIFO data in response to an FF command.

* You can use the CB command to specify whether or not the MV will return data of
measurement channels set to skip and computation and external input channels set to

OFF.
* The ID number of the output format is 1. See “ID” in section 5.1.
2 bytes 2 bytes
Number of blocks Number of bytes g
Block 1 N Binary data
N (The binary data section in the
Block n Ny

Number of Blocks
This is the number of blocks.

“Conceptual diagram” in section 5.1.)

Number of Bytes

This is the size of a block in bytes.

Block
1 byte | 1 byte | 1 byte | 1byte | 1byte 1 byte 2 bytes 1 byte 1 byte
Year | Month | Day Hour Min s ms (Reserved)*| Flag
T*| Channel | A2A1 | A4A3 Measured data

T*| Channel A2A1 | A4A3 Computed data

T*| Channel | A2A1

A4A3 | External input data

<

4 bits 12 bits

* The sections indicated as (Reserved) are not used. The value is undefined.
** Abbreviation of “Type” for the purpose of this figure.

* Flag

A description of each flag is given in the table below. The flags are valid for FIFO
data output. The flags are undefined for other cases.

Bit Flag Description
0 1

7 No Yes Indicates that the screen snapshot was executed.

6 — —

5 — —

4 - —

3 — —

2 No Yes Indicates that the decimal place or unit information was
changed during measurement.

1 No Yes Indicates that the FIFO acquiring interval was changed with
the FR command during measurement.

0 No Yes Indicates that the internal process took too much time

(computation, for example) and that the measurement could
not keep up at the specified scan interval.

The bits that have “~” for the flag column are not used. The value is undefined.
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5.3 Binary Data Output Format

Special Data Values

Block Member

Name Binary Value
Year 0to 99
Month 1t012
Day 1to 31
Hour 0to 23
Minute 0to 59
Second 0to 59
Millisecond 0 to 999
(Reserved) Undefined
Type 0x0:  16-bit integer (measurement channel/external
input channel)
0x8:  32-bit integer (computation channel)
Channel 110 48, 101 to 160, or 201 to 440

Alarm status’
A1 (Bit0to 3)

A2 (Bit4 to 7) 0Oto 8
A3 (Bit 0 to 3)
A4 (Bit4 to 7)
Measured data/external input data 0 to OXFFFF
Computed data 0 to OXFFFFFFFF

* Abinary value 0 to 8 is entered in the upper and lower 4 bits of a byte (8 bits) for the alarm
status. The binary values 0 to 8 correspond to H (high limit alarm), L (low limit alarm), h
(difference high-limit alarm), | (difference low-limit alarm), R (high limit on rate-of-change
alarm), r (low limit on rate-of-change alarm), T (delay high limit alarm), and t (delay low limit

alarm) as follows:
O:noalarm, 1: H, 2:L,3:h,4:1,5: R, 6:r,7: T, and 8: t.

The measured/computed data takes on the following values under special conditions.

Special Data Value

Measured Data

Computed Data

+Over
—Qver

Skip

Error

Undefined

Burnout (up setting)

Burnout (down setting)

7FFFH
8001H

8002H
8004H
8005H
7FFAH
8006H

7FFF7FFFH
80018001H

80028002H
80048004H
80058005H
7TFFF7FFFH
80018001H

The MV returns the number of blocks, the number of bytes, and the measured/computed
data according to the byte order specified by the BO command.
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5.3 Binary Data Output Format

Configured Channel Information Data
The MV returns the configured channel information data in response to an FE5

1 byte

command.

The ID number of the output format is 25.
You can use the CB command to specify whether or not the MV will return data of
measurement channels set to skip and computation channels set to OFF.

The figure below indicates the format.

1 byte

2 bytes

2 bytes 1 byte 1 byte

Version

(Reserved)

Number of blocks

Block size  |(Reserved)|(Reserved)

Configured channel information block 1

Configured channel information block n

[/

Format Details

Item Description Output Value
Version Format version 1

Number of blocks Number of configured channel information blocks Up to 348

Block size’ Size of the of configured channel information blocks 72

Block 1ton Configured channel information blocks Up to 25056 bytes

See Block Details.

* Returned in the byte

order specified by the BO command.

Block Details
Item Number of Bytes Description
Channel number’ 2 1 to 440
Decimal place 1 Oto4
(Reserved) 1 0
Channel type 4 2H for measurement and external input channels

and 4H for computation channels.
This value is ORed with 800H when the range mode
is DI or 8000H when the range mode is skip.

Unit information 8 The terminator is \0.’
Tag information 24 The terminator is \0.’
Minimum input value” 4 Measurement channels: Allowable input range under
the current setting
Maximum input value™ 4 Computation channels: —9999999, +99999999
(fixed)
External input channels: —30000, +30000 (fixed)
Span lower limit’ 4 Measurement channels (when scaling is not used):
Same value as the MV span setting
Span upper limit” 4 Measurement channels (when scaling is used):

Same value as the MV scale setting
Computation and external input channels:
Same value as the MV span setting

Scale lower limit”

4 Measurement channels:

Same value as the span

Scale upper limit’

4 Computation and external input channels:

Same value as the span

FIFO type’

2 1

Area in the FIFO

2 Indicates the position of its own channel in the FIFO

block of one sample.
The value starts from zero.

(Reserved)

4 0

* Returned in the byte

order specified by the BO command.
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5.3 Binary Data Output Format

Configured Alarm Information Data
» The MV returns configured alarm information data in response to an FE6 command.
* The ID number of the output format is 26.
» The figure below indicates the format.

1 byte 1 byte

2 bytes 2 bytes 1 byte 1 byte

> »€

> <€ > € < >

Version |(Reserved)| Number of blocks| Block size |(Reserved)|(Reserved)

Configured alarm information block 1

Configured alarm information block n

[1/]/

Format Details

Item Description Output Value
Version Format version 1

Number of blocks” Number of configured alarm information blocks Up to 348

Block size” Size of the of configured alarm information blocks 24

Block 1 to n Configured alarm information blocks Up to 8352 bytes

See Block Details.

* Returned in the byte order specified by the BO command.

Block Details
Item Number of Bytes Notes
Channel number 2 1 to 440
Decimal place 1 Oto4
(Reserved) 1 0
Alarm type 4 The following settings are entered in order from

level 1to 4.

0: Setting off, 1: H (high limit), 2: L (low limit),
3: h (difference high limit),4: | (difference low limit),
5: R (high limit on rate-of-change),

6: r (low limit on rate-of-change),

7: T (delay high limit), 8: t (delay low limit)

Alarm value”

4x4 The alarm values are entered in order from level 1

to 4.

* Returned in the byte order specified by the BO command.

Manually Sampled Data

The MV returns the manually sampled data in response to the ME or MO command.

* The ID number of the output format is 17. See section 5.1 for details.

» For the data format, see the MV1000/MV2000 User’s Manual (IM MV1000-01E).

Report Data

* The MV returns the report data in response to the ME or MO command.

» The ID number of the output format is 18. See section 5.1 for details.

» For the data format, see the MV1000/MV2000 User’s Manual (IM MV1000-01E).

Display Data (Text)

* The MV returns the display data in response to an ME command.

» The ID number of the output format is 29. See section 5.1 for details.

» For the data format, see the MV1000/MV2000 User’s Manual (IM MV1000-01E).

Event Data (Text)

* The MV returns the display data in response to an ME command.

* The ID number of the output format is 30. See section 5.1 for details.

» For the data format, see the MV1000/MV2000 User’s Manual (IM MV1000-01E).

IM MV1000-17E

5-31

sosuodsay n



5.4 Instrument Information Output Format

Response

Output Example

This section describes the instrument information output format of the instrument
information server.

Note

“CRLF” used in this section denotes carriage return line feed.

The response packet will contain parameter values according to the following format.
EACRLF
(Parameter 1) _=_(value of parameter 1)CRLF
(Parameter 2) = (value of parameter 2)CRLF

ENCRLF

* The MV returns the parameter values in order as specified by the command
parameter.

* The output order of the parameters is not fixed when all is specified.

 If the same parameter is specified multiple times, the MV returns a response only
to the first one.

» Lower-case characters are used for parameters.

* An underscore (_) indicates a space.

The following table shows the parameter types.

Parameter Output Information

serial Serial number
host Host name
ip IP address

Several output examples are indicated below.

Packet Parameter Sent as Commands Response
Parameters are not case sensitive.
ip HoSt EA

ip = 192.168.111.24
host = MvV2000
EN

If the same parameter is specified multiple times, the MV returns a response only to the first one.
host ip host ip host EA

host = MvV2000

ip = 192.168.111.24

EN

Undefined parameters will be ignored.
(Space) EA
EN
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Chapter 6

Status Reports

6.1

Status Information and Filter

The following figure illustrates the status information and

1bytes

filter on the MV.

Status information

[ 1] 2 | 3] 4] 5 ]| 6 | 7| 8
3

A A

| Filter

L1 [ 2] 3] 45 6|7 s

| Condition register

* You can use the IF command to set the filter.

* When an event described on the following page occurs, the corresponding bit in the

condition register is set to 1. The status information is the logical AND of the condition

register and the filter.

* You can use the IS command to get the status information. Status information bytes 3,
4,7, and 8 are cleared when you get the information. Status information bytes 1, 2, 5,
and 6 are not. They will remain 1 while the event is occurring.

+ If multiple connections are established, you can set a filter for each connection. This
allows the status information to be held for each connection.

* An empty bit, indicated as “-,” is fixed to 0.

IM MV1000-17E
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6.2

Status Information Bit Structure

The MV returns the following four status information groups in response to an IS
command, which is a status information output request command. For the output format,
see “Status Information” in section 5.2, “Text Data Output Format.”

Status Information 1

Bit

Name

Description

5
6
7

Basic setting
Memory sampling

Computing
Alarm activated
Accessing medium

E-mail started

Set to 1 when the MV is in Basic Setting Mode.

Set to 1 while the MV is acquiring data to the internal
memory.

Set to 1 while the MV is computing.

Set to 1 while an alarm is active.

Set to 1 while the MV is saving a display, event, manual
sampled, report, or screen image data file to an external
storage medium.

Set to 1 while the MV is sending e-mail.

Status Information 2

Bit Name Description

0 - —

1 - —

2 Memory end Set to 1 while the free space in the internal memory or

external storage medium is low.

3 Logged in through keys Set to 1 while logged in through keys.

4 - —

5 - —

6 Detecting measurement Set to 1 while the A/D converter is detecting an error or
error burnout.

7 Detecting communication ~ Set to 1 if any command is stopping the communication on

error

the Modbus master or Modbus client.

Status Information 3

Bit

Name

Description

0
1

w

(]

Measurement dropout
Decimal place/unit
information change
Command error
Execution error

SNTP error when memory
start is executed

Set to 1 when the MV cannot keep up with measurements.
Set to 1 when the decimal place or unit information is
changed.

Set to 1 when there is a command syntax error.

Set to 1 when an error occurs while executing a command.
Set to 1 when the time cannot be adjusted using SNTP
when the MV starts memory sampling.
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6.2 Bit Structure of the Status Information

Status Information 4

Bit Name Description
0 A/D conversion complete  Set to 1 when the A/D conversion of a measurement is
complete.

1 Medium access complete

2 Report generation
complete
Timeout

USER key detection

~No b w

Set to 1 when the MV completes the saving of the display,
event, manual sampled, report, or screen image data file to
an external storage medium.

Set to 1 when the MV successfully completes the saving or
loading of setup data.

Set to 1 when the MV completes a report generation.

Set to 1 when the timer expires.

Set to 1 when the USER key is pressed.

Status Information 5 to 8
All bits are zeroes.

IM MV1000-17E
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Chapter 7  Specifications

7.1 Ethernet Interface Specifications

Basic Specifications

Electrical and mechanical specifications: =~ Conforms to IEEE 802.3 (Ethernet frames

conform to the DIX specification)

Transmission medium type: 10BASE-T
Protocol: TCP, IP, UDP, ICMP, ARP, FTP, HTTP, SNTP,
SMTP

Maximum Number of Connections and Number of Simultaneous Uses
The following table indicates the maximum number of connections, the number of
simultaneous uses (number of users that can use a function simultaneously), and the MV

port number for each function.

Function Maximum Number Number of Port number*

of Connections Simultaneous Uses

Administrator User

Setting/measurement server 3 1 21 34260/tcp®
Maintenance/test server 1 1 1! 34261/tcp®
FTP server 2 2 2! 21/tcp®
Web server (HTTP) 1 — — 80/tcp®
SNTP server - — — 123/udp®
Modbus server 2 — — 502/tcp®
Instrument information server — — — 34264/udp?®

1 Users have limitations. See section 1.1 for details.

2 The port number is fixed.

3 The default port number. You can set a value in the range of 1 to 65535. Use the default port
number unless there is a specific reason not to do so.

4 Make sure that each port number is unique.
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RS-232 Specifications

Connector type:

Serial Interface Specifications

D-Sub 9-pin plug

Electrical and mechanical specifications:

Connection:
Transmission mode:
Synchronization:
Baud rate:

Start bit:

Data length:

Parity:
Stop bit:

Hardware handshaking:

Software handshaking:

Receive buffer size:

RS-422/485 Specifications

Terminal block type:

Conforms to the EIA-574 standard (for the 9-pin interface of
the EIA-232 (RS-232) standard)

Point-to-point

Half-duplex

Start-stop synchronization

Select 1200, 2400, 4800, 9600, 19200, or 38400 [bps].

1 (fixed)

Select 7 or 8 bits (To output data in BINARY format, be sure to
set the data length to 8 bits.)

Select odd, even, or none

1 (fixed)

Select whether to fix the RS and CS signals to TRUE or to use
them for flow control.

Select whether to use the X-ON and X-OFF signals to control
only the transmitted data or both the transmitted and received
data.

X-ON (ASCII 11H), X-OFF (ASCII 13H)

2047 bytes

6 terminals, terminal screws: ISO M4/nominal length 6 mm

Electrical and mechanical specifications:

Connection:

Transmission mode:
Synchronization:

Baud rate:

Start bit:

Data length:

Parity:

Stop bit:

Receive buffer size:
Escape sequence:
Electrical characteristics:

Communication distance:
Terminator:

Conforms to EIA-422 (RS-422) and EIA-485 (RS-485)
standards
Multidrop Four-wire type  1:32
Two-wire type 1:31
Half-duplex
Start-stop synchronization
Select 1200, 2400, 4800, 9600, 19200, or 38400 [bps].
1 (fixed)
Select 7 or 8 bits
Select odd, even, or none
1 (fixed)
2047 bytes
Open and close
FG, SG, SDB, SDA, RDB, and RDA (six terminals)
SG, SDB, SDA, RDB, and RDA terminals are functionally
isolated from the MV internal circuit.
The FG terminal is frame ground.
Up to 1.2 km
External: recommended resistance 120 Q, 1/2 W

7-2
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7.3

Modbus Protocol Specifications

Modbus Client Function

Basic Operation

» The MV, operating as a Modbus client device, communicates with Modbus servers
periodically by sending commands at specified intervals.
» This function is independent of the Modbus master function operating over the serial

interface.

» The supported functions are (1) reading data from the input registers and hold
registers on a server and (2) writing data into the hold registers on a server.

Modbus Client Specifications
Communication available via ModbusTCP

Communication media:
Read cycle:

Connection retries:

Connection timeout value:

Command timeout value:
Server:
Supported functions:

Ethernet 10Base-T

Select from the following:

125 ms, 250 ms, 500 ms, 1s,2s,5s,and 10 s

Select the how long to wait before reconnecting after the
connection is dropped due to the expiration of the connection
wait time.

OFF, 10s,20s, 30 s, 1 min, 2 min, 5 min, 10 min, 20 min, 30
min, and 1 h

1 minute

However, if the IP address has not been obtained from the
DHCP server, a communication error results immediately.

10 seconds

Register up to 16 servers

The table below contain functions that the MV supports. To
use the functions, the server device must also support them.

Function Code Function Operation
3 Reads the hold register The MV reads from the server device hold register
(4XXXX, 4XXXXX) into the communication input channel or external
input channel.
4 Reads the input register ~ The MV reads from the server device input register
(3XxXXX, 3XXXXX) into the communication input channel or external
input channel.
16 Writes to the hold register The MV writes the measured or computed data to
(4XXXX, 4XXXXX) the server device hold register.
Commands
Command type: R, R-M, W, and W-M
Number of commands: Set up to 16 commands
Data type: See the table below.
Symbol Description
INT16 16-bit signed integer
UINT16 16-bit unsigned integer
INT32_B 32-bit signed integer (big endian)
INT32_L 32-bit signed integer (little endian)
UINT32_B 32-bit unsigned integer (big endian)
UINT32_L 32-bit unsigned integer (little endian)
FLOAT_B 32-bit floating point (big endian)
FLOAT L 32-bit floating point (little endian)
IM MV1000-17E 7-3
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7.3 Modbus Protocol Specifications

¢ Reading Values into External Input Channels (MV2000 only)

External input channels are an MV2000 option (/MC1).

Reads values from the server register into the MV external input channels.

The data type of external input channels is 16-bit signed integer.

The measurement range and unit are set on the external input channels. The
decimal place is determined by the external input channel’s span lower settings.

MV2000 Server

Access | External Input data
method| Number: 201 to 440

Register Data type
30001 to 39999 |INT 16, UINT 16,

Data type: 16-bit signed integer 300001 to 365536 INT 32_B, INT 32_L,
€ |100011049999 | UINT 32.B, UINT33_L,
400001 to 465536

R
Read

External Input Channel Values

The range of external input channel values is —30000 to 30000 after removing the
decimal. If a value is outside this range, the value is set to positive or negative range-

out.

Server Register Value

External Input Channel Value

Greater than 30000

Positive range-out (7FFFH)

—30000 to 30000

—30000 to 30000

Less than —30000

Negative range-out (8001H)

* Reading Values into Communication Input Channels

Reads values from the server register into the MV communication input channels.
Communication input data is an option (/M1 or /PM1).

The data type of communication input data is 32-bit floating point.
Communication input data can be displayed on a computation channel by writing
an expression that contains the data in an MV computation channel (/M1 or /PM1
option). The measurement range and unit are also set on a computation channel.

R-M

CO01 to C60 (MV2000)
Data type: 32-bit floating point

-

Read

MV1000 and MV2000 Server
Access | Communication input data Register Data type
method} Number: C01 to €24 (MV1000) 30001 to 39999  |INT 16, UINT 16

300001 to 365536
40001 to 49999

400001 to 465536

INT 32_B, INT 32_L,
UINT 32_B, UINT 32_L,
FLOAT_B, FLOAT_L

* Writing Measured Values of Measurement Channels
» Writes measured values of measurement channels to server registers.

» The data type of measured values is 16-bit signed integer.

w

001 to 048 (MV2000)
Data type: 16-bit signed integer

Write

MV1000 and MV2000 Server
Access | Measurement channel Register Data type
method| Number: 001 to 024 (MV1000) 40001 to 49999 INT 16, UINT 16,

400001 to 465536

FLOAT_B, FLOAT_L
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7.3 Modbus Protocol Specifications

Specified Data Type and Write Operation
The MV writes the measured values of measurement channels according to the
specified data type as follows:

Specified Type

INT16

FLOAT L
FLOAT B

Measured Value | Value Written
Writes all values directly.
+Over’ 7f800000H(+)
-Over’ ff8O0000H(-)
Skip” f800002H(Nan)
Error’ f800004H(Nan)
Undefined data’ ff800005H(Nan)
Burnout(Up)’ 7f800006H(Nan)
Burnout(Down)” f800006H(Nan)
Other values Writes the value including the decimal

place in FLOAT data type.

* For details on values, see section 5.3, “Binary Data Output Format.”

¢ Writing Computed Values of Computation Channels
» The computation function is an option (/M1 or /PM1).
» Writes computed values of computation channels to server registers.
» The data type of computed values is 32-bit signed integer.

W-M

101 to 160 (MV2000)
Data type: 32-bit signed integer *

MV1000 and MV2000 Server
Access | Computation channel Register Data type
method| Number: 101 to 124 (MV1000) 40001 to 49999 | INT 16, UINT 16,

Write

400001 to 465536| INT 32_B, INT 32_L,

FLOAT_B, FLOAT_L

Specified Data Type and Write Operation
The MV writes the computed values of computation channels according to the
specified data type as follows:

Specified Type Computed Value Value Written
Less than —32768 -32768
Greater than 32767 32767
+Over’ 32767
INT16 -Over’ -32768
Skip”
Error’
Other values Writes the value in INT16 data format.
Less than 0 0
Greater than 65535 65535
+Over’ 65535
-Over’ 0
UINT16 Skip’
Error’
Other values Writes the value in UINT16 data
format.
INT32_L Writes all values directly.
INT32_B
+Over’ 7f800000H (+)
-Over’ ff800000H(-<)
FLOAT L Skip ff800002H(Nan)
FLOAT_B Error’ ff800004H(Nan)
Other values Writes the value including the decimal
place in FLOAT data type.

* For details on values, see section 5.3, “Binary Data Output Format.”

IM MV1000-17E
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7.3 Modbus Protocol Specifications

Modbus Server Function
Modbus Server Specifications
Communication available via ModbusTCP
Communication media: Ethernet 10Base-T
Port: 502/tcp (default value)
Command wait timeout: 1 minute. However, the timeout to receive the entire command
after starting to receive a command is 10 seconds.
Maximum number of connections: 2

Supported functions: The table below contain functions that the MV supports.
Function Function Operation
Code
3 Reads the hold register The client device reads the communication input
(4XXXX) data and external input channel data from the MV.
4 Reads the input register ~ The client device reads the computed, measured,
(BXXXX) alarm, and time data from the MV.
6 Writes once to hold The client device writes data to the
register (4XXXX) communication input channel and external input
channel on the MV.
8 Loopback test The client device performs a loopback test on the
MV.
16 Writes to hold register The client device writes data to the
(4XXXX) communication input channel and external input

channel on the MV.

Register Assignments (shared with the Modbus slave function)

Data type MV input register
Number Data type
Measurement channel | Measured data | 30001 to 30048 16-bit signed integer
Alarm status 31001 to 31048 Bit string
Computation channel | Computed data | 32001 to 32120 32-bit signed integer
Alarm status 33001 to 33060 Bit string

External input channel | Measured data | 34001 to 34240 16-bit signed integer
Alarm status 35001 to 35240 Bit string

Measurement channel | Alarm list 36001 to 36012 Bit string
Computation channel | Alarm list 36021 to 36035 Bit string
External input channel | Alarm list 36041 to 36100 Bit string
Time 39001 to 39008 16-bit signed integer

l Read

Data type MV hold register
Number Data type
Communication input data 40001 to 40060 16-bit signed integer

40301 to 40420 32-bit floating point
Measured data of external input channel | 41001 to 41240 16-bit signed integer

Write T l Read
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7.3 Modbus Protocol Specifications

Input Register (shared with the Modbus slave function)

Common ltems
» The client device can only read the input registers.

» The readout data does not include decimal place and unit information. Specify them

on the client device.
« External input channels are an MVV2000 option (/MC1).

Details
Input Register Data Data Type
30001 Measured data of measurement channel 001  16-bit signed integer
I I
30048 Measured data of measurement channel 048
» There is no decimal place information.
31001 Alarm status of measurement channel 001 Bit string
| |
31048 Alarm status of measurement channel 048
* Register structure and alarm status values

2 1 4  3<—Alarmlevel
[ abits | 4bits | 4bits | 4bits |<Alarm status

4-bit value Meaning

No alarm

High limit alarm

Low limit alarm

Difference high limit alarm
Difference low limit alarm

High limit on rate-of-change alarm
Low limit on rate-of-change alarm
Delay high limit alarm

Delay low limit alarm

OIN[O[R|W|IN|(=|O

32001 Lower word of the computed data of 32-bit signed integer
computation channel 101

32002 Higher word of the computed data of
computation channel 101

32119 Lower word of the computed data of
computation channel 160
32120 Higher word of the computed data of

computation channel 160
* Register structure
Channel 101 example
[ 1 ] Regstersagor [ | { 1]
[} | Registerazooa [ | | [ |~

[
Higher word Lower word

[P i1 14 ! computeddataofchannel101 | | | | | [ |1 ]

» There is no decimal place information.

33001 Alarm status of computation channel 101 Bit string
I |
33060 Alarm status of computation channel 160
» Register structure and alarm status values: Same as those of measurement channels.
34001 Measured data of external input channel 201  16-bit signed integer
I I
34240 Measured data of external input channel 440

* There is no decimal place information.
* The data in these registers are the data in the MV external input channels. If linear
scaling is enabled, the values are those after linear scaling.

35001 Alarm status of external input channel 201 Bit string
I |

35240 Alarm status of external input channel 440

» Register structure and alarm status values: Same as those of measurement channels.

IM MV1000-17E
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7.3 Modbus Protocol Specifications

Input Register Data Data Type
36001 List of alarms of measurement channels 001 to 004 Bit string
I I
36012 List of alarms of measurement channels 045 to 048
* Register structure
Level 3 Level 2
Level 4 —|_| |_|-Level 1
4ch 3ch 2ch 1ch
Indicates the alarm statuses of four channels in a register. Set to 1 when
alarm is activated. The figure above is an example of register 36001
(measurement channels 001 to 004).
36021 List of alarms of computation channels 101 to 104 Bit string
I I
36035 List of alarms of computation channels 157 to 160
» Register structure: Same as the list of alarms of measurement channels.
36041 List of alarms of external input channels 201 to 204 Bit string
| |
36100 List of alarms of external input channels 437 to 440

» Register structure: Same as the list of alarms of measurement channels.

* Input registers 36001 to 36100 can be accessed consecutively. All unassigned register bits

are read as zeroes.

Input Register Data Data Type

39001 Year 16-bit signed integer
39002 Month

39003 Day

39004 Hour

39005 Minute

39006 Second

39007 Millisecond

39008 (Reserved)
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7.3 Modbus Protocol Specifications

Hold Register (shared with the Modbus slave function)

Common Items

» The client device can read and write to the hold registers.

»  Communication input data is an option (/M1 or /PM1).

» External input channels are an MVV2000 option (/MC1).

To Write Data

« Communication input data can be handled on a computation channel by writing an
expression that contains the data in an MV computation channel.

» External input channel data can be handled on an external input channel.

Details

Hold Register Data Data Type

40001 Communication input data C01 16-bit signed integer
| |

40060 Communication input channel C60

= Precautions to be taken when a client device reads data
The MV communication input data is in floating point format, but the data is converted to
16-bit signed integer when the data is read.

» Precautions to be taken when a client device writes data
A client device can only write data in 16-bit signed integer format. A client device cannot
write a floating point value.

40301 Lower word of communication input data CO1 32-bit floating point
40302 Higher word of communication input data C0O1
I I
40419 Lower word of communication input data C60
40420 Higher word of communication input data C60

» Precautions to be taken when a client device writes data
Input range: —9.9999E29 to —1E-30, 0, 1E-30 to 9.9999E29
If values outside this range are used on a computation channel, a computation error
occurs.
41001 External input channel write register 201 16-bit signed integer
I |
41240 External input channel write register 440
» Precautions to be taken when a client device writes data
A client device can only write 16-bit signed integer data.
The measurement range and unit are set on the external input channels. The decimal
place is determined by the external input channel’s span lower settings.

Modbus Error Response (common to Modbus server and Modbus slave)
The MV returns the following error codes to a client or master device.

Code Function Operation
1 Bad function code Unsupported function request.
2 Bad register number Tried to read or write to a register that does not have a

corresponding channel.

3

Bad number of registers  When writing: The specified number of registers is less than
or equal to zero or greater than or equal to 124.

When reading: The specified number of registers is less than
or equal to zero or greater than or equal to
126.

The MV does not return a response in the following cases.
* CRC error
» Errors other than those shown above.

IM MV1000-17E
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7.3 Modbus Protocol Specifications

Modbus Master Function

Basic Operation

» The MV, operating as a master device, communicates with slave devices periodically
by sending commands at specified intervals.

» This function is independent of the Modbus client function operating over the Ethernet
interface.

» The supported functions are (1) reading data from the input registers and hold
registers on a slave device and (2) writing data into the hold registers on a slave
device.

Serial Communication Specifications (same as with the Modbus slave
function)

Communication available via ModbusRTU

Communication media: RS-232, RS-422, or RS-485

Control system: No flow control (none only)

Baud rate: Select 1200, 2400, 4800, 9600, 19200, or 38400.
Start bit: 1 (fixed)

Data length: 8 (fixed)

Parity: Select odd, even, or none

Stop bit: 1 (fixed)

Message termination determination:
Time equivalent to 48 bits

Modbus Master Specifications

Read cycle: Select the cycle for reading data from other devices from the
following:
125 ms, 250 ms, 500 ms, 1s,2s,5s,and 10 s

Timeout value: Select the timeout value when there is no response from a

specified slave after sending a command from the MV.
125 ms, 250 ms, 500 ms, 1s,2s,5s,10s, and 1 min
Retry count: Select the retry count when there is no response from a
specified device for a command sent from the MV
OFF, 1, 2, 3,4, 5, 10, and 20
Auto recovery cycle: Select the cycle for automatically recovering from the
following:
OFF, 1, 2, 5,10, 20, 30 min,and 1 h
Wait between commands: Select the wait time” to send the next command after receiving
a response to the previous command from the following:
OFF, 5, 10, 15, 45, and 100 ms
* When communicating using an RS-485 two-wire system,
the signals may collide, because the master and slave
device communication drivers switch in half-duplex mode.
If communication does not work properly, increase the wait
time.
Command type: R, R-M, W, and W-M
Command setup: Set up to 16 commands
Command items: Read channel 201 to 440, C01 to C60
Write channel 001 to 048, 101 to 160 (varies depending on
the model)
Address: 1to 247
Input registers: Same as the Modbus client function.
Hold register:  Same as the Modbus client function.

Access method: Same as the Modbus client function.
Supported functions: Same as the Modbus client function.
Data type: Same as the Modbus client function.
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7.3 Modbus Protocol Specifications

Modbus Slave Function

Serial communication specifications:

Same as the Modbus master function.
Slave address: 11to 99
Supported functions: Same as the Modbus master function.
Register assignments:  Same as the Modbus server function.
Modbus error response: Same as the Modbus server function.

IM MV1000-17E
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Appendix

I Appendix 1 ASCII Character Codes

Upper 4 bits

Appendix

8|9|A|/B|C|D|E|F

p

X

a

e

A|lQ
B|R|Db

E|U

H|X|h

4 D|T|d

5

\"
7. G|W|g|w

SP| 0 @ P

#13|C|S

%

ESC +

LF

CR

B

s)q ¢ JomoT
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Appendix 2 Data Dropout during Modbus
Communication

Data Dropout When Operating as a Modbus Client
If the MV tries to issue a command to a server device but has not finished receiving
a response to the previous command, the MV will not be able to transmit the next
command. This will cause a data dropout. Take appropriate measures to prevent
dropouts by referring to the following figures.

1. When the response from the server device takes a long time

Read cycle

Lto

Server device 1 u @
Server device 2 ¢—,_T @ { @
| 1© 11®

Data dropout Data dropout
(Servers 2 and 3) (Server 3)

Server device 3

2. When the connection is dropped because there is no response from the server device

Read cycle Connection dropped

T e
©
e

Data dropout
(Servers 2 and 3)

| |
| |
Server device 1 u @ U@
Timeout value
| e {
| te

Server device 2

N [O)

Server device 3

3. When the communication recovers through connection retry

Read cycle Connection dropped Connection recovered

| I | |
! ! i ! I

; Lte 1@ | te

: ‘Connection retry time* |

| @ . (Retr;))’ | @ U @
L1© | | te L1

Data dropout
(Servers 2 and 3)

Server device 1 u @

Timeout val

e

Server device 2 *

L 1©

Server device 3

JEDSDEEREPEY A I N S A

@ @ @ ®: Status lamp * The first connection retry after the connection is
¢ - Command from the MV dropped is s_h0|:ter fthan _the s_pecmed interval. The
status lamp indications in this example apply

T : Response from the server device when the connection retry function is enabled.
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Appendix 2 Data Dropout during Modbus Communication

Data Dropout While Operating as a Modbus Master
If the MV tries to issue a command to a slave device but has not finished receiving
a response to the previous command, the MV will not be able to transmit the next
command. This will cause a data dropout. Take appropriate measures to prevent
dropouts by referring to the following figures.

1. When the response from the slave device takes a long time

Read cycle

|t

Slave device 1 U @
Slave device 2 l—,_T @ l—T @
| 1© L1©

Data dropout Data dropout
(slaves 2 and 3) (slave 3)

Slave device 3

2. When there is no response from the slave device

Read cycle

|
I I I
Slave device 1 U@ U@ : U@ ;

u@ ‘ Timeout value i® U@
e IIC e

Data dropout
(slaves 2 and 3)

Slave device 2

Slave device 3

3. When the slave device that is not responding is disconnected (retry count set to 1)
Read cycle

I
|
Timeout value

l (Retry) i ®
Lo

Disconnect slave 2

Slave device 1 { @

Timeout val

e

[©
| 1©®

Data dropout
(slaves 2 and 3)

Slave device 2 ‘

G

Slave device 3

|
|
|
.
:
i
u
!
:
;
:
;
:
;

Data dropout
(slaves 2 and 3)

@ @ ® Status lamp

l : Command from the MV

T : Response from the slave device
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Appendix 3 Login Procedure

You log into the MV from your PC to use the functionality of the setting/measurement
server and the maintenance/test server via the Ethernet interface. If you complete the
procedure successfully up to “Login complete” in the following figure, you will be able to
use the commands given in chapter 4.

When Using the Ethernet Login Function of the MV

N

o
m Within the number
of connections'’

Increment retry count

404

N

o No
</erification match? Within 3 retries?2>—> @
Within th * ber of No N

ithin the number o ep s -
< simultaneous uses?* Within 3 retries?’ O]
Disconnect Login complete

Start D Judge
End © Transit
User entry

Ml

Response from the MV (message omitted)
For the response syntax, see section 5.1.

Code (for details on codes and messages, see the MV1000/MV2000
User’s Manual.)

N

The maximum number of connections cannot be exceeded (see section 7.1).

If you try to log in using a wrong password four consecutive times, the connection will be
dropped (the number of login retries is three).

If you try to log in when the number of simultaneous uses at the administrator or user level
is exceeded (see section 7.1) four consecutive times, the connection will be dropped (even
if the password is correct).

N

w

App-4
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Appendix 3 Login Procedure

When Not Using the MV Login Function

Log in as “admin” or “user.”

» The user name “admin” is used to log into the MV as an administrator.
» The user name “user” is used to log into the MV as a user.

Within 2 minutes?

Yes
< Entered “quit”? »@C Increment retry count >

E1 403 E1 404

No

A 4 No
Qerification match? Within 3 retries?>—} O)
* \ No No
Within the number of s D
@ simultaneous uses? / > <W'th'" 3 retries > > @

Login complete

IM MV1000-17E
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Appendix 4 Flowchart of How to Get Files or a File
List from an External Storage Medium
or Internal Memory

Example of How to Get the File 10101000.DAD

The following flowchart illustrates how to get file 10101000.DAD from the DATAO
directory on an external storage medium.

Command

START ( ) Command description

Received response data

Send the command

i

| MEGET, /DRVO/DATA0/10101000.DAD | (Specify the file name using a full path to get the data.>

Receive response ) Binary (see section 5.1)

Binary header | !

Binary footer

\l

|

| |
: Binary data :
| |
| |

Is there more data? NO *  Bit 0 of the binary header flag
0: There is more data.
YES 1: No more data.

Send the command

| VENEXT | (Output the )
subsequent data.

Binary (see section 5.1)

- - - - - = < — - — =

Binary header |
Binary data

Binary footer
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Appendix 4 Flowchart of How to Get Files or a File List from an External Storage Medium or Internal Memory

Example of How to Get a File List, 10 Files at a Time

The following flowchart illustrates how to get the file list of the DATAO directory on an
external storage medium, 10 files at a time.

START
Send the command

|MEDIR,/DRVO/DATAO/,10 | <

ASCII (see section 5.2)

- — — — — — - — — —

| EN

Are there more
files in the list?*

YES

NO

| MEDIRNEXT

| (Get the
subsequent files.

ASCII (see section 5.2)

)

Command

( ) Command description

Received response data

Command used to get the first file list.
Specify the number of files to get.

When the number of received files is
smaller than the maximum number of
files specified by the ME DIR
command (10 in this example), you can
conclude that there are no more files.
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Appendix 5 Flowchart of the FIFO Data Output

FIFO Buffer Overview

The MV has an exclusive internal memory for transmitting measured/computed data. The
memory has a FIFO (First-In-First-Out) structure. Measured/computed data is constantly
acquired to the internal memory at the specified acquisition interval (FIFO acquisition
interval, set with the FR command). By using this function, you will be able to read
measured/computed data that has been saved at the specified interval, independent of
when the PC reads the measured/computed data.

The following example shows the case when the acquisition interval is 1 s, and the
FIFO memory can store data for 8 intervals.

y

Block 1

2

3

Previous read <—— 4

Position: RP1
5
Currentread <—— 6 <— Most recent acquire
Position: RP2 Position: WP
7
Block 8

* Measured/Computed Data Acquisition
* The MV acquires measured/computed data to the internal memory at 1-s intervals.

» The MV acquires measured/computed data in order to positions 1 through 8. After
acquiring to position 8, the MV acquires the next data to position 1.

* Reading the Measured/Computed Data (using the FF GET command)
The MV transmits the data from the previous read position (RP1) to the most recent
acquisition position (WP).

In this example, more than 2 seconds has elapsed from the previous read operation.
Therefore, the MV transmits the data from blocks 5 and 6.

The amount of internal memory allocated for the FIFO buffer (FIFO buffer data size)
varies depending on the model.

Model Data size

MV1004, MV1008, MV2008 For 1200 intervals (30 s at the fastest acquisition
interval of 25 ms)

MV1006, MV1012, MV1024, MV2010, For 240 intervals (30 s at the fastest acquisition

MV2020, MV2030, MV2040, MV2048 interval of 125 ms)

Models with the external channel input For 60 intervals (60 s at the fastest acquisition interval

option of 1s)

App-8
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Appendix 6 Network Terminology

Network Terminology

Term Explanation

IP address An ID that is assigned to each PC or communication device on an IP network such as
the Internet or an intranet. The address is a 32-bit value expressed using four octets in
decimal notation (each 0 to 255), each separated by a period as in 211.9.36.148.

Subnet mask TCP/IP networks such as the Internet are often divided up into smaller networks called
sub networks. The subnet mask is a 32 bit value that specifies the number of bits of the
IP address used to identify the network address.

Default gateway A representative router or computer that is used when accessing a computer outside its
own network. If the access destination IP address does not specify a specific gateway,
data is sent to the host designated as the default gateway.

DNS An acronym for Domain Name System. A computer that converts the domain name,
which is the name of the computer on the Internet, to four octets called the IP address.
Each name server contains a mapping table of domain names and IP addresses in the
network that the server manages and responds to external inquiries.

DHCP An acronym for Dynamic Host Configuration Protocol. It is a protocol that allocates IP
address and other settings that a PC needs to connect temporarily to the Internet. The
DHCP server provides the information to a computer (client) that accesses the server. If
a client finishes the communication, the server withdraws the address and assigns it to
another computer.

HTTP An acronym for HyperText Transfer Protocol. A protocol used to exchange data between
a Web server and a client (Web browser, etc.). HTML documents as well as image,
sound, and video files that are linked to them can be exchanged along with formatting
information.

SNTP An acronym for Simple Network Time Protocol. One of the protocols used to synchronize
the computer clock via the TCP/IP network. It is an abbreviated version of NTP. NTP
is a protocol that configures time information servers in a hierarchy and synchronizes
the clock by exchanging information. SNTP omits the complicated sections of the NTP
specifications and specializes in serving clients that query time information.

SMTP An acronym for Simple Mail Transfer Protocol. A protocol used to transmit e-mail over the
Internet. It is used to exchange mail between servers and used by the client to send mail
to the server.

FTP An acronym for File Transfer Protocol. A protocol used to transfer files over a TCP/IP
network such as the Internet.

POP3 An acronym for Post Office Protocol version 3. A protocol used to receive mail over the
intranet or Internet from a server that stores e-mail.

POP before SMTP One of the user authentication methods for e-mail transmission. Access to the SMTP
server is granted after a specific POP3 server is accessed first.

PASV mode Passive mode of the file transfer protocol FTP (method by which the FTP server notifies

the port for making the connection). This mode is required when transferring files across
a firewall. Check with your network administrator on whether or not you need to set PASV
mode.
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